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PeerSync Help

Welcome to Peer Software, Inc. Folder Synchronization Utility Software, PeerSync v7.3. With this
utility you will be able to conveniently synchronize folders for back-up purposes or portability
requirements. Never again will you overwrite newer data by attempting to manually update an
individual file or the contents of a folder. 

History

PeerSync has been available for download/purchase since early 1995. Since then hundreds of
downloads have been logged from various international forums where PeerSync was made
available and thousands of copies have been sold. PeerSync is an MS Windows-based product.
Originally written in Visual Basic, the current product is written in Delphi Object Pascal. PeerSync
originated as a solution to a problem frequently encountered by our own developers, that of
keeping files in sync between multiple hard drives. Developers working on-site at customers'
locations or at home during crunch schedules would then have to synchronize their data back to
the office server. This was most often done manually, with each individual file being dragged to
the appropriate server folder. Invariably, data would be lost when one or several of the server files
contained new information which was subsequently overwritten. In addition to loss of work and
resulting frustration, the process was also time consuming. Anywhere from 20 minutes to 2 hours
would be spent during each synchronization. After reviewing several commercially available
products, it became apparent that an effective and user-friendly solution to this common problem
did not exist, hence the development of PeerSync. 

Description

Configured through the Profiler, an intuitive and easy-to-use application, PeerSync automatically
synchronizes multiple directories and sub-directories from user-defined Source to Target Folders.
While removing the frustration and loss of time associated with manual synchronization, 
PeerSync prevents loss of data by checking file dates and times to ensure that newer information
is not overwritten. Synchronization can occur between any mapped or UNC connected drives
located on local computers or computer networks. While processing and performing any number
of simultaneous tasks, PeerSync retains and expands upon the selectivity and precision of
manual synchronization by offering a suite of automated file inclusion and exclusion features.
Files can be included within synchronization according to standard DOS-type wild cards and
excluded using sub-string comparisons or file attribute settings. Files can be also be excluded
according to their date and size. In addition, PeerSync can be configured to update or add files
which are out-dated or non-existent in the current Target Folder. Precision and scope are further
enhanced through PeerSync Jobs and Command Line Modes. A virtually unlimited number of
folder combinations (Jobs) can be created and stored in Profiles which can be run manually or
automatically using command line arguments. While synchronizing large numbers of folder
combinations at once, each combination can have a unique set of exceptions. In this way 
PeerSync combines the benefits of precise folder matching with that of an automated
environment. Real-Time Source Folder monitoring and repetitive operations on the host PC are
also available with PeerSync's options. PeerSync can also be used for network file management
purposes. Reports run during synchronization can display added, updated, and opened files as
well as directories created, and can display unmatched files found in Target directories. 

The manufacturer of PeerSync makes no warranties, implied or otherwise, for use of this product. User assumes all
responsibility for any data loss or damage.

Copyright © 1993-2006 Peer Software Inc. All Rights Reserved Privacy Policy

PeerSync Help Manual was built on Monday, November 06, 2006

http://www.peersoftware.com/privacypolicy.asp
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Product Information

License

YOU SHOULD READ CAREFULLY THE FOLLOWING TERMS AND CONDITIONS BEFORE
INSTALLING, USING OR DISTRIBUTING THIS SOFTWARE. INSTALLING, USING OR
DISTRIBUTING THIS SOFTWARE INDICATES ACCEPTANCE OF THESE TERMS AND
CONDITIONS. IN THIS AGREEMENT, ''YOU'' MEANS YOU AS AN INDIVIDUAL IF YOU ARE
USING THIS SOFTWARE FOR PERSONAL USE. IF YOU ARE USING THE SOFTWARE ON
EQUIPMENT OWNED OR OPERATED BY A COMPANY OR ORGANIZATION
(COLLECTIVELY ''COMPANY''), BY ACCEPTING THIS AGREEMENT, YOU REPRESENT
THAT YOU ARE DULY AUTHORIZED TO ACCEPT THIS AGREEMENT ON BEHALF OF
YOUR COMPANY.

COPYRIGHT

The software programs (hereafter the "Software") and documentation (hereafter the
"Documentation") is copyrighted and remains the property of Peer Software, Inc. All rights are
reserved.

LICENSE

Peer Software, Inc. hereby grants you (hereafter the "User") a limited, non-exclusive,
non-transferable license to install and use the Software and accompanying Documentation
contained in the trialware distribution package (hereafter called the "Trialware Package") you
received (THE "Original Distribution") for your internal business purposes only. The Trialware
Package consists of copies of the Software and Documentation received via an electronic
transfer mechanism or an electronic storage medium including, but not limited to, diskette, hard
disk, removable disk, tape or optical devices such as CD-ROM or WORM. This license to install
and use the Software and Documentation is conditioned upon User’s compliance with the terms
of this Agreement.

You may install and use the Trialware Package on one or more computers provided there is no
chance that it will be used simultaneously on more than one computer. If you need to use the
Software on more than one computer simultaneously or on a network, please contact Peer
Software, Inc. for information about network licenses.

The Software is protected by trade secret and copyright laws and international treaty provisions.
You are not obtaining title to the Software or Documentation or any copyright or other intellectual
property rights. You further acknowledge that title and full ownership rights to the Software and
Documentation will remain the exclusive property of Peer Software, Inc. or its suppliers, and You
will not acquire any ownership rights to the Software. You may not sublicense, lease, rent, sell,
convey, translate, modify, decompile, incorporate into another product, convert to another
programming language, reverse engineer or disassemble the Software or Documentation for any
purpose. You may not modify, or create derivative works based in whole or in part upon, the
Software. You agree to not remove, obscure, or alter Peer Software, Inc.’s or any third party's
copyright notice, trademarks, or other proprietary rights notices affixed to or contained within or
accessed in conjunction with or through the Software and Documentation. Peer Software, Inc.
reserves the right to periodically conduct audits upon advance written notice to verify compliance
with the terms of this Agreement.

Once a license is purchased from  Peer Software, Inc., the Trialware Package will be authorized
to function as the full working version of the Software with access to all licensed features.

NETWORK LICENSE

Multiple users on a network (e.g. a LAN) requiring access to the Software and Documentation
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must purchase a Network License. Two forms of Network Licenses are offered, a Site License
and Enterprise or Concurrent User License. With a Site License, any user who accesses the
Software or Documentation requires a user license, regardless of the frequency of use. Once a
Site License is purchased Software and Documentation may be copied to all users who have
been licensed. Site Licenses are customized for each purchase. The license is based on a
quantity of simultaneous users and or CPU installations.

The Concurrent User License allows the licensed number of users to simultaneously access the
Software and Documentation. The User agrees to operate metering software, which restricts the
simultaneous number of users to the quantity purchased. The Software and Documentation must
be installed on network servers under the control of metering software. 

Both Site and Concurrent User Licenses allow installation of the Software and Documentation to
any number of servers on any number of geographic sites, limited only by the quantity of licenses
purchased.

TERM AND TRIAL PERIOD

You are permitted to use the Trialware Package for a trial period (hereafter the "Trial Period") of
thirty (30) days or 30 uses (which ever comes first) after receipt of the Trialware Package. After
such time, if you continue to use the Trialware Package, you must register your copy with Peer
Software, Inc. Failure to register after the Trial Period constitutes termination of this license. Upon
registration, a password (hereafter called the "Password") will be provided to eliminate the
registration reminder screen.

This license is effective until terminated. You may terminate it by destroying the Software,
Documentation, and all copies thereof. This license will also terminate if you fail to comply with
any of the terms or conditions herein. You agree, upon such termination, to destroy all Software,
Documentation, and copies thereof. Upon request, You agree to certify in writing that all copies of
the Software and Documentation have been destroyed.

LIMITED WARRANTY

THE SOFTWARE AND DOCUMENTATION IS PROVIDED "AS IS" WITHOUT WARRANTY OF
ANY KIND. PEER SOFTWARE, INC. DISCLAIMS ALL WARRANTIES RELATING TO THIS
SOFTWARE, WHETHER EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY
IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE,
AND INFRINGEMENT AND ALL SUCH WARRANTIES ARE EXPRESSLY AND SPECIFICALLY
DISCLAIMED. 

EXCLUSIVE REMEDY

YOUR EXCLUSIVE REMEDY AND PEER SOFTWARE, INC. ENTIRE LIABILITY ARISING
FROM OR IN CONNECTIONS WITH THE SOFTWARE, DOCUMENTATION, AND/OR THIS
LICENSE (INCLUDING WITHOUT LIMITATION FOR BREACH OF WARRANTY OR
INFRINGEMENT) SHALL BE, AT PEER SOFTWARE, INC.'S OPTION, THE REPAIR OR
REPLACEMENT OF THE SOFTWARE OR REFUND OF REGISTRATION FEES (IF
NOTIFICATION OF PROBLEM IS WITHIN 30 DAYS OF PURCHASE).

LIMITATIONS OF LIABILITY

UNDER NO CIRCUMSTANCES OR LEGAL THEORY, WHETHER IN TORT, CONTRACT, OR
OTHERWISE, SHALL PEER SOFTWARE, INC. OR ANYONE ELSE WHO HAS BEEN
INVOLVED IN THE CREATION, PRODUCTION, OR DELIVERY OF THIS SOFTWARE BE
LIABLE TO YOU OR TO ANY OTHER PERSON FOR ANY INDIRECT, SPECIAL, INCIDENTAL,
OR CONSEQUENTIAL DAMAGES (EVEN IF PEER SOFTWARE, INC. SHALL HAVE BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES), INCLUDING, WITHOUT LIMITATION,
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DAMAGES FOR LOSS OF GOODWILL, WORK STOPPAGE, COMPUTER FAILURE OR
MALFUNCTION, OR, FOR ANY OTHER DAMAGES OR LOSSES OF ANY NATURE. IN NO
EVENT WILL PEER SOFTWARE, INC. BE LIABLE FOR ANY DAMAGES IN EXCESS OF THE
LIST PRICE PEER SOFTWARE, INC. CHARGES FOR A LICENSE TO THE SOFTWARE. 

Some states do not allow the exclusion of the limit of liability for consequential or incidental
damages, so the above limitation may not apply to you.

BACK-UP

You may make one copy of the Trialware Package for backup purposes only.

DISTRIBUTION

You may distribute the Trialware Package to others via an electronic transfer mechanism or
electronic storage media provided that no files are deleted from the Original Distribution Trialware
Package or are modified in any way. Files may be added to the Trialware Package expressly for
the purpose of identifying the party distributing the Trialware Package. You may also place the
Trialware Package into any archive or compressed format for ease of distribution.

You may not distribute the product Registration Key to others under any circumstances.

GENERAL

Export of the Software may be subject to compliance with the rules and regulations promulgated
from time to time by the Bureau of Export Administration, United States Department of
Commerce, which restrict the export and re-export of certain products and technical data. If the
export of the Software is controlled under such rules and regulations, then the Software shall not
be exported or re-exported, directly or indirectly, (a) without all export or re-export licenses and
United States or other governmental approvals required by any applicable laws, or (b) in violation
of any applicable prohibition against the export or re-export of any part of the Software. Some
countries have restrictions on the use of encryption within their borders, or the import or export of
encryption even if for only temporary personal or business use. You acknowledge that the
implementation and enforcement of these laws is not always consistent as to specific countries.
Although the following countries are not an exhaustive list there may exist restrictions on the
exportation to, or importation of, encryption by: Belgium, China (including Hong Kong), France,
India, Indonesia, Israel, Russia, Saudi Arabia, Singapore, and South Korea. You acknowledge it is
your ultimate responsibility to comply with any and all government export and other applicable
laws and that Peer Software, Inc. has no further responsibility after the initial license to you within
the original country of sale.

In addition, neither the Software nor the Documentation and underlying information or technology
may be downloaded or otherwise exported or re-exported (i) into (or to a national or resident of)
any country to which the United States has embargoed goods; or (ii) to anyone on the United
States Treasury Department's list of Specially Designated Nations or the United States
Commerce Department's Table of Denial Orders. By using the Software you are agreeing to the
foregoing and you are certifying that you are not located in, under the control of, or a national or
resident of any such country or on any such list.

This agreement shall be governed by the laws of the state of New York and shall inure to the
benefit of Peer Software, Inc. and any successors, administrators, heirs, and assigns. Any action
arising under this Agreement shall be filed in any state or federal court located in Suffolk county in
the State of New York, and You hereby agree, acknowledge and submit to the exclusive
jurisdiction and venue of such courts for the purposes of such action, waive any right You may
have to object to such jurisdiction or venue.

This Agreement sets forth all rights for the user of the Software and is the entire agreement



PeerSync Help 5

Copyright © 1993-2006 Peer Software Inc. All Rights Reserved

between You and Peer Software, Inc. and supersedes any other prior or contemporaneous
agreements or communications with respect to the Software and Documentation. This Agreement
may not be modified except by a written addendum issued by a duly authorized representative of 
Peer Software, Inc. No provision hereof shall be deemed waived unless such waiver shall be in
writing and signed by Peer Software, Inc. or a duly authorized representative of Peer Software,
Inc. If any provision of this Agreement is held invalid, the remainder of this Agreement shall
continue in full force and effect. The parties confirm that it is their wish that this Agreement has
been written in the English language only.

PeerSync Installation

PeerSync is shipped (downloaded) in a full installation program. To run, simply double-click on
the executable in the Explorer window, or choose "Run" from the Start Menu and then select the
application. For networked installations, PeerSync supports silent installation by adding "/S" to the
installation application's command line.

Example: %PATH%/ps73.exe/S

See Additional Configuration Entries for more Information on silent installation configuration.

Additionally, PeerSync can use the PeerSync73.lic file for larger networked sales and site
licensing. This file will be placed in the "PeerSync" folder. If PeerSync detects this file at startup
then it will use this data and bypass all other registration security checks. If the PeerSync73.lic file
is located in the same folder as the PeerSync installation application, this file will then be
automatically placed in the PeerSync installation folder during installation. To obtain a
PeerSync73.lic file, please specify your requirements during purchase/registration.

Additional Configuration Entries

PeerSync and the PeerSync installation (ps73.exe) use a configuration file (PSDef.cfg) to read
and set options during and after installation.  If a PSDef.cfg file is located in the same folder as
ps73.exe before installation, this file will be automatically copied to the PeerSync installation
folder during install.

Pre-Installation Configuration Options

The following options are available before installation and are used during manual and silent
installs:

Installation Folder:  This option can be set to any directory path and designates what directory to
install PeerSync into.

Disable Install Reboot:  This option can be set to 'Yes' or 'No' and allows you to suppress the
rebooting (if needed) of your computer after installation. 

Install PSProfiler:  This option can be set to 'Yes' or 'No' and allows you to decide if the
PSProfiler interface is to be installed.

Install PSWizard:  This option can be set to 'Yes' or 'No' and allows you to decide if the PS
Wizard interface is to be installed.

Install PSObserver:  This option can be set to 'Yes' or 'No' and allows you to decide if the PS
Observer interface is to be installed.
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Install SNMP:  This option can be set to 'Yes' or 'No' and allows you to decide if files needed for
SNMP are to be installed (SNMP is only available in the Enhanced Package).

Install EOFM:  This option can be set to 'Yes' or 'No' and allows you to decide if files needed for
EOFM are to be installed (EOFM is only available with the Enhanced Package).

Example (PSDef.cfg format):

[Application Options]
Installation Folder= C:\Program Files\PeerSync
Disable Install Reboot=No
Install PSProfiler=Yes
Install PSWizard=Yes
Install PSObserver=Yes
Install SNMP=Yes
Install EOFM=No

Post Installation Configuration Options

The following options are used by PeerSync and other installed applications after install:

User Name:  This is used to set the Registration or Evaluation information to be read in by
PeerSync.

Company:  This is used to set the Registration or Evaluation information to be read in by
PeerSync.

Options:  This is used to set the Registration or Evaluation information to be read in by PeerSync
.

Password:  This is used to set the Registration or Evaluation information to be read in by
PeerSync.

TempFolder:  This option can be set to any directory path and will be used for a temporary folder
PeerSync to use.  If the path does not exist, an attempt will be made to create it.  If it cannot be
created, the default will be used which is the logon users system Temp path.

Example (PSDef.cfg format):

[Application Options]
User Name=
Company Name=
Options=
Password=
[Misc Options]
TempFolder=C:\Temp

Registration and Passwords

If this is an unregistered or Evaluation Copy of PeerSync, you can register it with Peer Software,
Inc. as a fully licensed copy by providing credit card information via phone or secure Internet
registration, or by sending a check or money order to the address below (see included
"readme.txt" file for pricing information).  As an integral component of PeerSync 7.3 and all
subsequent versions, the Profiler application is included as part of registration. 

Register online via secure Internet credit card registration at: 
http://www.peersoftware.com

http://www.peersoftware.com/solutions/PeerSync_overview.asp
http://www.peersoftware.com/solutions/PeerSync_overview.asp
http://www.peersoftware.com/registration.cgi
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Register by phone via credit card by calling:
631.979.1770 between the hours of 9:00 AM to 5:00 PM EST

Register by FAX via Purchase Order:
Send Purchase orders to 631.979.1870 

Register by mail, send check or money order to:  
Peer Software, Inc.
4155 Veterans Highway, Suite 12
Ronkonkoma, NY 11779-6063

Information Required:
Full name (as it appears on the credit card)
End User Name (user to be licensed for the product)
Company Name (if applicable)
Address (City, State / Province, Country, and Postal Code)
Phone Number
Entire Card Number
Card Expiration Date
Card Security Code
Email Address 
(Peer Software, Inc. will send the Authorization Key required to unlock PeerSync's Evaluation
Counter to this).

Quantity Discounts 
Visit http://www.peersoftware.com or contact us for more information.

Upon registering PeerSync, user information will be generated according to the name and
company name (if any) you specified during registration, as well as a password specific to the
product version you have licensed. This information will be emailed to you and will be used to
activate your current copy. Additional license fees must be paid for multi-user use.

PeerSync may not be commercially distributed or distributed by government agencies including
their contractors UNLESS registration fees are paid for by the distributing party.

See License agreement for product redistribution.

Please visit http://www.peersoftware.com for different versions of PeerSync and types of licensing
we offer.

Note Regarding Updates:  As new updates/changes become available, updated versions of the software will be posted
at http://www.peersoftware.com.  Check this page periodically to download the latest executables.  Your Authorization
Key will continue to work with updated versions unless a major release is issued, or PeerSync is installed in a different
folder than the previously installed/authorized version.

Entering Your User Information and Password

Through an Evaluation Copy of PeerSync:

After registration with Peer Software, Inc., you will receive Registration Information generated
which is from the information you provided during registration. The password you receive will be
specific to the PeerSync product you have licensed and registered with Peer Software. Upon
entering valid password and user information into your Evaluation Copy, that copy will be
immediately converted to a fully licensed version of the appropriate PeerSync product. The
instructions below apply to a "Registered Evaluation Copy" of PeerSync, that being one whose
evaluation period is still active.

http://www.peersoftware.com
http://www.peersoftware.com
http://www.peersoftware.com
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To activate your registered and licensed PeerSync product, first run your Evaluation Copy of
PeerSync. Then choose "About" from the Help Menu located on the far right of the Profiler Menu
Bar. To activate your registered and licensed PeerSync product, first run your Evaluation Copy of
PeerSync. Then choose "About" from the Help Menu

 Located on the far right of the Profiler Menu Bar. This opens the About PeerSync screen, which
contains "User Name," "Company", "Options" and "Password" fields.

Be sure to enter this information exactly as you received it, with the same spacing, hyphenation,
punctuation, and cases (i.e. if a comma or period contained within a company name is omitted,
registration will not be accepted). It is advisable to cut-and-paste passwords directly from the
E-mail registration information. If passwords are typed using lower case letters where upper
cases have been indicated, or if other information is typed incorrectly, the message shown below
will be displayed. This message indicates that registration was unsuccessful; shows the number
of attempts made to register, and contains' a link to Peer Software's website. You will only be
allowed a limited number of attempts before the application closes entirely and will need to be
opened again in order to retry.

If registration is successful, your will receive a success dialog. Your Evaluation Copy will have
been immediately activated as a registered version of the PeerSync product you have licensed,
with this change indicated on the interface title bar. Click "OK" on the success dialog to begin
usage of your newly activated PeerSync product. You will not have to exit and restart the
application to do so.
 
Through an Unregistered Copy of PeerSync: 

Unregistered copies of PeerSync are Evaluation Copies whose evaluation period has expired, or
copies into which a valid password and user information has not yet been entered. These copies
can still be activated as fully licensed versions of whichever PeerSync product whose usage you
have purchased from Peer Software, Inc.

After registration with Peer Software, you will receive Registration Information which is generated
from the information you provided during registration. The password you receive will be specific to
the PeerSync product you have licensed. 

To activate your copy of PeerSync as a fully licensed version, first run the copy. Because your
copy is unregistered, the application will not open in its entirety, instead an About PeerSync
screen will open. This screen contains "User Name," "Company", "Options" and "Password"
fields.

Be sure to enter this information exactly as you received it, with the same spacing, hyphenation,
punctuation, and cases (i.e. if a comma or period contained within a company name is omitted,
registration will not be accepted). It is advisable to cut-and-paste passwords directly from the
Email registration information. If passwords are typed using lower case letters where upper cases
have been indicated, or if other information is typed incorrectly, the message shown below will be
displayed. This message indicates that registration was unsuccessful; shows the number of
attempts made to register, and contains' a link to Peer Software's website. You will only be
allowed a limited number of attempts before the application closes entirely and will need to be
opened again in order to retry.

If registration is successful, your will receive a success dialog. Your copy will now have been
immediately activated as a registered version of the PeerSync product you have licensed. Click
"OK" on the success dialog to begin using your registered copy: the About PeerSync screen will
close and the full application interface will be displayed. You will not have to exit and restart the
application to begin usage.
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TERMS AND CONDITIONS

READ THE LICENSE AGREEMENT BEFORE USING THIS PROGRAM. 

Please send any suggestions, comments or requests for support to the proprietor of PeerSync:

Peer Software, Inc.
4155 Veterans Highway, Suite 12
Ronkonkoma, NY 11779-6063

Phone: 631.979.1770
Fax: 631.979.1870
Web: http://www.peersoftware.com

Upgrade Information

Visit http://www.peersoftware.com/software_download.asp to get the latest version of PeerSync. 

To upgrade your software, double-click on the installation file (ps73.exe) in the Explorer window,
or choose "Run" from the Start Menu and then select the application.

If you are upgrading the current version of PeerSync (7.3.x to 7.3.y) simply install the application
over your existing PeerSync and the previous version will be backed up in a sub-folder called
'BACKUP' (if the option to keep a backup is selected during the installation).

If you are evaluating a new version of PeerSync 7.3 and you already have an existing copy of
PeerSync 7.2 or older, please select a new directory during the installation.

If you wish to remove previous versions of PeerSync you must go to the 'Start
Menu-Settings-Control Panel,' select the 'Add/Remove Programs' utility and remove the PeerSync
versions you no longer need. 

http://www.peersoftware.com
http://www.peersoftware.com/software_download.asp
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Help Guide

Interface/Features

The manufacturer of PeerSync makes no warranties, implied or otherwise, for use of this product. User assumes all
responsibility for any data loss or damage.

Copyright © 1993-2006 Peer Software Inc. All Rights Reserved Privacy Policy

PeerSync Help Manual was built on Monday, November 06, 2006

1.  Getting Started

The Profiler is used to create PeerSync Profiles. A Profile can contain as many as 255 individual
synchronization tasks, or Jobs. A Job is defined by identifying a Source Folder, a Target Folder
(to which the contents of the Source will be synchronized), and then choosing from more than 80

http://www.peersoftware.com/privacypolicy.asp
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easily specified Job Settings. These settings determine which contents will be synchronized, in
what manner, and when they will be synchronized -- according to your choice of Real-Time,
Scheduled, or manually initiated operations.  

The process of building a Profile is made quick and simple by allowing you to easily create Jobs
and then follow the sequentially arranged list of Settings screens accessed through the Selection
Tree, which is located on the left side of the application interface. The user begins by first
selecting a single Job or Multiple Jobs from the Profile Job List. Then specific synchronization
criteria is applied to the selected items using Job Settings. Once synchronization criteria has been
configured for each Job, Run/View Current Profile window is used to launch the entire Profile. By
offering a Tool button Toolbar as well as separate Selection Tree and Profile Job List windows,
Profiler's browser-based interface allows you to easily view, create, copy, rename, move, or
delete Jobs regardless of which Settings screen is currently being displayed.

Product Definitions

Synchronizat
ion: 

Updating any existing files or adding new files in the Target Folder using the
Source Folder as the guide. When completed, the Target Folder should contain
all of the files in the Source Folder with matching content and time stamps.

Replication: Same as synchronization, except files that are in the Target Folder that do not
have a matching Source File will be deleted.

Profiles: A Profile is a description of a complete synchronization scenario. Profiles can
contain many Source-Target combinations allowing the end-user to define very
detailed file synchronizations and run them all within a single request. For
example, you could build a Profile that contains Multiple Source and Target
Folders such as:

Source = C:\My Documents Target = N:\USERS\TEST\My Documents
Source = D:\LocalData Target = N:\USERS\TEST\LocalData
Source = C:\WINDOWS\Profiles Target = N:\USERS\TEST\Profiles

Each of these Source-Target entries can then be further detailed with more than
65 options each making each entry a completely self-contained process while still
allowing it to be run as part of a bigger set or Profile. 

Jobs: A Job is a single entry in a Profile. A Profile can contain from one to 255 Jobs and
each Job contains more than 80 individual option settings.

Real-time
Mode: 

In this mode of operation, PeerSync will automatically detect changes made to
the Source Folder(s) and execute the synchronization options selected for the
matching Job. Typically, the Target Folder is updated with the Source Folder
change within moments of the change. Note that PeerSync may have completed
the operation before Windows actually displays the change in the Target Folder
Explorer window.

Scheduled
Mode:

In this mode of operation, PeerSync will execute the designated Job at the
selected time. Each Job in the Profile can have the same or different time interval.

Product
Support:

All support of PeerSync will be handled on our web site support page located at
http://www.peersoftware.com/support/index.asp.

PeerSync is fully supported under all NT based platforms of Windows but should
first be evaluated on each machine in which you wish to register the product on. 
PeerSync is no longer fully supported under Windows 9x platforms.

http://www.peersoftware.com/support/index.asp
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Note:  For more information on the latest features and how to implement specific scenarios please go to our support
page at: http://www.peersoftware.com/support/index.asp.

2.  Menus

In addition to special options found only on the Profiler menu, menu items replicate the features
accessed through the Profiler's Tool Buttons. As a result, you can still access essential Profile
and Job Settings even if you have chosen to hide the Tool buttons using the View Menu.

File

This menu includes items allowing you to create and save new Profiles, open existing Profiles,
create Profile desktop shortcuts, and exit the application. 

New Create a new Profile. This feature is accessible from the Tool
Buttons Toolbar.

Open Open an existing Profile. This feature is also accessible from the
Tool Buttons Toolbar.

Reopen Reopen a recently used Profile.

Save Save the current Profile. This feature is also accessible from the
Tool Buttons Toolbar.

Save as Rename and Save the current Profile.

Profile - Revert to Saved Revert to the last saved settings of the current Profile. 

Profile - Merge Existing Merge an existing Profile into the current Profile.

Profile - Create Shortcut
on Desktop

Create and add a shortcut to PeerSync of the current Profile and
settings/command line arguments to the desktop.

Profile - Save Defaults Save the current settings of the Profile as the default settings.

Exit Close/exit the application.

Edit

Allows you to move one step up or down between Selection Tree options screens while
providing a shortcut to the Run/View Current Profile Activity screen.

Back Move back to the previous screen. This feature is accessible from
the Tool Buttons Toolbar.

Next Move on to the next screen. This feature is also accessible from
the Tool Buttons Toolbar.

Run/View Current Profile
Activity

Go to the Run/View Current Profile Activity screen.

http://www.peersoftware.com/support/index.asp
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View

Allows you to change the appearance of the application interface. "Hint" items enable or disable
pop-up hints activated by passing the mouse pointer over interface features, as well as those
displayed in the Status Bar located at the bottom of the application interface. In addition to a
description of Profiler features, hints will identify command line arguments associated with
those features (if any).

Toolbars - Tool Buttons Show/hide the Tool Buttons Toolbar.

Toolbars - Profile
Description

Show/hide the Profile Description Toolbar.

Toolbars - with Hot
Tracks

Show/hide the hot tracks features for the Toolbars.   

Toolbars - with Text
Labels

Show/hide description text labels for the Toolbars.

Selection Tree Show/hide the Selection Tree left side panel. This feature is also
accessible from the Tool Buttons Toolbar.

Refresh Current Profile
Activity F5

Refresh Profile activity.

Status Bar Show/hide the Status Bar at the bottom of the application.

Hints - on Application Show/hide pop-up hints displayed on the application.

Hints - on Status Bar Show/hide hints displayed on the Status Bar.

Folders Allows for the ability to launch and display Source and Target
Folder selections in organized Explorer windows in a set viewing
area. This helps the user to view and/or validate the Source and
Target Folder content before, after, and during synchronization.
These features may be quite helpful during evaluation and when
running and testing a newly modified Profile.  

Job Groups* (Enhanced
Package)

 Similar to Microsoft's Multiple Document Interface (MDI), 
PeerSync now contains a multi-pane interface that allows the user
to organize groups of Jobs (Source and Target pairs) by any
convention necessary. User-specified tab controls allow quick
transition from one group to another. The traditional Job list
interface is still available for those who do not need the group
panes.

Remote Control* (
Enhanced Package) 

Displays the Remote Control Dialog which allows for the ability to
monitor PeerSync running as a service on the local machine
and/or any instances of PeerSync running on machines that are
connected to the local machine.

PSObserver This will launch the PeerSync LAN Observer Utility (PS Observer),
if it is installed/available. This utility allows for the ability to monitor
PeerSync activity across the LAN for the centralized viewing of all
PeerSync activity on the network.

Profile Messages Open the Profile Message Log file if it exists. The naming
convention of the Message Log files is as follows: Profile.snc.log,
where Profile represents the name of the current Profile. 

http://www.peersoftware.com/solutions/PeerSync_overview.asp
http://www.peersoftware.com/solutions/PeerSync_overview.asp
http://www.peersoftware.com/solutions/PeerSync_overview.asp
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Options

Allows you to select options pertaining to the way PeerSync, the Profiler and the Wizard interact
with each other and Windows Explorer.

Use Wizard to Add Jobs If selected, directs Profiler to open the Wizard application as an
easier and simpler way to add new Jobs to a Profile. If not
selected, the Add Job option will use the saved Job defaults. This
feature is toggled on or off depending on which option was used
the last time that a Job was added (with Defaults or with Wizard).

Create SNC extension
association

If selected, creates an association of any file that has an SNC
extension with the Profiler to be used as the default application to
open these files. If not selected, the association of SNC files with
the Profiler will be removed. This feature is also accessible from
the  Startup Services screen.

Add Quick-Sync Folder
option to Explorer menu

If selected, will add our Quick-Sync feature to Windows Explorer.
To access this feature, simply right-click on any folder in Explorer,
or on your Desktop, and you will be able to sync the folder to
selected Target Folder(s), add the Job to a Quick-Sync Profile that
is stored out in memory, and administer the ability to modify/add to
the Jobs using the Profiler. This feature is also accessible from
the Startup Services screen. 

On Profile Exit This option allows for the ability to do one of the following when
exiting the Profiler while it is connected to an Active Profile:
Display Terminate Active Profile Dialog, Leave Active Profile
Running, or Terminate Active Profile.

Global Settings Displays various settings including Recovery/Offline Options,
Performance Options, Reporting Options, Display Options, ACL
Options, Bi-Directional Options,EOFM Options, and Current
Command Line Arguments.
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Run 

Allows you to Launch the Current Profile, Terminate the Active Profile and Update the Current
Profile.

Launch Current Profile This feature will launch the current Profile (Job/Global settings) in 
PeerSync. During this process, an instance of PeerSync will be
started with the current Profile as the first parameter and the
arguments selected from the Options/Commands screen  as the
subsequent parameters. You can automate this process via a
shortcut, through the startup folder, in the registry or as a service
by selecting one of these features from the Startup Services
screen. This feature is also accessible from the Tool Buttons
Toolbar. 

Terminate Active Profile This option, when available, will allow a user to terminate an
instance of PeerSync that contains an active Profile which is
connected to the Profiler. This feature is also accessible from the
Tool Buttons Toolbar.

Update Current Profile This option, when available, will allow a user to update an instance
of PeerSync with the current Profile opened in the Profiler.

Note:  Because it is separate from the core software engine, the Profiler allows you to create and configure new
Profiles while PeerSync runs Synchronization Operations at optimum efficiency. In both this Help file and on Profiler
screens, "Current" refers to the Profile currently being configured but not yet launched, while "Active" most often refers
to the Profile presently being run by the PeerSync engine.

Pre-Sync Report This executes a pre-sync report of the currently selected Jobs.
During this process, files and folders will not be modified and
persistent arguments set for the current Profile will be ignored. A
report will be created and displayed with the work that would be
performed if a synchronization was actually run. This feature may
be quite helpful during evaluation and when running and testing a
newly modified Profile. Pre-Sync Report options.
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Job

Allows you to manipulate Jobs within the current Profile. If "Allow Multiple Selection" has been
checked on this menu, you will be able to select and apply settings to Multiple Jobs.

Add - Job with Defaults Creates and adds a Job to the current Profile using the saved Job
defaults. This feature is also accessible from the Tool Buttons
Toolbar and the Profile Job List Pop-Up Menu.

Add - Job with Wizard Opens the Wizard application that allows you to select a
predetermined canned scenario and add it as a Job to the current
Profile. This feature is also accessible from the Tool Buttons
Toolbar and the Profile Job List Pop-Up Menu.

Copy Creates a duplicate copy of the currently selected Job and all of its
settings. This feature is also accessible from the Tool Buttons
Toolbar and the Profile Job List Pop-Up Menu.

Rename Allows for the renaming of the selected Job. This feature is also
accessible from the Tool Buttons Toolbar and the Profile Job List
Pop-Up Menu.

Delete Allows for the deletion of the currently selected Job(s). This
feature is also accessible from the Tool Buttons Toolbar and the
Profile Job List Pop-Up Menu.

Clear All This will close the current Profile allowing for the user to create a
new Profile.

Move Up Moves the currently selected Job up one in the list. This feature is
also accessible from the Tool Buttons Toolbar and the Profile Job
List Pop-Up Menu.

Move Down Moves the currently selected Job down one in the list. This feature
is also accessible from the Tool Buttons Toolbar and the Profile
Job List Pop-Up Menu.

Select All This will select all of the Jobs. 

Invert Selection This will change the selected state of all the Jobs.

Allow Multiple Selection Gives the ability to select and apply settings to Multiple Jobs.

Create Auto Job Name This feature allows a simple way to generate meaningful Job
names. When selecting this item, Job names are automatically
generated based on their Source and Target paths which make it
a simple task to organize the Job list.

Log File - View Display the log file for the selected Job.

Log File - Clear Clear the log file for the selected Job.

Message Log File - View Display the message log file for the selected Job or profile.

Message Log File - Clear Clear the message log file for the selected Job or Profile.

Save Defaults Stores the currently selected Job Settings as the default for all
subsequent newly added Jobs. 
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Help

While allowing you to access Help files and the About screen, this menu also provides
demonstrations of PeerSync's Real-Time Monitoring and Scheduled Operation modes.

Demos This option allows the user to instantly run either a Real-Time or
Scheduled test Profile to demonstrate PeerSync's synchronization
capabilities. 

Web Site This menu item will have many links back to our web site for
product information, downloads, updates and support.

PeerSync Help Will open the application help file to the contents section. You may
also access specific parts of the help file for features you are
currently observing by pressing 'F1' on your keyboard.

Register PeerSync Will display the PeerSync Registration Screen to activate the
PeerSync trial version or upgrade the current license.

License Information Will display the different Product Editions and Licensing available
for PeerSync. Will also display what the current edition has
available as well as other useful information about the current
package you are running.

About PeerSync Will display an about screen, which contains information about the
current PeerSync you are running.

Evaluation

Only displayed in evaluation copies of the software, this menu item will contain features that we
believe are helpful to the user during evaluation such as demos, README files, and other
evaluation oriented features.

View Popup Menu

Activated by right clicking on the application Menu, Tool Buttons Toolbar, Profile Description
Toolbar, or the Status Bar, you can select many of the options available from the application 
View Menu.
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PeerSync Tray Icon Popup Menu

Activated by right clicking on the application Menu, Tool Buttons Toolbar, Profile Description
Toolbar, or the Status Bar, you can select many of the options available from the application 
View Menu.

View Log File Allows you to access, launch and view Log files in the default text
editor for the current Profile.

View Message Log File Allows you to access, launch and view the Message log file for the
current Profile.

View Admin Folder Allows you to access, launch and view Admin log file Folders in
Explorer for the current Profile.

Open Source Folder Allows you to access, launch and view Source Folders in Explorer
for the current Profile.

Open Target Folder  Allows you to access, launch and view Target Folders in Explorer
for the current Profile.

Show Status Display This item will show the PeerSync Status Display dialog box during
synchronization so the user can see activity, status, and other
information while PeerSync is running. This feature is only
available if the Display Status in the PeerSync feature was
enabled for the current Profile.

Connect/Launch Profiler This item will open the Profiler, if it is not already open, and send
status messages to be displayed on the Run/View Current Profile
Activity screen. This connection feature will only work if the
Display Status in Profiler feature was enabled for the current
Profile.

About PeerSync Will display an about screen, that contains information about the
current PeerSync you are running.

Exit PeerSync Allows you to close/exit the current session of PeerSync.

* Note:  Some features described on this page require the Enhanced Package.

3.  Tool Buttons

Profiler offers a simple set of browser-style Tool Buttons allowing you to easily modify the current
Profile and its Jobs, regardless of which screen has been chosen from the Selection Tree. These
buttons can be hidden by unchecking the "Tool Buttons" option, accessed through the "Toolbars"
item on the View Menu. Even if this Toolbar has been hidden you will still be able to access its
options by using the File, Edit, and Job Menus. You can also change the placement of these
buttons by clicking on the left side of the Toolbar and dragging it to rest above or below the Profile
Description Toolbar. The following descriptions are listed in the order in which they appear left to
right on the Tool Buttons Toolbar and are all accessible via the application Menus.

http://www.peersoftware.com/solutions/PeerSync_overview.asp
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New Profile: Located on the far left of the Toolbar, this button creates a new Profile. If
another Profile containing unsaved changes is currently open when this
button is pressed, a dialog box will open asking you if you want to save
changes to the current Profile before opening a new one (See Save Profile
Button Below). If you choose "No," the new Profile will replace the current
one and no changes will be saved.

Note:  If the current Profile has not been previously saved and "No" is chosen, the entire Profile
will be lost. 

Open Profile: This button displays a "Select Profile File" dialog box allowing you to open an
existing Profile. By default, it will open in the path in which PeerSync has
been installed (i.e. C:\Program Files\PeerSync). Links to previously opened
Profiles can be accessible through a drop-down list opened by clicking on the
arrow key attached to this button.   

Save Profile: This button allows you to save new Profiles, or save changes made to
existing Profiles. If you are saving a new Profile, a "Save As" dialog box will
open allowing you to name and store it as an .SNC file in your choice of
folders, with "NewProfile" as the default name and the path in which 
PeerSync has been installed as the default directory. Profiles and Profile
modifications must be saved in order to be subsequently accessible. 

Launch Current
Profile:

This feature will launch the current Profile (Job/Global settings). During this
process, an instance of PeerSync will be started with the current Profile as
the first parameter and the arguments selected from the Options/Commands
screen  as the subsequent parameters. You can automate this process via a
shortcut, through the startup folder, in the registry or as a service by selecting
one of these features from the StartUp Services screen. 

Terminate Active
Profile:

This option, when available, will allow a user to terminate an instance of 
PeerSync that contains an active Profile that is connected to the Profiler. 

Add Job: This button adds a Job to the bottom of the current list (See Profile Job List).
Jobs are named "New Job Item" and assigned a number by default. If you
have selected "Use Wizard to Add New Jobs" from the Options Menu, the
Wizard application will open when this button is pressed. The Wizard
provides a guided, step-by-step method for creating and configuring new
Jobs. A drop-down list attached to this button also allows you to choose
between "Add Job With Wizard" or "Add Job With Defaults" options. If the
former is chosen, Wizard will open every time this button is pressed. If the
latter is chosen, new Jobs added to the list through this button will be
configured manually using Selection Tree screens. These Jobs will use
whichever default settings are currently applied (See Job Menu, "Save
Defaults"). 

Note:  The first time "Add Job With Wizard" is chosen from the drop-down list, the Wizard
application will open. After that point Wizard will be launched by pressing the Add Job button.  

Copy Job: Creates a copy of the currently selected Job and places it at the bottom of
the Profile Job List. Copies will be numbered by default and named after the
original (i.e. "Copy 1 of My Syncs").

Rename Job: Allows you to rename the currently selected Job. Jobs can also be renamed
manually by clicking on them after they have been highlighted.  

Delete Job: Deletes the currently selected Job(s). When this button is pressed, a dialog
box will open asking you to confirm deletion. Jobs can also be deleted by
selecting them and then pressing the DELETE key on your keyboard.

Move Job Up: Moves the currently selected Job up one place within the Profile Job List.

Move Job Down: Moves the currently selected Job down one place within the Profile Job List.

Show Selection
Tree:

Shows or hides the Selection Tree. If the Tree has been hidden, its space will
be filled within the interface by the currently selected Settings screen. When
the tree is hidden, screens can still be selected using the drop-down list
attached to the Back button. 

Back: Opens the screen located immediately above that, which is currently being
displayed. Settings screens can also be accessed using the drop-down list
located on the right side of the Back button; list items follow the same order
as that shown on the Selection Tree. 

Next: Opens the Profile Options screen located immediately below the screen
currently being displayed.



PeerSync Help20

Copyright © 1993-2006 Peer Software Inc. All Rights Reserved

4.  Profile Description

This field is located bellow the Tool Buttons Toolbar by default and displays a textual description
of the current Profile. By default the description for an unsaved Profile will read "Profile Job List."
Unless you enter a unique description into this field, a default description will be assigned upon
saving the Profile; this default description will match the new Profile name.

Descriptions can be changed at any time; like all Profiler configurations, they must be saved prior
to closing the Profile or application in order to be stored. You can change the placement of the
Profile Description Toolbar by clicking on its left side and dragging it to rest above or below the
Tool Buttons Toolbar. The Profile Description can also be hidden by unchecking the "Profile
Description" option, accessed through the "Toolbars" item on the View Menu.

5.  Profile Job List

Located beneath the Toolbars, this window displays all Jobs associated with the current Profile.
Use of this list is central to the Profile-building process; all configurations made on the Job
Settings screens (accessed through the Selection Tree) will only be applied to those Jobs
currently selected from this list. 

To select a Job, highlight it using the left mouse button. The "Allow Multiple Selection" item must
be checked on the Job Menu in order to select and have settings applied to Multiple Jobs. To
select Multiple Adjacent Jobs, highlight the first Job, hold down the SHIFT key on your keyboard,
and then highlight the last Job you wish to include. You can also hold down the SHIFT key and
then use the up or down arrow keys on your keyboard. To select Multiple Nonadjacent Jobs,
highlight the first Job, then hold down the CTRL key on your keyboard and click on each
additional Job you wish to include. Once you have selected a Job or Jobs, move through the
screens found on the Selection Tree and apply settings as desired. Highlighting on the selected
Job(s) will appear gray as you move through these screens, indicating that any configured
settings will only be applied to those selected Jobs. 

The box appearing to the left of each Job must be checked in order for that Job to be included in
the active Profile when launched. Although unchecked Jobs will not be processed upon launch,
they will be saved within the Profile for future use and/or selection. 

Upon creating a new Profile, an initial Job will be displayed bearing the name "New Job Item 1" by
default (this applies to manual Job creation only). The first New Job added within an existing
Profile will also bear this name. Successive Jobs will be named "New Job Item 2," "New Job Item
3," etc. Any selected Job can be renamed through the "Rename" Tool Button, through items
found on both the Job Menu and Profile Job List Pop-Up Menu described below, or manually by
selecting it a second time using the left mouse button.

In both new and stored Profiles, you can navigate the Profile Job List as well as add, copy, delete,
and navigate Jobs using the Tool Buttons; using items from the Job Menu, and by using items
found on the Profile Job List Pop-Up Menu described below. You can also navigate the list and
delete items using the DELETE and up and down arrow keys on your keyboard. 

Note:  In order to navigate or modify the Profile Job List, you must have first clicked somewhere within the Profile Job
List window; this ensures that during configuration any options chosen from the Selection Tree screens are applied
exclusively to the currently selected Job. 

The height of the Profile Job List window can be changed by passing the mouse pointer over its
bottom border until a double/Arrow cursor appears, then dragging the window to meet the desired
size. At minimum size, only a single Job may be viewed. Adding a new Job while this view is in
effect prompts display of up and down arrow buttons in the right side of the window. These
buttons allow you to view different Jobs within the list. 
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Job List Pop-Up Menu

Activated by right clicking on the Profile Job List, this menu duplicates the mostly used features
found on the Job Menu while providing some additional items listed below. 

Synchronize
Selected Jobs 

This executes an immediate, non-persistent synchronization of the
currently selected Jobs ("non-persistent" refers to a one-time sync
process; "persistent" refers to ongoing sync operations such as
Real-Time Monitoring or Scheduled Operations). During this process,
persistent arguments set for the current Profile will be ignored. When
the button is released, a confirmation dialog will be displayed indicating
which Jobs have been selected from the active Profile and asking you
to confirm synchronization through a "Yes" or "No" button. If "Yes" is
selected, the synchronization will proceed. A message will always be
displayed upon completion of this operation. Other sync operations
allow you to choose whether or not such a message will be displayed. 

Create Pre-Sync
Report

This executes a pre-sync report of the currently selected Jobs. During
this process, files and folders will not be modified and persistent
arguments set for the current Profile will be ignored. A report will be
created and displayed with the work that would be performed if a
synchronization was actually run. This feature may be quite helpful
during evaluation and when running and testing a newly modified
Profile.  

Log File - View This menu item allows you to view Log reports by opening the file in a
text editor. This feature is also accessible from the Reporting screen. 

Log File - Clear This menu item allows you to clear Log reports. This feature is also
accessible from the Reporting screen. 

Message Log File -
View

This menu item allows you to view Message Log reports by opening
the file in a text editor. This feature is also accessible from the View
Menu item. 

Message Log File -
Clear

This menu item allows you to clear Message Log reports. This feature
is also accessible from the View Menu item. 

Job List View
Options

This feature enables/disables the ability to display the "Click Here to
Add Another Job" Job every time a new Job has been created.

Job List View
Options Pop-Up
Menu

Activated by right clicking on the Profile Job List, this Popup menu
allows for the following features:

Use "<Click
Here to Add
Another Job>"
Feature

This menu item will add a new Job to the end of the Job list named
"<Click Here to Add Another Job>" every time a new Job is created.

Suppress Add
Job Confirm
Dialog

This menu item will suppress the Confirmation Dialog that is launched
when clicking on the "<Click Her to Add Another Job>" Job.
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View Job
Groups* (
Enhanced
Package) 

This feature enables/disables the ability to allow the user to
organize/categorize Jobs within a Profile into Job Groups. 

When this feature is enabled, you can create as many Job Groups as
desired. Each Job Group is represented by a Tab. Each Tab displays
the Job Group Name, the number of Checked Jobs and the number of
Total Jobs for the corresponding Job Group, in the following format: 
GROUP NAME [CHECKED JOBS / TOTAL JOBS]

Select All This menu item will select/highlight all Jobs within the current Job
Group for a quick and easy way of modifying all Jobs within a given
Profile. If this feature is not enabled you must turn on the Allow Multiple
Selection feature on from the Job Menu.

Last Run On This is a display of the last run date/time of the selected Job within the
current Profile. This is the date/time that will be used when comparing
files for the Bi-directional Synchronization Mode option on the File
Options screen. This feature is also displayed on the from the  Folder
Selectionscreen. 

Last Run On - Reset This allows a means of resetting the last run date/time of the selected
Job within the current Profile. 

Job Group Pop-Up Menu* (Enhanced Package) 

Activated by right clicking on the Profile Job List, this Popup menu allows for the following
features:

Add Job Group This menu item will create and add a new Job Group to the existing
Profile. 

Edit or Delete Job
Groups

These menu items will display the Modify Job Groups Dialog, allowing
for the adding, renaming, moving, re-ordering, modifying and/or the
deletion of Job Groups. 

Edit Job Groups
Dialog

To add a Job Group click "New," then type the desired name into the
field located at the bottom of the dialog. Repeat this process for each
Job Group you wish to add. Entries can be deleted by selecting them
from the list and clicking the "Delete" key at the bottom of the box. You
can also use the "Up" and "Down" buttons to reorder the items.

All Tabs - Check All
Jobs

This menu item will set all Jobs to the checked state allowing for a
quick and easy way of checking all Jobs across all Job Groups. 

All Tabs - Uncheck
All Jobs

This menu item will set all Jobs to the unchecked state allowing for a
quick and easy way of unchecking all Jobs across all Job Groups. 

Note:  Some features described on this page require the Enhanced Package.

6.  Selection Tree

The Selection Tree is located at the left side of the Profiler interface. The Selection Tree can also
be hidden by unchecking the "Selection Tree" option, accessed through the "Toolbars" item on
the View Menu.

Screens can be accessed through this interface, which are used to set synchronization criteria for

http://www.peersoftware.com/solutions/PeerSync_overview.asp
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individual Jobs (Job Settings), as well as set global properties relating to execution of the entire
Profile and all related Jobs (Global Settings). Once you have selected a Job or Jobs from the 
Profile Job List, all options configured on Job Settings screens will only be applied to those
selections. After synchronization criteria for all individual Jobs have been established, use the
Global Settings screens to set global properties relating to all Jobs, as well as choosing how you
would like the Profile to be executed. The Profile Job List will appear gray when any Global
Settings screen is displayed, indicating that all properties set on that screen will be applied to the
entire Profile.

Selection Tree: The Selection Tree can be set to Basic, Intermediate, Advanced or Customized.
Some Selection Tree items will not be accessible depending on the package you are currently
using.  

Pop-Up Menu: Activated by right clicking on the Selection Tree, this menu duplicates the items
listed in the Selection Tree, as well as, the items listed in the drop-down list located on the right
side of the Back button on the Tool Buttons Toolbar. This Menu offers the following options:

Show All Profile Options: This feature will toggle between showing all Profile Options and
the Custom Options in the Selection Tree. 

Customize: This feature will allow the user to select which Profile Options to display in the
Custom Selection Tree, when the "Show All Profile Options" is turned off. When selected
the user will be given the dialog box shown below to pick and choose which Profile Options
to use.

7.  Job Settings

A Job is a Source-Target backup/synchronization scenario. 

Jobs are created by identifying a Source Folder and a Target Folder, to which the contents of the
Source Folder will be synchronized to the Target Folder. Each Job has unique options, settings
and modes that can be applied to it.

These options, settings and modes are categorized into screens based on what they will do to the
Job or what they will do to the data that will be modified by the Job. 

These selections determine which contents will be synchronized and in what manner they will be
synchronized. As well as, when they will be synchronized according to your choice of Real-Time,
interval scheduling, daily timer scheduling, trigger driven or manually initiated operations.

Note:  Some settings are ignored when enabled in conjunction with other settings. For example, report summaries are
ignored in multiple threaded or enhanced Real-Time mode.

4 Topics
Folder Selection
Automation
Blackout Settings
Scan Limitations
File Options
Open Files
EOFM
Performance
Byte Replicator
Revisioning
Miscellaneous
Additional Features
Exceptions
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Reporting
Admin Reporting
Email Reporting
Compression
Pre/Post Process Options
Global Settings
Options/Commands
StartUp/Service
Run/View Current Profile

7.1  Folder Selection

4 Topics
 Folder Selection Overview 
 Source Mode Selection / Target Mode Selection 
 Source Folder Selection / Target Folder Selection 
 Include Subfolders 
 Swap Source and Target Folders 
 Last Run On
 Other Features

Note:  Features listed on this page may require the TCP WAN Connector and/or File Transfer Protocol (FTP) options.

7.1.1  Folder Selection Overview

Each Job within a Profile is initially defined by using the Folder Selection screen to select a
Source and Target Folder. The contents of a Source Folder will be synchronized to a Target
Folder according to criteria further defined on other Settings screens. Once you have highlighted
a Job or Jobs from the Profile Job List, this screen offers several different methods to locate and
select folders for synchronization. File paths can be typed manually, or you can browse local and
network drives to locate and select your desired folders. 

http://www.peersoftware.com/solutions/PeerSync_overview.asp
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7.1.2  Source Mode Selection

There are three Source folder selection Modes: Normal, TCP, and FTP. 

Normal Select Normal if you can navigate to the desired Source directory via a Local Path,
a UNC Path, or a Mapped Drive. This selection requires that the machine on which 
PeerSync is running has full access to the desired Source directory. In some
instances Network Logon may be required. 

TCP Select TCP if the Source directory is outside the scope of the machine on which
PeerSync is running. TCP enables access to machines not located on the same
network as PeerSync. As a prerequisite, the PSListener needs to be installed and
running on the remote Source machine in order for PeerSync to be able to
communicate with it. This feature supports encryption and compression.

Note: We strongly recommend the use of a VPN when transferring files over the public Internet for
security purposes. Otherwise, you should use our Encryption feature with a user name and password to
protect data and all communication as it is being transferred. 

FTP Select FTP to automatically logon to a Source FTP server. This feature supports
proxy servers/firewalls and has an option to adjust for GMT time on the FTP server
side.

Notes: 

1. The TCP feature listed on this page requires the TCP WAN Connector option. Please visit
http://www.peersoftware.com or contact Sales for additional information.

2. The FTP feature listed on this page requires the File Transfer Protocol (FTP) option. Please visit
http://www.peersoftware.com or contact Sales for additional information.

3. Generally performance will be optimal when PeerSync is installed on one of the machines involved in the
synchronization process (Source or Target).

7.1.3  Target Mode Selection

Target Mode selection is accomplished through the same method as that used for Source Mode
selection, with the following matching controls: 

There are three Target folder selection Modes: Normal, TCP, and FTP.   

Normal Select Normal if you can navigate to the desired Target directory via a Local Path, a
UNC Path, or a Mapped Drive. This selection requires that the machine on which 
PeerSync is running has full access to the desired Target directory. In some
instances Network Logon may be required. 

TCP Select TCP if the Target directory is outside the scope of the machine on which 
PeerSync is running. TCP enables access to machines not located on the same
network as PeerSync. As a prerequisite, the PSListener needs to be installed and
running on the remote Target machine in order for PeerSync to be able to
communicate with it. This feature supports encryption and compression.

Note: We strongly recommend the use of a VPN when transferring files over the public Internet for
security purposes. Otherwise, you should use our Encryption feature with a user name and password to
protect data and all communication as it is being transferred. 

http://www.peersoftware.com/solutions/PeerSync_overview.asp
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FTP Select FTP to automatically logon to a Target FTP server. This feature supports
proxy servers/firewalls and has an option to adjust for GMT time on the FTP server
side.

Notes: 

1. The TCP feature listed on this page requires the TCP WAN Connector option. Please visit
http://www.peersoftware.com or contact Sales for additional information.

2. The FTP feature listed on this page requires the File Transfer Protocol (FTP) option. Please visit
http://www.peersoftware.com or contact Sales for additional information.

3. Generally performance will be optimal when PeerSync is installed on one of the machines involved in the
synchronization process (Source or Target).

7.1.4  Source Folder Selection

Using Normal Mode  

Select a Source Folder by typing the file path into the field provided or by using the Select Source
Folder Button. By default, the Source Folder field will contain the path in which PeerSync has
been installed: in most cases this will be C:\Program Files\PeerSync\Source. The convention
outlined in this path must be used when manually typing entries, (i.e. a drive must be specified
followed by a colon, with subsequent folders separated by backslashes). This field is not case
sensitive, though spaces may only be entered where they are part of valid folder names (i.e.
"Program Files"). No space should appear between slashes and folder names. This field also
supports File/Folder Path Variables. 

UNC names can be entered manually, or can be selected from the Network Neighborhood using
the "Browse for Folder" dialog box (see Select Source Folder Button). UNC names will appear in
the form \\COMPUTER\SHAREDDEVICE\PATH. For example: \\SERVER11\D\USERDATA 

Note:  We do not recommend using UNC paths for folders that reside on the local machine, in this scenario you should
use the local path to that folder.

Folders can also be dragged and dropped from MS Windows Explorer into the Source Folder
Field for automatic insertion.

The Source Folder Field holds a folder selection History of up to 10 entries. They can be selected
by clicking on the drop down button located to the right of the field. 

The current path will be displayed below the Source Folder Selection Field. An invalid path will
display a red INVALID SELECTION label instead. If there are no efforts made to correct the
invalid path and you exit the Source Folder Selection field, the application will throw a message
and use the default PeerSync installation path C:\Program Files\PeerSync\Source instead.

The Host Name and User Name & Password values (if provided) are displayed above the Source
Folder Selection field (see Network Logon).

Using TCP Mode: 

When selecting the TCP Mode for the first time the Source TCP/Port Configuration window will
open automatically for Source Folder configuration. Otherwise, the previously entered TCP folder
path will be displayed. This path can be manually edited by typing directly into the field provided or
by using the Configuration button. The convention outlined in this path must be used when
manually typing entries, (i.e. the key word TCP must be specified followed by a colon, two
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backslashes, the Source IP address or machine name, and subsequent folders separated by
backslashes). This field is not case sensitive, though spaces may only be entered where they are
part of valid folder names (i.e. "Program Files"). No space should appear between slashes and
folder names. This field also supports File/Folder Path Variables. 

The Source Folder Field holds a folder selection History of more then 10 entries. They can be
accessed by clicking on the drop down button located to the right of the field. 

The current path will be displayed bellow the Source Folder Selection Filed. An invalid path will
display a red INVALID SELECTION label instead. If there are no efforts made to correct the
invalid path and you exit the Source Folder Selection field, the application will throw a message
and use the last valid TCP path specified or the default path TCP:\\127.0.0.1\C\Source. 127.0.0.1
represents the loopback IP address of the local host (i.e. the machine on which PeerSync is
running).

The provided Host Name and User Name & Password values are displayed above the Source
Folder Selection field. 

Using FTP Mode: 

When selecting the FTP Mode for the first time the Source FTP Logon Configuration window will
open automatically for Source Folder configuration. Otherwise, the previously entered FTP folder
path will be displayed. This path can be manually edited by typing directly into the field provided or
by using the Configuration button. The convention outlined in this path must be used when
manually typing entries, (i.e. the key word FTP must be specified followed by a colon, two forward
slashes, the Source IP address or machine name, and subsequent folders separated by forward
slashes). This field is not case sensitive, though spaces may only be entered where they are part
of valid folder names (i.e. "Program Files"). No space should appear between slashes and folder
names. This field also supports File/Folder Path Variables. 

The Source Folder Field holds a folder selection History of more then 10 entries. They can be
accessed by clicking on the drop down button located to the right of the field. 

The current path will be displayed bellow the Source Folder Selection Filed. An invalid path will
display a red INVALID SELECTION label instead. If there are no efforts made to correct the
invalid path and you exit the Source Folder Selection field, the application will throw a message
and use the last valid FTP path specified. 

The provided Host Name and User Name & Password values are displayed above the Source
Folder Selection field.

Notes: 

1. The TCP features listed on this page require the TCP WAN Connector option. Please visit
http://www.peersoftware.com or contact Sales for additional information.

2. The FTP features listed on this page require the File Transfer Protocol (FTP) option. Please visit
http://www.peersoftware.com or contact Sales for additional information.

3. You cannot monitor a TCP, FTP or any other remote folder/device in Real-Time.

4. Compression, Bi-directional synchronization mode, File Recovery, Exclude empty Source Folders, Turn file archive
attribute off after synchronization and CRC32, as well as other non applicable features are ignored when using an FTP
Source.

5. Folder Compression and Bi-directional synchronization mode, as well as other non applicable features are  ignored
when using a TCP Source.

6. Selecting an FTP Source and a FTP Target for the same Job is not recommended/supported.
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7. Selecting a TCP Source and a TCP Target for the same Job is not supported.

4 Related Options
Source Folder Configuration Button
Select Source Folder Button
Explore/Open/Create Button
Source Folder Popup Menu

Using Normal Mode: 

The Source Folder Configure Button is activated by clicking on the Configure button located in
right lower corner of the Source Folder panel/section. Selecting the Configure button opens the
Source Network Logon Settings window. Alternatively, you may right-click on the Source
Folder field and select Configure: Source Folder (See Source Folder Popup Menu). This window
allows for network logon Name and Password information for a remote Source connection. 

Using TCP Mode: 

The Source Folder Configure Button is activated by clicking on the Configure button located in
right lower corner of the Source Folder panel/section. Selecting the Configure button opens the
Source TCP/Port Configuration window. Alternatively, you may right-click on the Source Folder
field and select Configure: Source Folder (See Source Folder Popup Menu). 

TCP Configuration Tab 

This tab provides a guided method for entering the Source TCP path. 

Host Name: Enter the IP address or machine name of the Source Folder into this filed.
You may use the machine name only if the remote Source Machine resides
on the same network as that on which PeerSync is running. 
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Path to Host: Provide the full path (i.e. C:\Documents and Settings\Source) to the Source
folder in this field. The path entered needs to be a local path without a
machine name or UNC format. This field does not validate the existence of
the path you provide therefore you must exercise great care when doing so.
If the path does not exist, PeerSync will create it during run time as long as
a valid host name or IP address has been provided and it can find the drive
letter specified.

Care must be exercised if your PSListener contains a "Root Path". If you
specify such a path in your PSListener it will behave like an FTP server that
sets Root Paths to limit user access to the local file system. If a "Root Path"
exists on the PSListener it will limit PeerSync's ability to access directories
on the remote device. PeerSync will only be able to access directories equal
to or bellow the specified "Root Path" level provided that it meets the Port
and Encryption requirements. In no circumstances can PeerSync access
directories located above this path. If the remote path you enter in the Path
to Host  field references a directory above the "Root Path", PeerSync will
create that folder structure at runtime bellow the "Root Path". 

Example: 

PSListener "Root Path" = C:\Backup\Users\Admin
PeerSync's "Path to Host"  = C:\Backup\My Documents
Actual Remote Source Path =

C:\Backup\Users\Admin\C\Backup\M
y Documents

Note: The "Root Path" will be ignored when performing byte-level replication using Normal
Mode (i.e. Local or UNC paths). 

Port Configuration Tab  

This tab provides settings to be used by both the Source and Target connections when using
TCP and/or Byte Replicator. 

Time Out
Sets the amount of time a connection will wait to complete a data transfer
before exiting and performing the failure operation. 

Port This is the TCP Port used to communicate with the Listener on the remote
machine. This must match the port number that the PSListener is
configured for. By default both Listener and PeerSync use port 7333.

Compression Uses a lossless compression algorithm to transmit data in fewer bits. By
default Compression is disabled to achieve faster performance. 

Use Encryption By default Encryption is enabled in both PeerSync and PSListener. This
option uses strong DES encryption to encrypt data and communication as it
is being transmitted over the Internet, LAN, WAN, or VPN. For enhanced
security we recommend you provide your own User Name and Password as
key values. PeerSync will use these values to further encrypt data and
communication transmitted between sites. You must enter the same
values on the PSListener side. 

Using FTP Mode: 

The Source Folder Configure Button is activated by clicking on the Configure button located in
right lower corner of the Source Folder panel/section. Selecting the Configure button opens the
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Source FTP Configuration window. Alternatively, you may right-click on the Source Folder field
and select Configure: Source Folder (See Source Folder Popup Menu). 

FTP Configuration Tab

Provides a guided method for entering the Source FTP path as well as connection
authentication. 

Host Name Enter the IP address or machine name of the Source folder into this filed.
You may use the machine name only if the FTP Source machine resides on
the same network as that on which PeerSync is running. 

Path to Host Provide the full path to the Source folder in this field (i.e. /FTProot/My
Data/Source). Make sure the path begins at the base directory to which the
FTP server allows connection. The path does not need to be preceded by
the key phrase 'FTP' however it must start with a forward slash ( / ). This
field does not validate the existence of the path you provide therefore you
must exercise great care when doing so. If the path does exist, PeerSync
will create it during run time as long as a valid host name or IP address has
been provided.

User Name Stores the Source FTP User Name information for login.

Password Stores the Source FTP Password information for login.

FTP Settings 

Provides configuration for the FTP Source Selection.

Enable Passive
Mode

Sets the FTP mode to passive. The phrase passive refers to the FTP server
which passively accepts connections and data while the client initiates both
the control connection and the data connection to random ports specified by
the server. Passive mode is enabled by default. 

Host is using
GMT

Option to adjust for GMT time on the FTP server side. 

Time Out
(seconds) 

Sets the amount of time a connection will wait to complete a data transfer
before exiting and performing the failure operation. 

Port Port number used to initiate an FTP session or "command" connection to
the FTP server. Uses standard port 21 by default. 

Use Proxy -
Firewall

This option allows you to specify the Host Name, User ID, Password, and
Port number to a network Proxy - Firewall.

File types to
transfer as
ASCII  

Through this field, file types can be selectively tagged for transfer as ASCII
upon synchronization. These file types are set by specifying file extensions
(i.e. ".txt") which, if found within a file name, will be transferred as an ASCII
file during synchronization. Multiple strings will be semicolon delimited.
These settings are not case sensitive, (i.e. "A" = "a"). 

File types can be typed manually, or can be specified using either the Files to Transfer as ASCII
Button or drop-down list located to the right of the field. The drop-down list located to the right of
this field will be dynamically populated with file types as they are set through the dialog box
described above. They are also added to the list when you exit the field after manually editing the
file types field. File types can then be specified by selecting them from this list. This provides a
way to store and/or retrieve sets of file types for later use with other Jobs.
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Notes:

1. The TCP features listed on this page require the TCP WAN Connector option. Please visit
http://www.peersoftware.com or contact Sales for additional information.

2. The FTP features listed on this page require the File Transfer Protocol (FTP) option. Please visit
http://www.peersoftware.com or contact Sales for additional information. 

Located to the right of the Source Folder Selection Field, this button opens a "Browse for Folder"
dialog box. Once this box has opened, locate your chosen Source folder, select it using the left
mouse button, and click "OK." 

Note:  This button is not available when selecting TCP or FTP Modes for Source or Target.

This button provides three options to be selected from the attached drop-down list. The button
label will change to reflect whichever item has been checked on this list. 

 When "Explore" has been selected and the button is depressed, an Explorer-type window will
open displaying all available directories. By default, this window will show the folder whose path is
currently designated in the Source Field. If the folder shown in this field does not exist, Profiler will
display a dialog alerting you to this fact and asking if you would like to create it. You may do so by
clicking the "Yes" button located at the bottom of this dialog. Once you have done so the newly
created folder will be shown in the Explorer-type window. 

 When "Open" has been selected and the button is depressed, a traditional MS navigation
window is opened displaying the contents of whichever folder is currently shown in the Source
Folder Field. If this folder does not exist, Profiler will display a dialog alerting you to this fact and
asking if you would like to create it. You may do so by clicking the "Yes" button located at the
bottom of this dialog. Once you have done so the newly created Folder will be shown in the
navigation window. 
  
 When "Create" has been selected and the button is depressed, a "Select Directory" dialog will
open allowing you to specify a Source Folder path by using the mouse to select a desired drive,
directory, and folder. Folder paths can also be manually entered into the "Directory Name" field. If
you enter a path for a folder that does not exist and hit the ENTER key or click "OK," a dialog box
will appear allowing you to create this folder.

Note:  This button is not available when selecting TCP or FTP Modes for Source or Target.

Using Normal Mode: 

The Source Folder PopUp Menu is activated by right clicking on the Source Folder field. The first
four features allow the user to Browse for Source Folder, Explore, Open and/or Create the
Source Folder selection. 

Configure: Source Folder: Selecting this option displays the Source Network Logon Settings
window. This allows the user to specify Network Logon credentials for the Source Folder which
enables connection to directories that are not accessible with the current logged on account. 

Edit: Source Variable File: This will allow the user to view/edit Variable Data Import and/or Job
Data Import files that are used in the Source Folder selection. This option is only available if using
Job data import files.

Create Auto Job Name: This feature allows a simple way to generate meaningful Job names.
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When selecting this item, Job names are automatically generated based on their Source and
Target paths which make it a simple task to organize the Job list. 
 

Using TCP Mode: 

The Source Folder PopUp Menu is activated by right clicking on the Source Folder field. The first
two features allow the user to Explore and Open the Source Folder selection. 

Configure: Source Folder: Selecting this option displays the Source TCP/Port Configuration
window. This window provides a guided method for entering the Source TCP path as well as TCP
and/or Byte Replicator settings (see TCP Configuration).

Create Auto Job Name: This feature allows a simple way to generate meaningful Job names.
When selecting this item, Job names are automatically generated based on their Source and
Target paths which make it a simple task to organize the Job list. 

Notes:  

1. The TCP features listed above require the TCP WAN Connector option. Please visit http://www.peersoftware.com or
contact Sales for additional information.

2. The Browse for Source Folder and Create options are not available when using TCP Source Mode. 

Using FTP Mode: 

The Source Folder PopUp Menu is activated by right clicking on the Source Folder field. The first
feature allows the user to Open the Source Folder selection. 

Configure: Source Folder: Selecting this option displays the Source FTP Configuration window.
This window provides a guided method for entering the Source FTP path, specify network
authentication, as well as FTP configuration options (see FTP Configuration).

Create Auto Job Name: This feature allows a simple way to generate meaningful Job names.
When selecting this item, Job names are automatically generated based on their Source and
Target paths which make it a simple task to organize the Job list. 

Notes:  

1. The FTP features listed above require the File Transfer Protocol (FTP) option. Please visit
http://www.peersoftware.com or contact Sales for additional information. 

2. The Browse for Source Folder, Explore, and Create options are not available when using FTP Source Mode.

7.1.5  Target Folder Selection

Target Folder selection is accomplished through the same method as that used for Source Target
selection, with the following matching controls: 

Using Normal Mode: 

Select a Target Folder by typing the file path into the field provided or by using the Select Target
Folder Button. By default, the Target Folder field will contain the path in which PeerSync has been
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installed: in most cases this will be C:\Program Files\PeerSync\Target.  The convention outlined in
this path must be used when manually typing entries, (i.e. a drive must be specified followed by a
colon, with subsequent folders separated by backslashes). This field is not case sensitive, though
spaces may only be entered where they are part of valid folder names (i.e. "Program Files"). No
space should appear between slashes and folder names. This field also supports File/Folder Path
Variables. 

UNC names can be entered manually, or can be selected from the Network Neighborhood using
the "Browse for Folder" dialog box (see Select Target Folder Button). UNC names will appear in
the form \\COMPUTER\SHAREDDEVICE\PATH. For example: \\SERVER11\D\USERDATA 

Note:  We do not recommend using UNC paths for folders that reside on the local machine, in
this scenario you should use the local path to that folder.

Folders can also be dragged and dropped from MS Windows Explorer into the Target Folder
Field for automatic insertion.

The Target Folder Field holds a folder selection History of more then 10 entries. They can be
selected by clicking on the drop down button located to the right of the field. 

The current path will be displayed bellow the Target Folder Selection Filed. An invalid path will
display a red INVALID SELECTION label instead. If there are no efforts made to correct the
invalid path and you exit the Target Folder Selection field, the application will throw a message
and use the default PeerSync installation path C:\Program Files\PeerSync\Target instead.

The Host Name and User Name & Password values (if provided) are displayed above the Target
Folder Selection field (see Network Logon).

Using TCP Mode: 

When selecting the TCP Mode for the first time the Target TCP/Port Configuration window will
open automatically for Target Folder configuration. Otherwise, the previously entered TCP folder
path will be displayed. This path can be manually edited by typing directly into the field provided or
by using the Configuration button. The convention outlined in this path must be used when
manually typing entries, (i.e. the key word TCP must be specified followed by a colon, two
backslashes, the Target IP address or machine name, and subsequent folders separated by
backslashes). This field is not case sensitive, though spaces may only be entered where they are
part of valid folder names (i.e. "Program Files"). No space should appear between slashes and
folder names. This field also supports File/Folder Path Variables. 

The Target Folder Field holds a folder selection History of more then 10 entries. They can be
accessed by clicking on the drop down button located to the right of the field. 

The current path will be displayed bellow the Target Folder Selection Filed. An invalid path will
display a red INVALID SELECTION label instead. If there are no efforts made to correct the
invalid path and you exit the Target Folder Selection field, the application will throw a message
and use the last valid TCP path specified or the default path TCP:\\127.0.0.1\C\Target. 127.0.0.1
represents the loopback IP address of the local host (i.e. the machine on which PeerSync is
running).

The provided Host Name and User Name & Password values are displayed above the Target
Folder Selection field (see Configuration Button).

Using FTP Mode: 
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When selecting the FTP Mode for the first time the Target FTP Logon Configuration window will
open automatically for Target Folder configuration. Otherwise, the previously entered FTP folder
path will be displayed. This path can be manually edited by typing directly into the field provided or
by using the Configuration button. The convention outlined in this path must be used when
manually typing entries, (i.e. the key word FTP must be specified followed by a colon, two forward
slashes, the Target IP address or machine name, and subsequent folders separated by forward
slashes). This field is not case sensitive, though spaces may only be entered where they are part
of valid folder names (i.e. "Program Files"). No space should appear between slashes and folder
names. This field also supports File/Folder Path Variables. 

The Target Folder Field holds a folder selection History of up to 10 entries. They can be accessed
by clicking on the drop down button located to the right of the field. 

The current path will be displayed bellow the Target Folder Selection Filed. An invalid path will
display a red INVALID SELECTION label instead. If there are no efforts made to correct the
invalid path and you exit the Target Folder Selection field, the application will throw a message
and use the last valid FTP path specified. 

The provided Host Name and User Name & Password values are displayed above the Target
Folder Selection field (see Configuration Button).

Notes: 

1. TCP (i.e.TCP WAN Connector Option) and FTP are optional modes which may not be included in your package.
Please visit http://www.peersoftware.com or contact Sales for additional information.
  
2.Folder Compression and Bi-directional synchronization mode, as well as other non applicable features are ignored
when using a TCP Target.
 
3. Selecting an FTP Source and a FTP Target for the same Job is not recommended/supported.
 
4. Selecting a TCP Source and a TCP Target for the same Job is not supported.

4 Related Options
Target Folder Configuration Button
Select Target Folder Button
Explore/Open/Create Button
Target Folder Popup Menu
Alternate Target Path Selection

Using Normal Mode: 

The Target Folder Configuration Button can be activated by clicking on the Configure button
located in right lower corner of the Target Folder panel/section. Selecting the Configure button
opens the Target Network Logon Settings window. Alternatively, you may right-click on the Target
Folder field and select Configure: Target Folder (See Target Folder Popup Menu). This window
allows for network logon Name and Password information for a remote Target connection. 

Using TCP Mode: 

The Target Folder Configuration Button can be activated by clicking on the Configure button
located in right lower corner of the Target Folder panel/section. Selecting the Configure button
opens the Target TCP/Port Configuration window. Alternatively, you may right-click on the Target
Folder field and select Configure: Target Folder (See Target Folder Popup Menu). 

http://www.peersoftware.com
http://www.peersoftware.com/contact/contact_sales.asp
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TCP Configuration Tab

This window provides a guided method for entering the Target TCP path. 

Host Name: Enter the IP address or machine name of the Target folder into this filed.
You may use the machine name only if the remote Target machine resides
on the same network as that on which PeerSync is running. 

Path to Host: Provide the full path (i.e. C:\Documents and Settings\Target) to the Target
folder in this field. The path entered needs to be a local path without a
machine name or UNC format. This field does not validate the existence of
the path you provide therefore you must exercise great care when doing so.
If the path does exist, PeerSync will create it during run time as long as a
valid host name or IP address has been provided and it can find the drive
letter specified.

Care must be exercised if your PSListener contains a "Root Path". If you
specify such a path in your PSListener it will behave like an FTP server that
sets Root Paths to limit user access to the local file system. If a "Root Path"
exists on the PSListener it will limit PeerSync's ability to access directories
on the remote device. PeerSync will only be able to access directories equal
to or bellow the specified "Root Path" level provided that it meets the Port
and Encryption requirements. In no circumstances can PeerSync access
directories located above this path. If the remote path you enter in the Path
to Host  field references a directory above the "Root Path", PeerSync will
create that folder structure at runtime bellow the "Root Path". 

Example: 

PSListener "Root Path" = C:\Backup\Users\Admin
PeerSync's "Path to Host"  = C:\Backup\My Documents
Actual Remote Target Path =

C:\Backup\Users\Admin\C\Backup\M
y Documents

Note: The "Root Path" will be ignored when performing byte-level replication using Normal
Mode (i.e. Local or UNC paths). 

Port Configuration Tab 

Provides settings to be used by both the Source and Target connections when using TCP
and/or Byte Replicator. 

Time Out
Sets the amount of time a connection will wait to complete a data transfer
before exiting and performing the failure operation. 

Port This is the TCP Port used to communicate with the Listener on the remote
machine. This must match the port number that the PSListener is
configured for. By default both Listener and PeerSync use port 7333.

Compression Uses a lossless compression algorithm to transmit data in fewer bits. By
default Compression is disabled to achieve faster performance. 
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Use Encryption By default Encryption is enabled in both PeerSync and PSListener. This
option uses strong DES encryption to encrypt data and communication as it
is being transmitted over the Internet, LAN, WAN, or VPN. For enhanced
security we recommend you provide your own User Name and Password as
key values. PeerSync will use these values to further encrypt data and
communication transmitted between sites. You must enter the same
values on the PSListener side. 

Using FTP Mode: 

The Target Folder Configuration Button can be activated by clicking on the Configure button
located in right lower corner of the Target Folder panel/section. Selecting the Configure button
opens the Target FTP Configuration window. Alternatively, you may right-click on the Target
Folder field and select Configure: Target Folder (See Target Folder Popup Menu). 

FTP Configuration Tab

Provides a guided method for entering the Target FTP path as well as connection
authentication. 

Host Name Enter the IP address or machine name of the Target folder into this filed.
You may use the machine name only if the FTP Target machine resides on
the same network as that on which PeerSync is running. 

Path to Host Provide the full path to the Target folder in this field (i.e. /FTProot/My
Data/Target). Make sure the path begins at the base directory to which the
FTP server allows connection. The path does not need to be preceded by
the key phrase 'FTP' however it must start with a forward slash ( / ). This
field does not validate the existence of the path you provide therefore you
must exercise great care when doing so. If the path does exist, PeerSync
will create it during run time as long as a valid host name or IP address has
been provided.

User Name Stores the Target FTP User Name information for login.

Password Stores the Target FTP Password information for login.

FTP Settings Tab

Provides configuration for the FTP Target selection.

Enable Passive
Mode

Sets the FTP mode to passive. The phrase passive refers to the FTP server
which passively accepts connections and data while the client initiates both
the control connection and the data connection to random ports specified by
the server. Passive mode is enabled by default. 

Host is using
GMT

Option to adjust for GMT time on the FTP server side. 

Time Out
(seconds) 

Sets the amount of time a connection will wait to complete a data transfer
before exiting and performing the failure operation. 

Port Port number used to initiate an FTP session or "command" connection to
the FTP server. Uses standard port 21 by default. 
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Use Proxy -
Firewall

This option allows you to specify the Host Name, User ID, Password, and
Port number to a network Proxy - Firewall.

File types to
transfer as
ASCII  

Through this field, file types can be selectively tagged for transfer as ASCII
upon synchronization. These file types are set by specifying file extensions
(i.e. ".txt") which, if found within a file name, will be transferred as an ASCII
file during synchronization.  Multiple strings will be semicolon delimited. 
These settings are not case sensitive, (i.e. "A" = "a") 

File types can be typed manually, or can be specified using either the Files to Transfer as ASCII
Button or drop-down list located to the right of the field.  The drop-down list located to the right of
this field will be dynamically populated with file types as they are set through the dialog box
described above.  They are also added to the list when you exit the field after manually editing the
file type field.   File types can then be specified by selecting them from this list.  This provides a
way to store and/or retrieve sets of file types for later use with other Jobs.

Notes:

1. The TCP features listed on this page require the TCP WAN Connector option. Please visit
http://www.peersoftware.com or contact Sales for additional information.

2. The FTP features listed on this page require the File Transfer Protocol (FTP) option. Please visit
http://www.peersoftware.com or contact Sales for additional information. 

Located to the right of the Target Folder Selection Field, this button opens a "Browse for Folder"
dialog box: once this box has opened, locate your chosen Target folder, select it using the left
mouse button, and click "OK." 

Note:  This button is not available when selecting TCP or FTP Modes for Source or Target.

This button provides three options to be selected from the attached drop-down list. The button
label will change to reflect whichever item has been checked on this list. 

When "Explore" has been selected and the button is depressed, an Explorer-type window will
open displaying all available directories. By default, this window will show the folder whose path is
currently designated in the Target field. If the folder shown in this field does not exist, Profiler will
display a dialog alerting you to this fact and asking if you would like to create it: you can do so by
clicking the "Yes" button located at the bottom of this dialog. Once you have done so the newly
created Folder will be shown in the Explorer-type tree.

When "Open" has been selected and the button is depressed, a traditional MS navigation window
is opened displaying the contents of whichever folder is currently shown in the Target Folder
Field. If this folder does not exist, Profiler will display a dialog alerting you to this fact and asking if
you would like to create it: you can do so by clicking "Yes" button located at the bottom of this
dialog. Once you have done so the newly created Folder will be shown in the navigation window.  

When "Create" has been selected and the button is depressed, a "Select Directory" dialog will
open allowing you to specify a Target Folder path by using the mouse to select a desired drive,
directory, and folder (See image in "Source Folder Selection" topic above). Folder paths can also
be manually entered into the "Directory Name" field. If you enter a path for a folder that does not
exist and hit the ENTER key or click "OK," a dialog box will appear allowing you to create this
folder.

Note:  This button is not available when selecting TCP or FTP Modes for Source or Target.

http://www.peersoftware.com/solutions/PeerSync_overview.asp
http://www.peersoftware.com
http://www.peersoftware.com/contact/contact_sales.asp
http://www.peersoftware.com/solutions/PeerSync_overview.asp
http://www.peersoftware.com
http://www.peersoftware.com/contact/contact_sales.asp
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Using Normal Mode: 

The Target Folder PopUp Menu is activated by right clicking on the Target Folder field. The first
four features allow the user to Browse for Target Folder, Explore, Open and/or Create the
Target Folder selection. 

Configure: Target Folder: Selecting this option displays the Target Network Logon Settings
window. This allows the user to specify Network Logon credentials for the Target Folder which
enables connection to directories that are not accessible with the current logged on account. 

Edit: Target Variable File: This will allow the user to view/edit Variable Data Import and/or Job
Data Import files that are used in the Target Folder selection. This option is only available if using
Job data import files.

Create Auto Job Name: This feature allows a simple way to generate meaningful Job names.
When selecting this item, Job names are automatically generated based on their Source and
Target paths which make it a simple task to organize the Job list. 

Set Alternate/Additional Targets: Selecting this menu item will open the Alternate/Additional
Targets selection window. This feature allows for alternate or additional Target paths associated
with the base Job. 

Force Source Folder Root as Target Folder Root: Appends the Source folder directory to the
Target folder path.

Using TCP Mode: 

The Target Folder PopUp Menu is activated by right clicking on the Target Folder field. The first
two features allow the user to Explore and Open the Target Folder selection. 

Configure: Target Folder: Selecting this option displays the Target TCP/Port Configuration
window. This window provides a guided method for entering the Target TCP path as well as TCP
and/or Byte Replicator settings (see TCP Configuration). 

Create Auto Job Name: This feature allows a simple way to generate meaningful Job names.
When selecting this item, Job names are automatically generated based on their Source and
Target paths which make it a simple task to organize the Job list. 

Force Source Folder Root as Target Folder Root: Appends the Source folder directory to the
Target folder path.

Using FTP Mode: 

The Target Folder PopUp Menu is activated by right clicking on the Target Folder field. The first
feature allows the user to Open the Target Folder selection. 

Configure: Target Folder: Selecting this option displays the Target FTP Configuration window.
This window provides a guided method for entering the Target FTP path, specify network
authentication, as well as FTP configuration options (see FTP Configuration).

Create Auto Job Name: This feature allows a simple way to generate meaningful Job names.
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When selecting this item, Job names are automatically generated based on their Source and
Target paths which make it a simple task to organize the Job list. 

Force Source Folder Root as Target Folder Root: Appends the Source folder directory to the
Target folder path.

Notes:  

1. The TCP features listed on this page require the TCP WAN Connector option. Please visit
http://www.peersoftware.com or contact Sales for additional information.

2. The FTP features listed on this page require the File Transfer Protocol (FTP) option. Please visit
http://www.peersoftware.com or contact Sales for additional information. 

3. The Browse, Explore, Create, and Set Alternate/Additional Target options are not available when using TCP and FTP
Target Modes.

 This link will be enabled if you are using a Normal Target Mode Selection. By selecting this link
you can set and access your current Alternate Target Path Selections. Through this feature, Jobs
can now have alternate or additional Target paths associated with the base Job. This allows for
the ability to redirect data on a failed connection to the base Target and/or easily setup,
one-to-many scenarios for distribution purposes. Selecting this menu item will open the Alternate
Target Path Selection dialog:

To add an alternate or additional Target click "New," then type the desired path into the field
located at the bottom of the dialog or select the "Browse" button to select a path.. Repeat this
process for each Target path you wish to add. Entries can be deleted by selecting them from the
list and clicking the "Delete" key at the bottom of the box. You can also use the "Up" and "Down"
buttons to reorder the paths.

Notes:

1. This feature requires the Enhanced Package. 

2. Alternate Target Path Selection is not available for TCP or FTP Target Mode Selections.

3. When using Alternate Target Path Selections you cannot use variables that are specific to the Job (i.e. %JobName%,
%SourcePath%, etc.) for the Move unmatched Target Files option.

7.1.6  Files to transfer as ASCII Button

The "Files to transfer as ASCII" option is available from the FTP Settings Tab for both Source and
Target FTP selection modes. Clicking on the button to the right of this field opens a dialog box
into which file types may be entered. 

To add a File Type click "New," then type the desired file type into the field located at the bottom
of the dialog. Repeat this process for each File type. Entries can be deleted by selecting them
from the list and clicking the "Delete" key at the bottom of the box. Once you have finished, click
the "OK" button. The box will close and all of the file types you have specified will automatically
appear in the Files to transfer as ASCII field.

Note: This feature requires the FTP option which may not be included in your package. Please visit
http://www.peersoftware.com or contact Sales for additional information.

http://www.peersoftware.com/solutions/PeerSync_overview.asp
http://www.peersoftware.com
http://www.peersoftware.com/contact/contact_sales.asp
http://www.peersoftware.com/solutions/PeerSync_overview.asp
http://www.peersoftware.com
http://www.peersoftware.com/contact/contact_sales.asp
http://www.peersoftware.com/solutions/PeerSync_overview.asp
http://www.peersoftware.com
http://www.peersoftware.com/contact/contact_sales.asp
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7.1.7  Include Subfolders

If this check box is selected, all sub-folders contained within the Source Folder will be
synchronized to the Target.

7.1.8  Swap Source and Target Folders

This button reverses placement of the file paths shown in the Source and Target Folder Fields (so
that what was formerly a Source Folder now becomes a Target Folder, and vice versa).

7.1.9  Last Run On

This is the date/time of the last bi-directional synchronization scan of a Job that will be used when
comparing files during the Bi-directional Synchronization Mode option on the File Options screen.
This feature is also displayed and can be reset from the Profile Job List Pop-Up Menu.

7.1.10  Other Features

This section describes additional features related to the Folder Selection topic. The features
below apply to both the Source and Target folder selections and related configuration options. 

4 Topics
File/Folder Path Variables
Variable Data Import 
Job Data Import 
Dynamic Network Drive Mapping and Unmapping

Variable file/folder paths can be used to create:

Dynamic archives for yearly, monthly, weekly and/or daily backups
Dynamic synchronization based on date
Dynamic synchronization based on logged on user or machine name
Dynamic synchronization based on personal folders or other variables read in from the registry
Log file storage, manipulation and organization
Administrative report file storage, manipulation and organization
Deleted file storage, manipulation and organization

The following variables can be used in any folder path Job setting available through the Profiler:
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Date
Time
Date/Time 
Minute
Hour
Day
Year
Month/Year
Minute (all formats)
Hour (all formats)
Day (all formats)
Month (all formats)
Year (all formats)

%Date%
%Time% 
%DateTime%
%Minute%
%Hour%
%Day%
%Year%
%MonthYear%
%n, nn%
%h, hh%
%d, dd, ddd, dddd, ddddd, dddddd%
%m, mm, mmm, mmmm, mmmm%
%y, yy%

Logged On User Name
Computer Name
Job Name
Source Folder Path
Target Folder Path
Deletion Folder Path
Report File Path

%UserName%
%ComputerName%
%JobName% 
%SourcePath%
%TargetPath%
%DeletePath%
%ReportPath%

Windows Directory
Windows
System Temp Path
System Temp Path
System Drive Letter
System 32 (WIN
9x/NT/00)

%WinDir%
%Windows% (also %SystemRoot%)
%Temp%
%Tmp%
%SystemDrive%
%System32%

Depending upon the argument used, these folders will be dated, named after the currently logged
user, named for the PC from which synchronization was launched, or based on a pre-determined
variable stored out and read in from the registry. 

Note:  You can also use any variables that are located in the registry under:
HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer\Shell Folder

PeerSync now contains tools for importing data from files. The ability to extract specific fields of
data from a file has been included to allow unlimited scalability. Within an organization, one
generic Profile can now be created, and utilizing text files, specific information about the user and
the desired folders to be synchronized can be imported dynamically. Variables can be used to
dynamically introduce data from a file into various fields throughout the interface including file
paths, deletion paths, log file paths, log file names, etc.

Field data is imported through: 

<<#FileName.txt [section] item#>>

In which the [section] is a defined field in a file, such as the example file content below.
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[Info] 
Name=Cris Smith
Home=c:\mydocuments

Using <<#FileName.txt [Info] Name#>> will import "Cris Smith" into the path it was used in and
using <<#FileName.txt [Info] Home#>> will import "c:\mydocuments" into the path it was used in. 

Note: This feature requires the Enhanced Package. 

PeerSync now contains tools for importing data from files to dynamically create Jobs. Within an
organization, one generic Profile can now be created, and utilizing text files, specific information
about the user and the desired folders to be synchronized can be imported dynamically. Lists can
be used in Source and Target path names as such:

Source: <<$FileNameSources.txt$>>
Target: <<$FileNameTargets.txt$>>

or: 

Source: <<$C:\Path\To\File\FileNameSources.txt$>>
Target: <<$C:\Path\To\File\FileNameTargets.txt$>>

Corresponding entries of each delimited file entry will be used to dynamically create a Job based
upon the Jobs properties.

Note: This feature requires the Enhanced Package. 

PeerSync allows for the ability to dynamically map and un-map a Source or Target folder
selection. The way you do this is to add a letter to the beginning of the UNC path that you wish to
map the drive to. This can be done for the Source or Target selection (i.e.
n\\COMPUTER\SHAREDDEVICE\PATH).

For Example: n\\DELLSERVER\D\USERDATA 

The example above will map the D drive on the DELLSERVER to the N drive upon start of 
PeerSync and will unmap the drive when PeerSync terminates. This is a quite useful feature
especially when running PeerSync as a service in the scenario where you want to synchronize to
a mapped drive. This feature will allow for it to occur seamlessly. 

Note: If you are going to run PeerSync as a Service it is advised to use UNC paths or PeerSync's
Dynamic Network Drive Mapping and Unmapping feature instead of using mapped drives due to
the fact that mapped drives are not understood when a user is not logged on.

Next/Last Available Drive Mapping 

This feature allows for the dynamic mapping of the next (A) or last (B) available network drive by
using the following format in the Source or Target Fields:

Map Next Available Example:  A\\COMPUTER\SHAREDDEVICE\PATH
Map Last Available Example:  B\\COMPUTER\SHAREDDEVICE\PATH

Local Drive Mapping

http://www.peersoftware.com/solutions/PeerSync_overview.asp
http://www.peersoftware.com/solutions/PeerSync_overview.asp
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This feature allows for the dynamic mapping of a local drive by using the following format in the
Source or Target Fields:

Map Local to N Example: N\\LOCALCOMPUTER\SHAREDDEVICE\PATH

7.2  Automation

4 Topics
Automation Overview
Scanning Options
Real-Time Event Detection Options

7.2.1  Automation Overview

The Automation screen allows you to apply Real-Time Monitored or Scheduled synchronization to
individual Jobs within a given Profile. Real-Time operations (also referred to as "File/Folder
Change Detection") monitor Source Folders for any changes and synchronize them to the
specified Target as they occur (and vice versa). Scheduled operations automatically launch
synchronization according to a user-specified schedule. Through these settings, PeerSync allows
you to build a Profile with as many as 255 different Jobs -- each run according to a unique
schedule or in Real-Time (Also see Options/Commands for Global Automation Settings).

7.2.2  Scanning Options

Scan Job once at start:  This feature directs PeerSync to run the current Job as an Automatic
Operation. An Automatic Operation allows you to perform an immediate launch of the current
Profile. As a non-persistent process, Automatic Operations are run a single time upon manual
initiation by the user. We also refer to this type of run as an Initial Sync. 
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Scan Job every x minute(s):  Checking this feature assigns a Scheduled operation to the
selected Job(s). The field associated with this feature allows you to set an interval in minutes:
after this time has elapsed the selected folders will be synchronized. 5 minutes is the default
setting. Intervals in seconds can be specified through the use of decimals, (i.e. 0.5, 2.5, etc.); the
minimum interval is 0.01.   

 Scan Job at (specific daily timer schedule):  Checking this feature will allow for the
synchronization of Jobs at a specific times of the day for selected days of the week. 

Daily Timer Options Button:  This button opens the "Daily Timer Options" dialog box. Once this
box has opened, it gives you the following features: 

Run selected Jobs at:  Selecting this feature will run the Job at the selected time of day.

List of Job Selections:  This is a list of the currently selected Daily Timer selections. You
can Add New selections by selecting the New button and Delete existing selections by
selecting the Delete button. 

Select days of week to run:  Allows you to turn on/off which days to run this schedule.

Selection Options:  This feature will give you the option to run the selected daily timer
schedules in a Recurring mode (synchronization will run every time according to the set
scheduled options) or Run Once (synchronization will run only once).

7.2.3  Real-Time Event Detection Options

Use Real-Time Monitoring:  Selects the current Job(s) for Real-Time Monitoring.

Real-Time Options Button:  This button opens an "Additional Options" dialog box. Once this box
has opened, it allows you to choose from two Real-Time operations. The first is a Folder
Replication feature, which monitors for changes to the Source Folder and synchronizes the
Target accordingly. The second, a Folder Restoration feature, monitors for changes to the Target
Folder and restores files on the Target accordingly. To properly use the restore feature, you will
need to select the "Always overwrite Target files" option. 

Notes:

1. Bi-directional will be ignored for Real-Time Jobs.

2.  When synchronizing to an FTP Target, PeerSync will suppress Real-Time Jobs until initial synchronization has
completed.

 
Use Enhanced Real-Time Monitoring:  Enhanced Real-Time file monitoring and updating
option. This feature allows the Real-Time feature in PeerSync to detect individual changes to files
and synchronize only the file which has changed without scanning the entire folder where the
change occurred. Normally, synchronization software scans and compares all files into a folder
which is being synchronized. This feature does not scan folders unless the change is
indeterminate. Under MS Windows NT4/2000, this feature is extended to the file/folder rename
operations as well. If a file or folder is renamed, PeerSync will rename the corresponding Target
File or folder using rename functions as opposed to copying the newly renamed Source Folder to
the Target and then subsequently deleting the outdated Target file/folder. This feature greatly
reduces the time required to synchronize files and also reduces network band width
requirements.

Notes:

1. Bi-directional, During comparison subtract/add x minute(s) from Target, and Trigger Selections, as well as, other non
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applicable features may be ignored during Enhanced Real-Time.

2. It is recommended either use the Enhanced Real-Time option for all or none of your Real-Time Jobs within a Profile.

3. Using Enhanced Real-Time will produce a different file output format for all modes of reporting and message logging (
Reporting, Admin Reporting and Email Reporting). The output will NOT contain a start and stop section or a summary,
each entry will also be initially marked with a date and time stamp. If use summary is selected for Admin or Email
reporting then the standard selection will be used. The reason this is done is due to the fact that processes will be
running in parallel.

7.3  Blackout Settings

4 Topics
Blackout Settings Overview

7.3.1  Blackout Settings Overview

This screen will enable you to set a blackout period during the daily synchronization. This is a
period in which the synchronization will stop and wait until the blackout period has expired
according to the specified settings. This would be a useful feature if you wish to stop all the
synchronization activities during a particular time when the Network Bandwidth is busy with other
activities (such as during working hours).

You may also choose to Suspend active scans when a Blackout Period starts. Enabling this
option will stop all the scheduled scans during the specified blackout.
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7.4  Scan Limitations

4 Topics
Maximum Duration of Scans
Initiate Scan on trigger File Change
Enhanced Package

Note:  Features listed on this page require the Enhanced Package.

7.4.1  Maximum Duration of Scans

Enabling the Set maximum duration to x minutes option allows you to specify a maximum
duration for each Job. This gives you the ability to limit the run time of a Job during initial, interval,
and scheduled scans. 

7.4.2  Initiate Scan on Trigger File Change

These settings ensure that the Target Folders always remain updated to their corresponding
Source by comparing dates indicated by individual Trigger Files. For example, if a Source Trigger
is found to be newer than a corresponding Target Trigger, a synchronization process will be
allowed to proceed for the selected Job(s). If the files date and time stamps match then the
synchronization will not be processed. Therefore, the run of the sync process is in essence,
determined by the trigger files.

Use Trigger Files:  This feature is used to activate or trigger synchronization based upon date
comparison between an individual Source Trigger File and a separate Target Trigger File. If the
Target Trigger File is older then the Source Trigger File, the entire Source Folder(s) will be
synchronized. 

Default File Name:  Displays the Default Global Trigger File Name: GLBCHG.000

Source Trigger File:  This field allows you to specify a Global Trigger File by entering it manually,
or by selecting it using the browse button located at the right side of the field. 

http://www.peersoftware.com/solutions/PeerSync_overview.asp
http://www.peersoftware.com/solutions/PeerSync_overview.asp
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Use Current Paths:  Automatically selects the current Trigger Files associated with the Source
and Target Folders.

Target Trigger File:  This field allows you to specify a Global Trigger File by entering it manually,
or by selecting it using the browse button located at the right side of the field.

Note:  During Enhanced Real-Time, Trigger Selections will be ignored. 

7.5  File Options

4 Topics
Mode Selection
Event Options

7.5.1  Mode Selection

Standard (update Target Files if Source is newer):  With this mode selection, PeerSync will
update files on the Target only if the Source is newer.

Always overwrite (Update Target Files if the Source is newer or older):  This feature
automatically overwrites any files in the Target Folder that have a different date\time stamp than
their corresponding Source File, even if the Target File is newer. This feature can be used to
restore folders to a previous state either for backup/restore operations or to reset files after
training operations.  

Bi-directional (both directions):  With this feature selected, PeerSync will merge the data of the
Source and the Target folders during Scan at Start, interval and scheduled scans. This feature
may be ignored during Real-Time and Enhanced Real-Time modes. The following will happen
when this feature is selected with the Replicate - Delete unmatched files/folders option enabled:  

If a File exists in both Source and Target Folders:  PeerSync will compare the Modified
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date/time of the files and update/overwrite the older file with the newer file. If the modified
date/time is identical PeerSync will not perform any action. 

If a File exists in only the Source or Target Folder:  PeerSync will compare the
Modified, Created and Accessed date/time of the file with the stored Last Run On date/time
of the Job. If any of the three file date/times are newer than the stored Last Run On
date/time the file will be added, otherwise the file will be deleted.  

If a Sub-Folder exists in only the Source or Target Folder:  The Source will be seen as
the primary folder and any sub-folders with content existing on the Source will be added to
the Target. If the folder is empty or exists on the Target, PeerSync will compare the
Modified, Created and Accessed date/time of the folder with the stored Last Run On
date/time of the Job. If any of the folder date/times are newer than the stored Last Run On
date/time the folder and all of its contents will be added, otherwise the folder will be
deleted.  

Notes: 

1. This feature is ignored during Real-time monitoring.

2. This feature may be ignored when using a TCP or FTP Source or Target.

3. This feature may be ignored when using Compression.

4. Non NTFS partitions may behave differently during this mode. You may notice files being retained for up to one day,
even if you delete a file from the Source or Target.

5. Modifications, such as renames and deletes, of Target Folders are subject to restoration in this mode.

4 Related Options
Global Bi-directional Options

Always create a super-set during bi-directional synchronization: This feature will alter the
way the Enable bi-directional synchronization mode option functions by always creating a
super-set of the data on the source and target. In this mode folders and files will always be added
and not deleted. 

Use enhanced bi-directional synchronization mode options:  This feature will alter the way
the Enable bi-directional synchronization mode option functions by using enhanced features to
track all file and folder adds, updates, deletions, renames and moves between scan cycles. In this
mode, PeerSync will use a hidden system trigger file within each sub-folder to store information
about the last scan cycle for that sub-folder. Using this trigger file, PeerSync can determine if a
Folder was added, deleted, renamed or moved since the last scan.

Notes:

1. Please refer to our White Papers page for step-by-step tutorials to achieve real-time or scheduled bi-directional
synchronization. 

2. When the "Always create a super-set during bi-directional synchronization" option is NOT selected (i.e. doing standard
or enhanced bi-directional synchronization) we recommend you add /YO- and /QYD:0 to your list of command line
arguments. These options will ensure that during standard or enhanced bi-directional synchronization, deleted files
from one side are not re-added by the other side. These arguments should NOT be used if there are more than two
machines involved in a bi-directional synchronization.  

http://www.peersoftware.com/support/ps_documents.asp?sp=tu
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7.5.2  Event Options

Add - synchronize new files to Target:  If the Source contains files not found within the Target
and this feature is selected, those files will be added to the Target Folder during synchronization.
This feature is selected by default. 

Update - synchronize existing files in Target:  If this feature is selected, Target Folder files
which are also found within the Source will be updated to match those Source files during
synchronization. This feature is selected by default. 

Replicate - Delete unmatched files:  If this feature is selected, any unmatched files found in
Target Folders will be deleted automatically. 

CAUTION:  Use this feature carefully. If not configured properly, needed files may be
permanently deleted. A deletion warning is NOT displayed by default: Profiler must be first set to
display this warning through the "Deletion Warning Message" check box.

4 Related Options
Deletion Options
Move Options

Once the Replicate - Delete unmatched files option is turned on the Deletion Options button will
be enabled for further configuration. Clicking on the Deletion Options button opens the "Additional
Options" dialog box which contains the following features:

Deletion Warning Message:  The upper section of this screen allows you to enable or disable a
Deletion Warning Message, as well as set the number of seconds for which a Message will be
displayed. (a message is NOT enabled by default and is not available during Enhanced
Real-Time). In addition, you can also choose to display a message requiring manual intervention
in order to activate deletions. 

Delete Excluded Files - Delete Excluded Files from the Target:  This feature will delete any
files on the Target that meet the criteria selected for the Exclude Files (using sub-strings) option
on the Exceptions screen if the Replicate - Delete unmatched files/folders option is selected from
the File Options screen. 

By clicking on the Move Options button you will be able to access the Move Deleted File Options
window which has the following settings available:

Move Deleted Files Options:  This section provides a field where the user can designate an
alternate folder to which unmatched files will be moved in order to avoid permanent deletion. This
folder path can be typed manually, or selected using the browse button provided to the right of the
field. If the designated folder exists, all unmatched files will be moved there, allowing you the
opportunity to recover files deleted from the Target. This field also supports File/Folder Path
Variables and when used, the current path will be displayed above the field. Beneath this field are
path options. 

We strongly recommend using a Deletion Folder that is located on the Target host computer.
Relocation to an alternate drive or host adds unnecessary processing and bandwidth overhead.
For this reason PeerSync uses the following Deletion Folder variables: 
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%TARGETROOT%: This variable resolves to the root directory of the target path. For
example if the target path is \\machine1\c$\Target\Docs, the deletions
path %TARGETROOT%\Deletions will resolve to \\machine1\c$
\Deletions. This variable is used by default. 

%TARGETPARENT%
:

This variable resolves to the parent directory of the target path. For
example if the target path is \\machine1\c$\Target\Docs, the deletions
path %TARGETPARENT%\Deletions will resolve to
\\machine1\c$\Target\Deletions.

 
Relative Paths:  This feature will move files deleted by PeerSync from the root folder to the root
of the selected folder. Files deleted from sub folders will be moved to corresponding sub folders
below the root selected deletion folder. This feature is intended (works best) for a Profile with a
single Job. 

Example: Source Folder: C:\MyDocs\Files\
Target Folder: D:\MyDocs\Files\ 

Move Path: C:\DeleteFolder\

If you delete: C:\MyDocs\Files\Sub\File.txt

PeerSync will move: D:\MyDocs\Files\Sub\File.txt

To: C:\DeleteFolder\Sub\File.txt

Preserve Paths: This feature will recreate the original path of the deleted file under the specified
path. Therefore, a file deleted by PeerSync will be moved into a folder that corresponds to the
file's original location: under the selected deletion folder. This feature is intended (works best) for
a Profile with Multiple Jobs.

Example: Source Folder: C:\MyDocs\Files\
Target Folder: D:\MyDocs\Files\ 

Move Path: C:\DeleteFolder\

If you delete: C:\MyDocs\Files\Sub\File.txt

PeerSync will move: D:\MyDocs\Files\Sub\File.txt

To: C:\DeleteFolder\
D_MyDocs\Files\Sub\File.txt 

Use Recycle Bin:  This feature allows you to specify the Windows Recycle Bin as a location for
unmatched files. This feature is not intended for use when file deletions made by PeerSync may
occur on a non-local machine or device. Only files deleted from a local drive can be moved to the
Recycle Bin, if this feature is used all network files will be permanently deleted. 

Delete unmatched Target Files older than x days:  This feature is intended for the cleanup of
files that were candidates for deletion but were selected to be moved to an unmatched folder. By
use of this feature, PeerSync can be used to temporarily store files setup for deletion and then
have the files deleted after a specified number of days. By default deletion folders are checked
every 6 hours. This interval can be modified by using the /LH:n argument where n is represented
in minutes. 
 

Notes: 

1. Only one copy of any file can exist in your designated Recovery folder.

2. To avoid filling up your hard drive unnecessarily, you should periodically check this folder and delete unwanted files or
use the  Delete unmatched Target Files older than x days option.

3. Only files deleted from a local drive can be moved to the Recycle Bin, if this feature is used, all network files will be
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permanently deleted.

4. When synchronizing to an FTP Target, the Move unmatched Target Files option is not available.

5. When using Compression, the Move unmatched Target Files option is not available.

6. The Deletion Warning Message option is not available during Enhanced Real-Time.

7. When using the Alternate Target Path Selections feature you cannot use variables that are specific to the Job (i.e.
%JobName%, %SourcePath%, etc.) for the Move unmatched Target Files option.

7.6  Open Files

4 Topics
Open Files Overview
Open/Locked Files
Related Global Settings

7.6.1  Open Files Overview

Include all open files:  Open files are those that are currently in use during synchronization. If
these files are set for synchronization and this feature is selected, PeerSync attempts to include
them within the synchronization process. 

Note:  If PeerSync is able to synchronize files which are in use by other applications, access to those applications may in
certain instances be temporarily lost during synchronization. 

Include partially open files:  Open files that are currently in use and open for read access only.
If these files are set for synchronization and this feature is selected, PeerSync attempts to include
them within the synchronization process.

Exclude all open files until closed:  This option will exclude all open files from the
synchronization until they have been completely closed.
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7.6.2  Open/Locked Files

By clicking on the EOFM link from this section you will be able to configure the EOFM for
processing local Open/Locked Files. Click here for the Global EOFM Options.

Note:  This features requires the Enhanced Package. Please visit http://www.peersoftware.com or contact Sales for
additional information.

7.6.3  Global Settings

By clicking on the Global Settings link you will be able to configure the Global Recovery/Offline
Options. Alternatively you can access this screen from the Global Settings window. The Global
Recovery/Offline Options screen is also available from the Options menu.

Retry Open and Inaccessible Files

Retry open files every x seconds:  Use this feature to specify, in seconds, how often PeerSync
will attempt to synchronize Source Files that are in use. If the "Include open files" option on the
File Options screen has not been checked and "Retry" is selected, PeerSync will continue
attempting to synchronize files that are opened by other applications. "Retry" will also work when
"Include open files" has been checked and a file is read-locked by another application. When the
"Retry" option is on, PeerSync will synchronize the open file within x seconds after the file has
been closed.

Set maximum number of retries to x:  This feature sets a limit indicating how many times to
attempt to process open files. The default, 0, indicates an indefinite number of retries.

Failed Connection Options

Retry failed connections every x minutes:  PeerSync monitors persistent Jobs (Real-Time,
scheduled, interval) for connectivity, and suspends the Job until a connection is resumed. This
allows PeerSync to ensure that synchronizations are only attempted when a connection exists.
This feature is set by default to a 1 minute interval and can be modified or disabled. 

Reconnect Options

Run a scan on reconnect:  This feature will initiate a full scan at Reconnect to process any
file/folder changes which may have occurred during the connection failure.

Store missed events and process on reconnect:  This feature pertains to any Job running in a
Real-Time mode. Having this option enabled will store Real-Time events during failed
connections and will process these events at Reconnect, eliminating the Source/Target Folder
scan.

http://www.peersoftware.com/solutions/PeerSync_overview.asp
http://www.peersoftware.com
http://www.peersoftware.com/contact/contact_sales.asp
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7.7  EOFM

4 Topics
EOFM Overview
EOFM Options
Related Global Settings

Note:  Features listed on this page require the Enhanced Package.

7.7.1  EOFM Overview

Enable Embedded Open File Manager (EOFM):  Through a partnership with open file
technology leader St. Bernard Software, PeerSync is now equipped to have total access to all
previously open and locked files. This feature has been integrated with PeerSync to allow
synchronization of critical data such as system files and databases. By default this feature is
enabled at the end of a manual synchronization and is run every 2 hours during persistent
(Real-Time or scheduled) modes. The interval can be modified from the Global Settings screen
via the Global Recovery Offline Options button. The interval can also be modified on the
command line by using the /GY:n argument where n is represented in minutes, with a minimum
interval of 30 minutes. For more features on configuring this option please view the Embedded
Open File Manager Arguments.

Notes: 

1. This option requires the Enhanced Package. Please visit http://www.peersoftware.com or contact Sales for additional
information.

2. This feature only works for local Source folders and will be ignored with an FTP Source.

3. This feature may be ignored when using an FTP Target in conjunction with File Compression.

4. This feature may be ignored when using Folder Compression.

http://www.peersoftware.com/solutions/PeerSync_overview.asp
http://www.peersoftware.com/solutions/PeerSync_overview.asp
http://www.peersoftware.com
http://www.peersoftware.com/contact/contact_sales.asp
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7.7.2  EOFM Options

Synchronize open/locked files via EOFM: Through the use of this feature PeerSync will enable
processing of the Open and Locked Files from the local machine, through the use of the
Embedded Open File Manager. Please note the EOFM will delay processing of files to the
specified EOFM interval. 

Synchronize ALL files via EOFM (including files that are not open/locked): Through the use
of this feature, you can force PeerSync to send all the file processing through the EOFM. Please
note the EOFM will delay processing of files to the specified EOFM interval. 

Notes: 

1. This option requires the Enhanced Package. Please visit http://www.peersoftware.com or contact Sales for additional
information.

2. This feature only works for local Source folders and will be ignored with an FTP Source.

3. This feature may be ignored when using an FTP Target in conjunction with File Compression.

4. This feature may be ignored when using Folder Compression.

7.7.3  EOFM Related Global Settings

By clicking on the Global Settings link you will be able to configure the Global EOFM Options.
Alternatively you can access this screen from the Global Settings window. The Global Settings
window is also available from the Options menu.

By default the Embedded Open File Manager (EOFM) is set to run on an interval of 120 minutes.
This interval may be changed by simply changing the interval time.

For more information on configuring the Embedded Open File Manager click on the following: 
Embedded Open File Manager Configuration and Behavior

Notes: 

1. This option requires the Enhanced Package. Please visit http://www.peersoftware.com or contact Sales for additional
information.

2. The minimum EOFM interval is 30 minutes.

3. This feature only works for local Source folders and will be ignored with an FTP Source.

4. This feature may be ignored when using an FTP Target in conjunction with File Compression.

5. This feature may be ignored when using Folder Compression.

http://www.peersoftware.com/solutions/PeerSync_overview.asp
http://www.peersoftware.com
http://www.peersoftware.com/contact/contact_sales.asp
http://www.peersoftware.com
http://www.peersoftware.com/solutions/PeerSync_overview.asp
http://www.peersoftware.com
http://www.peersoftware.com/contact/contact_sales.asp
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7.8  Performance

4 Topics
Performance Overview
Related Global Settings

7.8.1  Performance Overview

File Read/Write Buffer Size:  This feature allows you to change the read/write buffer sizes to
optimize performance/speed across various network environments or on the local machine. In
most cases this will increase performance dramatically but you will probably need to test this
feature in your environment to determine what advantages can be gained from altering this size.

The minimum value is 256 bytes.
The default value is 64 KB.
The maximum value that can be set using the track bar is 128 KB.
The maximum value that can be set using the up arrow or by manually typing in the spin edit
field is 128 KB

Buffer Size Upper Limit (* Multi Threading Option):  A higher upper limit of 1 MB is available with
the Multi Threading Option option. This value can be set using the up arrow or by manually typing
a set value into the spin edit field.

Note:  This option may be internally set to a maximum value when using an FTP Source or Target.

Throttle bandwidth - Use x percent of available bandwidth:  This feature will limit/slow down
the pulse of reads and writes performed by PeerSync, at the percentage specified, in order to
keep bandwidth available for other applications.

Enable intelligent network load balancing (when applicable):  The network load balancing
option will automatically set a read/write buffer size based on recommendation from NIC network
cards (Installed network cards must also support this feature).

http://www.peersoftware.com/solutions/PeerSync_overview.asp
http://www.peersoftware.com/solutions/PeerSync_overview.asp
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Set maximum number of copy threads to x (* Multi Threading Option):  This feature will limit
the number of copy threads to be spawned and used for the selected Job during folder scans.
This thread limit does not apply to enhanced Real-Time events. By using limits for scanning, it
helps the Profile to better process Enhanced Real-Time events during heavy scan operations.

Note:  Some features described on this page require the Multi Threading Option. Please visit
http://www.peersoftware.com or contact Sales for additional information.

7.8.2  Related Global Settings

By clicking on the Options/Commands link you will be able to configure the Global Application
Priority Options screen. Alternatively you can access this screen from the Global Settings
window as well as  the Options/Commands window. The Global Settings window is also available
from the Options menu. 

Please visit Global Performance Options for more information on this topic.

7.9  Byte Replicator

4 Topics
Byte Replicator Overview 
Block Size Selection
File Exclusion
Port Configuration

Note:  Features listed on this page require the Byte Replicator options.

7.9.1  Byte Replicator Overview

The Byte Replicator screen enables and configures Block/Byte level synchronization for the Job
selected. In order for Byte Replicator to be enabled, the following criteria must be present:

http://www.peersoftware.com/solutions/PeerSync_overview.asp
http://www.peersoftware.com/solutions/PeerSync_overview.asp
http://www.peersoftware.com
http://www.peersoftware.com/contact/contact_sales.asp
http://www.peersoftware.com/solutions/PeerSync_overview.asp
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The Source Path must point to a folder in a local drive letter
The Target Path cannot be an FTP Target
The PS Listener Service has been installed on the Target Machine
The PeerSync license has an available Remote Connection Licenses with Byte Replicator

To enable the Byte Replicator check the Use Block/Byte Level Synchronization box. This enables
or disables Block/Byte Level Synchronization. If this is disabled, PeerSync will use the standard
copy method to synchronize the file.

If the Byte Replicator fails to synchronize a file, i.e. On Failure, PeerSync will either: 

Log Messages & Use Recovery Intervals (if applicable)
Use Default File Copy for Synchronization 

Note: The Byte Replicator is an optional feature which may not be included in your package. Please visit
http://www.peersoftware.com or contact Sales for additional information. 

7.9.2  Byte Replicator Block Size Selection

This slider controls whether either Performance or Bandwidth Utilization is most important. Files
synchronized with the slider set Low will take longer to complete than with the slider set High. 

Note: The Byte Replicator is an optional feature which may not be included in your package. Please visit
http://www.peersoftware.com or contact Sales for additional information. 

7.9.3  Byte Replicator Exclusions

Clicking on the Exclusions button opens theByte Replicator File Exclusions window. Files that
match types in the exclusion string (types by file extension) or files that have a size lower than the
Minimum File Size will use the default file copy method instead of the Byte Replicator feature.
 
Excluded File Types:  Field containing a list of file types that will use the default file copy method
instead of the Byte Replicator. This feature can be configured by clicking the button to the right of
this field.

Minimum File Size:  Files with sizes lower than the value in this field will be copied using the
default file copy method instead of theByte Replicator.  

Note: The Byte Replicator is an optional feature which may not be included in your package. Please visit
http://www.peersoftware.com or contact Sales for additional information. 

7.9.4  Byte Replicator Port Configuration

Clicking on the Port Configuration button displays the Target TCP/Port Configuration window.
This window allows for a common TCP and/or Byte Replicator configuration option for both the
Source and Target paths (see the TCP Port Configuration tab for more information). 

Note: The TCP WAN Connector (TCP) and Byte Replicator are optional features which may not be included in your
package. Please visit http://www.peersoftware.com or contact Sales for additional information. 

http://www.peersoftware.com/solutions/PeerSync/features/byte_replicator.asp?sol=<PREFIX>&p_feat=br
http://www.peersoftware.com/solutions/PeerSync_overview.asp
http://www.peersoftware.com
http://www.peersoftware.com/contact/contact_sales.asp
http://www.peersoftware.com/solutions/PeerSync_overview.asp
http://www.peersoftware.com
http://www.peersoftware.com/contact/contact_sales.asp
http://www.peersoftware.com/solutions/PeerSync_overview.asp
http://www.peersoftware.com
http://www.peersoftware.com/contact/contact_sales.asp
http://www.peersoftware.com/solutions/PeerSync_overview.asp
http://www.peersoftware.com/solutions/PeerSync_overview.asp
http://www.peersoftware.com
http://www.peersoftware.com/contact/contact_sales.asp
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7.10  Revisioning

4 Topics
Revisioning Overview

7.10.1  Revisioning Overview

Revisioning - Keep backup files of overwritten Target Files:  Through the use of this feature,
you can use PeerSync to keep multiple versions of each file. This is a great feature for recovering
a previously saved version of a file. 

Number of backup files to keep:  Designates the number of revisions to keep for each file.
PeerSync revisions each file by adding a ".PSBAK1" extension to the existing Target File before
replacing it with the updated Source File.

Example:  "MyFile.txt" will become "MyFile.txt.PSBAK1"

If more than one backup is selected, each file will be renamed to the next revision when an
update occurs:

Example:  "MyFile.txt.PSBAK1" is renamed to ".MyFile.txt.PSBAK2" 

The newest revisions (backup files) will bear the lowest number while the oldest will have the
higher number:

Example:  Newer... PSBAK1, PSBAK2, PSBAK3, PSBAKn ...Older

Note:  If the "Delete Unmatched" option is selected and the Source File that has corresponding PSBAK files deleted, all
associated PSBAK files will also be deleted.

Keep files in Target Folder:  By default, revisions will be stored in the Target Folder where the
updated Target Files reside. 
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Keep files in Deletion Folder:  You also have the option of using the Deletion Folder for storing
revisions. This is quite useful when used in conjunction with the Delete unmatched Target Files
older than x days option, which is used for automatic cleanup of old revisions. 

Keep files in Alternate Folder:  You may specify the folder path where you would like the
revisions stored to. This option will give you the ability to specify a separate revision folder per
Job.

We strongly recommend using a Revisions Folder that is located on the Target host computer.
Relocation to an alternate drive or host adds unnecessary processing and bandwidth overhead.
For this reason PeerSync uses the following Revisions Folder variables: 

%TARGETROOT%: This variable resolves to the root directory of the target path. For
example if the target path is \\machine1\c$\Target\Docs, the revision
path %TARGETROOT%\Revisions will resolve to
\\machine1\c$\Revisions. This variable is used by default. 

%TARGETPARENT%
:

This variable resolves to the parent directory of the target path. For
example if the target path is \\machine1\c$\Target\Docs, the revisions
path %TARGETPARENT%\Revisions will resolve to
\\machine1\c$\Target\Revisions.

Notes:

1. This feature may be ignored when using an FTP Source.

2. This feature may be ignored when using Folder Compression.

7.11  Miscellaneous

4 Topics
Temp Files
Target File/Folder Alterations
Source File/Folder Alterations
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Additional Event Options

7.11.1  Temp Files

Use intermediate file during copy:  If this box is checked, a temporary file will be created in the
Target Folder: the contents of the Source File will then be copied into this temporary file. After a
successful copy, the Target File will be deleted and the temporary file will be renamed to bear the
Target File name. This feature ensures that the updated file will only replace the Target File if
copy is successful. If the copy process should be interrupted because of some outside factor
(network down, power outage, etc), the original Target file will still be preserved.

Note:  This feature may be ignored when using Folder Compression.

7.11.2  Target File/Folder Alterations

* Transfer NT security descriptions (ACLs):  If this feature is checked, PeerSync will transfer
over and match the security descriptions (ACLs) to the Target file upon synchronization, under
Windows NT platforms. When this option is enabled, the ACL Options and Global ACL Options
links will be enabled for further configuration. 

* Force target file attribute settings:  If this feature is selected, the File Attributes Options
dialog will be displayed. In this dialog, you may select to force any attribute on or off for the Target
files that are synchronized within the selected Job(s).

File Attribute Options Button:  This button opens the File Attribute Options dialog box. Once
this box has opened, it provides the user the selection to ignore, force on, or force off attribute
settings on Target files that are synchronized within the selected Job(s). 

* Notes: 

1. *Care must be exercised when using ACL options to synchronize files and folders between different domains. File
security transfers could make the target file unaccessible after transfer/update.

2. This feature may be ignored when using an FTP or TCP Source or Target.

3. This feature may be ignored when using Folder Compression.

4 Related Options
ACL Options
Global ACL Options

ACLs Options:  Once this button has been clicked, the ACLs Options screen will open. This
windows allows the user to select various levels of ACLs to transfer: Owner, Group, DACL, SACL.

This screen is activated by clicking on the Global Settings link located to the right of the ACL
Options button. This window has the following features:

Monitor ACL changes during real-time:  This global feature will enable Real-Time monitoring to
detect and process ACL changes. 
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Check for ACL changes during scans:  This global feature will validate and apply ACLs during
folder scans.

Note: Folder security checks occur during scans and folder create only.

7.11.3  Source File/Folder Alterations

Move Files - Delete source file after successful copy to target:  This feature will delete the
Source file after the file is copied to its corresponding Target folder. 

Note:  This feature should not be used with the Delete Unmatched Target Files option on the File Options screen
because conjunct use of the two options will greatly increase the chance of data loss.

Turn file archive attribute off after synchronization:  This feature resets the archive flag on
the Source and Target file after synchronization. The Windows file system automatically sets the
archive bit for every file that has changed; normally, this is used to indicate that a given file has
been modified since the last time its archive bit was set. Most tape back-up programs use this
flag to determine which files have changed since the last backup. This option will alter Source
files. PeerSync uses this feature to reduce the number of files that are checked on the Source
drive. 

Notes: 

1. Source files that are not being synchronized to Target folders will NOT have their archive flags reset. This process
only occurs after successful synchronization of a changed file.

2. This feature may be ignored when using an FTP Source.

Hint: To reset all Source file archive flags, use the "Always Overwrite Target Files" feature. This
configures all files for synchronization and consequently qualifies them for the reset of archive
flags. This feature only needs to be selected once to be applied to existing sync operations.

7.11.4  Additional Event Options

Include attribute change as synchronization criteria:  This feature allows for the
synchronization of files that have different attributes. If this feature has been selected, a Source
file whose attributes do not match the Target will still be included in the synchronization process.
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7.12  Additional Features

4 Topics
Additional Options
Validation Options
File Time Change Options

Note:  Features listed on this page require the Enhanced Package.

7.12.1  Additional Options

Enable file recovery:  This enables the file recovery option to continue a file copy which may
have been interrupted. If the Source and Target file name and date match but the Target file is
smaller, PeerSync will start the copy operation from the last byte that was sent the next time a
sync operation is executed on the folder.

Note:  Enable file recovery will be ignored with an FTP Source or FTP Target.

Replace in-use files upon reboot:  If this feature is selected, once a file is open and locked on
the Target Folder, it will be set to be replaced the next time the machine is rebooted. 

Note:  This option is only applicable for Jobs with a local Target Folder.

Reboot Options Button:  This button opens the Reboot Options dialog box. The default option
is "Do not reboot", you may also choose to "Display reboot dialog", or to "Automatically reboot".

Note:  Features described on this page require the Enhanced Package.

7.12.2  Validation Options

Perform binary comparison on all files (using CRC32):  Option to check all Source and Target
files for binary match during folder scan/compare cycle (using CRC32). This check ensures that
what is on the Target matches the Source at a binary level.

http://www.peersoftware.com/solutions/PeerSync_overview.asp
http://www.peersoftware.com/solutions/PeerSync_overview.asp
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Validate target file (using CRC32):  Option to validate file using CRC32 binary comparison after
successful file copy operation.

Note: Perform binary comparison on all files and Validate Target file (CRC32 features) will be ignored with an FTP
Source or FTP Target.

Retry Options Button:  This button opens the Validate File Copy Options dialog box.  Once
this box has opened, it allows for the selection of a retry value. If the file is not validated PeerSync
will retry the CRC32 validation x times.

Note:  Features described on this page require the Enhanced Package.

7.12.3  File Time Change Options

During comparison subtract/add x minute(s) from target:  Option to add or delete time from
Target file during folder comparison. This allows for synchronization of files between dissimilar
time zones or to allow for some time difference between Source and Target in case Target
machine date is slightly different from Source.

Note:  This feature may be ignored during Enhanced Real-Time.

Convert file times to GMT for comparison between time zones: Option to convert file times to
GMT for comparison between time zone differences of the Source and Target folders. This
feature is quite useful way of synchronizing data between machines located in different parts of
the world. 

After synchronization subtract/add x minute(s) from target:  This option can add or delete
time from Target file after synchronization. This allows for synchronization of files between
dissimilar time zones, or to allow for some time difference between Source and Target in case
Target machine date is slightly different from Source.

Note:  Features described on this page require the Enhanced Package.

7.13  Exceptions

http://www.peersoftware.com/solutions/PeerSync_overview.asp
http://www.peersoftware.com/solutions/PeerSync_overview.asp
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4 Topics
Exceptions Overview
Include Files
Exclude Files
Exclude Folders
Exclude File by Size
Exclude Files by Attributes
Exclude Selected File Dates

7.13.1  Exceptions Overview

The Exceptions screen is used after you have selected a Job or Multiple Jobs from the Profile Job
List and then created an associated Source and Target Folder on the Folder Selection screen.
Through Exception options, PeerSync allows you to selectively apply synchronization to files
contained within the Source Folder according to a wide range of explicit criteria. 

7.13.2  Include Files

Include Files:  Use this field to determine which file types will be included as part of
synchronization. File Type Inclusions are specified by a star command followed by the file
extension (i.e. *.doc). You can also specify specific file names and/or sub strings using the * wild
card. 

The default setting * includes all files. 

Multiple Inclusions can be used and are semicolon delimited (i.e. *.doc;*.txt;*.exe). 

Inclusions are not case sensitive, (i.e. "A" = "a"). 

Examples: *.doc
docs
copy*
file;data

;

- includes any file ending with the extension .doc
- includes any file that contains the string docs
- includes any file starting with the string copy
- includes any file containing the strings file or data 

Inclusions can be typed manually, or can be specified using either the Include File Types button
or drop-down list located to the right of the field.

 Include Files Button:  Opens an "Exceptions" dialog box into which file extensions may be
entered. The "include all files" command * will be shown by default. 

To add an extension, click "New." Next, type the desired extension into the field located at the
bottom of the dialog. Repeat this process for each desired file type. Inclusions can be deleted by
selecting them from the list and clicking the "Delete" key at the bottom of the dialog box. Once
you have finished, click the "OK" button. The dialog will close and all of the Inclusions you have
specified will automatically appear in the Include File Types field in the proper format (separated
by semi-colons). 

The drop-down list located to the right of this field will be dynamically populated with Inclusions as
they are set through the "Exceptions" dialog described above. They are also added to the list
when you exit the field after manually editing the Include File Types field. Inclusions can then be
specified by selecting them from this list. This provides a way to store and/or retrieve sets of
Inclusions for later use with other Jobs.
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7.13.3  Exclude Files

Exclude Files:  Through this field, files can be selectively excluded from synchronization using
sub strings or using wild cards.  Exclusions are set by specifying individual characters (i.e. ~), sets
of characters (i.e. copy*), or file extensions (i.e. *.tmp) which, if found within a file name, will
exclude that file from synchronization.

Multiple characters and strings can be used and are semicolon delimited (i.e. ~;*.tmp;copy*) 

These settings are not case sensitive, (i.e. "A" = "a")

Examples: ~
tmp
copy*
*.tmp
.tmp;.bak

;~ 

- excludes any file containing the character ~
- excludes any file that contains the string tmp
- excludes any file starting with the string copy
- excludes any file ending with the extension .tmp
- excludes any file bearing the strings .tmp, .bak or the character ~

Exclusions can be typed manually, or can be specified using either the Exclude Files Button or
drop-down list located to the right of the field.  

Exclude Files Button:  Opens a dialog box into which Exclusions may be entered.

To add an Exclusion click "New," then type the desired character or string into the field located at
the bottom of the dialog. Repeat this process for each Exclusion. Entries can be deleted by
selecting them from the list and clicking the "Delete" key at the bottom of the box. Once you have
finished, click the "OK" button. The box will close and all of the Exclusions you have specified will
automatically appear in the Exclude Files field. 

The drop-down list located to the right of this field will be dynamically populated with Exclusions
as they are set through the dialog box described above. They are also added to the list when you
exit the field after manually editing the Exclude Files field. Exclusions can then be specified by
selecting them from this list. This provides a way to store and/or retrieve sets of Exclusions for
later use with other Jobs. 

7.13.4  Exclude Folders

Exclude Folders:  Use this field to exclude folders from synchronization by specifying a folder
name in file path format, (i.e. \TEMP\ or C:\WINDOWS\). These examples will exclude any folder
path that contains these strings including sub-folders. 

If you wish to exclude only a specific or root folder such as "C:\WINDOWS\" but include
sub-folders you must include a "#" in front of the complete folder path (i.e. "#C:\WINDOWS\").
This example will exclude any files in this directory but include any files in its sub-folders. A
semicolon separates multiple folder exclusions. 

If you wish to exclude multiple folders that contain the same string do not include the "\" at the end
of the folder exclude (i.e. \Docs). 

These settings are not case sensitive, (i.e. "A" = "a")
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Examples \Docs
\Docs\
C:\Docs\
#C:\Docs\

- excludes files and sub-folder in folders starting with Docs (i.e. Docs,
Docs1, DocsA, etc.)

- excludes files and sub-folder in folders named Docs
- excludes files and sub-folder in the folder C:\Docs\
- excludes files in the folder C:\Docs\ but includes files in its

sub-folders

Exclusions can be typed manually, or can be specified using either the Exclude Folders Button or
drop-down list located to the right of the field. 

Exclude Folders Button:  Opens a dialog box into which Folder Exclusions may be entered. 

To add an Exclusion, click "New," then type the desired folder name into the field located at the
bottom of the dialog. Repeat this process for each Exclusion. Entries can be deleted by selecting
them from the list and clicking the "Delete" key at the bottom of the box. Once you have finished,
click the "OK" button. The box will close and all of the Exclusions you have specified will
automatically appear in the Exclude Folders field. The drop-down list located to the right of this
field will be dynamically populated with Exclusions as they are added. Exclusions can then be
specified by selecting them from this list. This provides a way to store and/or retrieve sets of
Exclusions for later use with other Jobs.

Exclude empty source folders:  This feature will exclude and will not sync empty Source
Folders to the Target.

7.13.5  Exclude Files by Size

Exclude File Sizes:  Use the Greater Than or Less Than fields to exclude files based upon their
size in bytes. Zero, by default, includes all files.

7.13.6  Exclude Files by Attributes

Current Attributes:  Using the characters "NASHR," this field displays which file attributes
(Normal, Archive, System, Hidden, and Read-Only) have been selected as criteria for
synchronization. All attributes are selected by default. Clicking the button to the right of this field
opens a window from which file attributes may be included or excluded.

7.13.7  Exclude Selected File Dates

Selected File Dates:  Use this field to specify files set for synchronization according to their date
stamp. The default setting includes all file dates. Clicking the button to the right of this field opens
a "Select File Dates" screen. 

This screen allows you to include all files, include files more than x days old, include files bearing
the current and past x day's date, or specify a range of the dates. The Set Today's Date button
automatically updates the existing range to reflect the current day.
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7.14  Reporting

4 Topics
Reporting Overview
Report File Content
Log File Size/Content
SNMP Options

7.14.1  Reporting Overview

PeerSync automatically generates Log Files providing a detailed history of all synchronization
events. This screen is used to view Log Files and set their reporting characteristics. 

Use Log File: This feature enables or disables Log file generation. The default file, PeerSync
.Log, is located in the path in which PeerSync has been installed. This field also supports
File/Folder Path Variables and when used the current path will be displayed above the field.

Overwrite Existing Log File:  Use this feature to report only the most recent PeerSync activity in
the Log File. If this feature is not selected, all PeerSync processes will be reported in succession. 

View Log File:  This button allows you to view Log reports by opening the file in a text editor. 

Clear Log File:  This button allows you to clear Log reports. 

7.14.2  Report File Content

Using the check boxes provided in this section of the Reporting screen, you can specify what will
be reported in the Log File. The Default setting is to include all items except Folder Names.

Added Files: This feature adds an entry for any file that has been added to the Target.
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File Date: Includes date associated with each file contained in the Log.

File Size: Includes size of each file contained in the Log.

Updated
Files:

This feature adds an entry for any file that has been updated in the Target.

File Time: Includes time associated with each file contained in the Log.

Transfer
Time:

Includes time it takes to transfer the file in milliseconds.

Summary: Appends a summary of activity to the end of the report.

Folder
Names:

Indicates the names of synchronized folders.

Folder
Creation: 

This feature creates an entry for any folders that did not exist in the Target and
had to be created during the synchronization process.

Messages This feature logs any messages or application errors found during
synchronization. 

Exceptions: This feature logs any file/folder exclusion found during synchronization. 

Note:  Application errors are additionally written to a file called "PS Error.log," regardless of whether or not that option
has been selected.

7.14.3  Log File Size/Content

Set the maximum log file size to x bytes:  By entering an amount into this field you can limit the
size of Log Files created by PeerSync. When this limit is reached, the next reporting session will
first rename the existing file to FILENAME.BAK1.Log and then create a new, blank Log File to
which subsequent data will be added. Two backups FILENAME.BAK1.Log and
FILENAME.BAK2.Log will be kept for each unique Log file. 

Unicode content:  This option will enable the reporting of Unicode content.

7.14.4  SNMP Options

Use SNMP reporting (errors only):  Use Simple Network Management Protocol error reporting.

SNMP Options Button:  This button opens the SNMP Options dialog box. Once this box has
opened, it allows you to select the Destination IP and Trap Prefix to be used for SNMP reporting.
Please refer to your SNMP management software for more details.
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7.15  Admin Reporting

4 Topics
Admin Reporting Overview
Report File Content
Report File Name
Report File Path
Admin Report Cycle Options
Advanced Settings

7.15.1  Admin Reporting Overview

This screen allows you to create a unique report for administration purposes. Admin Reports
generated during sync operations can be saved to a specific administrative folder (in a local or
network path). Admin Reports are made uniquely identifiable through a choice of naming
conventions, (i.e. Computer Name or User Name with date\time stamps). 

Create administrative report files:  This feature enables or disables the Administrative
Reporting feature.

Note:  Admin reporting files do not display Unicode characters.

7.15.2  Report File Content

Summary/Messages only:  Appends a summary of activity to the end of the report. This option
will also log messages.

Standard report file content:  This feature directs Report content to follow those conventions
also utilized in PeerSync Log Files. 

Messages only:  Only reports messages and application errors. 
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Note:  When in enhanced Real-Time or when using Multiple Job Threads standard reporting will be used if summary is
selected. 

7.15.3  Report File Name

Report file name:  Allows you to choose between a default-named (PC and date\time) or
User-named Administrative Report. 

7.15.4  Report File Path

Report file path:  This field displays the location of Admin Report files. This field also supports
File/Folder Path Variables and when used the current path will be displayed above the field.

7.15.5  Admin Report Cycle Options

Create a report for every event:  This option allows for a report to be generated on every event
(Add/Update/Delete/Message).

Create a report on an interval:  This option allows for a report to be generated at a specific
interval. You may specify the interval from the input field to the right of this option.

Create a report once a day:  This option allows for a report to be generated once a day. You
may specify the time of the day from the input field to the right of this option.

Create a report once a week:  This option allows for a report to be generated once a week. You
may specify the day of the week from the drop down list to the right of this option.

Only use Advanced Settings:  This option allows for a report to be generated based on the
configuration of the Advanced Settings only. 

7.15.6  Advanced Settings

At the start of this Profile:  This option allows for a report to be created at the start of the Profile.

At the stop of this Profile:  This option allows for a report to be created at the stop of the Profile.

For each individual error message as it occurs:  This option allows for a report to be created
for each error

After each scan (log all non-scan events on the cycle specified):  This option allows for a
report to be created once a day. You may specify the time of the day from the input field to the
right of this option.

After each scan/cycle even if no events occurred:  This option allows for a report to be
created after each scan even when no events occurred.
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7.16  E-mail Reporting

4 Topics
E-Mail Reporting Overview
Report File Content
Report File Name
Email Configuration
Email Report Cycle Options

7.16.1  E-Mail Reporting Overview

This screen allows you to create a unique report for administration purposes. E-mail Reports
generated during sync operations can be sent to an administrator, shared mailbox or a specified
user. E-mail notification of synchronization activity can be sent upon completion of entire Profile or
during persistent synchronization operations. E-mail Reports are made uniquely identifiable
through a choice of naming conventions, (i.e. Computer Name or User Name with date\time
stamps). 

Create administrative E-mail messages:  This feature enables or disables the E-mail Reporting
feature.

Note:  E-mail reporting messages do not display Unicode characters.

7.16.2  Report File Content

Summary/Messages only:  Appends a summary of activity to the end of the report. This option
will also log messages.

Standard report file content:  This feature directs Report content to follow those conventions
also utilized in PeerSync Log Files. 

Messages only:  Only reports messages and application errors.
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Note:  When in enhanced Real-Time or when using Multiple Job Threads standard reporting will be used if summary is
selected. 

7.16.3  Report File Name

Report file name:  Allows you to choose between a default-named (PC and date\time) or
User-named E-mail Report.

7.16.4  E-mail Configuration

Attach log files:  Allows you to attach the reporting section log file to e-mails generated by this
application.

Delete after successful send:  Deletes the log file after a successful e-mail attached send.

E-mail Configuration Button:  This button opens the Email Configuration dialog box:  Once
this box has opened, it allows you to select the SMTP Host, User ID, Port, who to send to, and
who to send Carbon Copies to and what e-mail address to send from.

7.16.5  E-mail Report Cycle Options

Send an e-mail for every event:  This option allows for an E-mail to be sent on every event
(Add/Update/Delete/Message)

Send an e-mail on an interval:  This option allows for an E-mail to be sent at a specific interval.
You may specify the interval from the input field to the right of this option.

Send an e-mail once a day:  This option allows for an E-mail to be sent once a day. You may
specify the time of the day from the input field to the right of this option.

Send an e-mail once a week:  This option allows for an E-mail to be sent once a week. You may
specify the day of the week from the drop down list to the right of this option.

Only use Advanced Settings:  This option allows for an E-mail to be sent based on the
configuration of the Advanced Settings only. 

7.16.6  Advanced Settings

Send E-mail Reports

At the start of this Profile: This option allows for an E-mail to be sent on every event
(Add/Update/Delete/Message).

At the stop of this Profile:  This option allows for an E-mail to be sent at a specific interval. You
may specify the interval from the input field to the right of this option.

For each individual error message as it occurs:  This option allows for an E-mail to be sent at
a specific interval. You may specify the interval from the input field to the right of this option.

After each scan (send all non-scan events on the cycle specified):  This option allows for an
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E-mail to be sent once a day. You may specify the time of the day from the input field to the right
of this option.

After each scan/cycle even if no events occurred:  This option allows for an E-mail to be sent
after each scan even when no events occurred.

E-mail Report Content

Send content in the body of the E-mail: This option will write the content for the email report
into the body of the e-mail.

Send content as an attachment to the E-mail: This option will generate a file with the content of
the e-mail report and attach the file to the e-mail.

Place content in a file and send a link in the E-mail: This option will generate a file with the
content of the e-mail report and a link to the file will be sent within the body of the e-mail.

7.17  Compression

4 Topics
Compression Overview
Compression Options
Compress/Expand
Compression File Extension
Compression Speed
Password-Encryption

7.17.1  Compression Overview

While compressing your choice of folders, the Compression utility also employs a unique method
to minimize file damage. While creating Target directory structures to match those found in the
Source, the folder compression option creates a single file for every folder contained within the
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Target Folder set. This minimizes the amount of data added to each compressed file. If a single
file were used for the entire directory structure were to become corrupt, all files might be lost. 
PeerSync's "one file per folder" scenario ensures that if damage occurs, it is limited to individual
folders only. We also offer file compression, which will compress the Source Files to the
corresponding Target Files down to the file level which adds even more flexibility.

During folder compression, all selected Source Files are synchronized to the compressed Target
Folder file bearing the name of the active folder plus the user selected extension (default
extension is "ZIP"). 

During file compression, all selected Source Files are synchronized to the compressed Target
Folder file bearing the name of the active file plus the user selected extension (default extension
is "ZIP"). 

Compressed folder files can be expanded using most PKZip compatible extraction utilities. In
addition, passwords can be specified and entered on this screen to protect against unauthorized
access to compressed files.

7.17.2  Compression Options

Use folder compression:  This check box enables or disables the folder compression feature
which will compress files in each sub-folder to a single file per sub-folder. 

Notes:

1. Folder Compression may be ignored when using an FTP Source or FTP Target.

2. Bi-directional, Transfer NT security descriptions (ACLs), Move unmatched target files, Force target file attribute
settings, Use intermediate file during copy and Revisioning, as well as, other non applicable features may be ignored
when using Folder Compression. 

Use file compression:  This check box enables or disables the file compression feature will
compress file by file. 

Notes:

1. File Compression may be ignored when using an FTP Source.

2. Bi-directional, Transfer NT security descriptions (ACLs) and Move unmatched Target Files, as well as, other non
applicable features may be ignored when using Folder Compression.

7.17.3  Compress/Expand

Compress target:  Selecting this feature enables compression of the Target Folder. 

Expand source: This feature extracts (expands) the Source folder. Use this feature to extract
files from Source Folders that have already undergone compression.

Note:  A compressed Source Folder can not be synchronized to a compressed Target Folder.

7.17.4  Compression File Extension

Compressed File Extension:  The extension entered into this field will be applied to the
compressed folder file name. For example, if "rar" is entered for a folder named "Samples," the
compressed folder file name will be "Samples.rar." 
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Note:  it is NOT necessary to add a period (" . ") before this extension name. The default extension is "ZIP," which
associates the file with a Zip application (i.e. WinZip). 

7.17.5  Compression Speed

Compression Speed:  Allows for normal compression, Maximum compression or maximum
speed.

7.17.6  Password-Encryption

Password - Encryption:  The password entered into this field will be used as a key to encrypt
the compressed files. Without this key the original file CAN NOT be extracted from the
compressed files. Do Not Lose This Password. Without it you will not have access to your
encrypted files, nor will Peer Software be able to recover them. 

Change Password:  Selecting this button will display the Password Change dialog box. This
allows you to change your existing password for the selected Job. This box requires you to enter
your old password in addition to whichever new one you wish to begin using. This dialog box is
also used to create a password if you do not currently have one. The password will be encrypted
and saved for the selected Job.  

Note: You may only change the password for a single Job at a time. The old password must be checked against the
stored password for this feature to be changed. 

7.18  Pre/Post Process Options

4 Topics
Pre/Post Process Overview
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7.18.1  Pre/Post Process Overview

This screen allows the user to choose external applications / scripts to be run before and after the
processing of a given Job. 

Select Application/Script to Run Before:  Use this field to specify (by file path) which
application you would like to run before processing a Profile. File paths can be manually entered,
or the open folder icon can be used to locate files. 

Select Application/Script to Run After:  Use this field to specify (by file path) which application
you would like to run after processing a Profile. File paths can be manually entered, or the open
folder icon can be used to locate files.

Wait for application to end before continuing:  Check this feature if you want PeerSync to wait
for the applications specified in the "Before" and "After" fields to close before processing
additional tasks. 

Use maximum wait time of x seconds:  Selecting this feature sets a limit (in seconds) for how
long PeerSync will wait for the applications specified in the "Run Before" and "Run After" fields to
close. In order to activate this function, the "Wait for Application to Terminate" function must be
checked. The default, when this feature is not checked, is to wait indefinitely.

7.19  Global Settings

4 Topics
Global Settings Overview
Global Recovery/Offline Options
Global Performance Options
Global ACL Options
Global Bi-directional Options
Global EOFM Options
Current Command Line Argument Selection
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7.19.1  Global Settings Overview

Global Settings are global to the current Profile. These settings and options pertain to all of the
Jobs in the current Profile and are used to define, configure and execute the launch of Profiles via
the PeerSync engine. Arguments to be sent to PeerSync can be selected and setup from the
Options/Commands screen. 

Profiles can then be launched from the Profiler through the following scenarios: 

By using the Launch Profile Menu Item in the Run Menu

By using the Launch Current Profile button on the Tool Buttons Toolbar
By using the Launch Current Profile button on the Run/View Current Profile Activity screen

Profiles can also be setup/run externally without the Profiler from the Startup/Service screen in
the following ways:

Setup/run from a Shortcut on the Desktop
Setup/run from the Startup Folder
Setup/run at boot from the Registry
Setup/run as a NT Service

Notes:

1. Individual Jobs can be synchronized using the 'Synchronize Selected Jobs' feature, found in the Profile Job List Popup
Menu. 

2. Another way of running PeerSync is by using the Quick-Sync Folder feature by right-clicking on a folder from MS
Windows Explorer.

7.19.2  Performance Options

This screen can be access from the Global Settings window as well as the Options/Commands
window. This screen is  also available from the Options menu.

Application Priority Section

Set Application Priority:  If this feature is selected, an icon will appear on the system tray when
PeerSync is loaded. When you right/click on this icon a menu will appear. Through this menu the
Profiler can be shown, the About PeerSync screen can be accessed, and PeerSync can be
terminated. 

Once this box has opened, it gives you the ability to Set the Application Priority allowing PeerSync
to run at a higher or lower priority then other applications. 

Performance Options

This section allows for Multiple Thread Selection features (Multi Threading Option). You can turn
on and specify how many Job and copy threads to allow PeerSync to use. 

Use Multiple Job Threads:  Job threads allow for Multiple Jobs to run in parallel processes.

Use Multiple Copy Threads:  Copy threads allow for multiple files to be copied in parallel
processes (i.e. Simultaneous Distribution - Synchronizing from one server to multiple servers
simultaneously in a Web Farm type environment).

http://www.peersoftware.com/solutions/PeerSync_overview.asp
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Notes: 

1. Some features described on this page require the Multi Threading Option. Please visit http://www.peersoftware.com or
contact Sales for additional information.

2. Using Multiple Job Threads will produce a different file output format for all modes of reporting and message logging (
Reporting, Admin Reporting and E-mail Reporting). The output will NOT contain a start and stop section or a
summary, each entry will also be initially marked with a date and time stamp. If use summary is selected for Admin or
Email reporting then the standard selection will be used. The reason this is done is due to the fact that processes will
be running in parallel.

3. We have exhaustively tested PeerSync operations using 50 Job threads and 10 Copy threads. Setting your threads
over this limit may lead to potential operational issues.  We strongly discourage the use of more then 50 threads,
however, you do have the option to exceed this limit by placing a greater than symbol ">" before your desired thread
value (maximum allowed is 200).  We  recommend you test your setting to ensure PeerSync continues to operate
acceptably in your environment. 

4. Some features described on this page require the Multi Threading Option.

5. The Include open files (if possible) option should be used if you are using the Performance Options: Multiple Job
Threads and Multiple Copy Threads. 

6. When setting the Application Priority to High, PeerSync will use more then average CPU, you may want to use the Set
Processor Affinity argument in this scenario.

7.19.3  Command Line Arguments Options

This screen can be access from the Global Settings window as well as the Options/Commands
window. This screen is also available from the Options menu.

From the Options/Commands window, selecting the button to the right of the Command Line
Argument filed opens the Current Command Line Argument Selection dialog box.  Once this
box has opened, you can modify, add or delete arguments to be used when launching PeerSync
through any of the modes described in the Startup Options screen or via the Run/View Current
Profile Activity screen. 

Current Arguments:  This section displays the current arguments selected for the Profile and will
also allows for the selection and modification of additional Command Line Arguments by
double-clicking this field or selecting the Current Arguments Button to the right of the field.

http://www.peersoftware.com/solutions/PeerSync_overview.asp
http://www.peersoftware.com
http://www.peersoftware.com/contact/contact_sales.asp
http://www.peersoftware.com/solutions/PeerSync_overview.asp
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7.20  Options/Commands

4 Topics
Options Commands Overview
Set Access Password
Display Options
Reporting Options
Performance Options
Command Line Arguments

7.20.1  Options/Commands

Options located on this screen can be accessed from the  Options/Commands window, the
Global Settings window, as well as the Options menu respectively.

Show tray icon:  If this feature is selected, an icon will appear on the system tray when the
PeerSync Engine is loaded. When you right/click on this icon a menu will appear. Through this
menu the Profiler can be shown, the About PeerSync screen can be accessed, and the PeerSync
Engine can be terminated. 

Enable display options:  If this feature is selected, the Display Options Button becomes
available, in which you are able to select how and when to display status of Profile activity.

Enable Reporting Options: If this feature is selected, the Reporting Options Button becomes
available, in which you are able to select between the Global Reporting Options.

7.20.2  Set Access Password

Set Access Password Button: This option can be found in the Options/Commands window. Use
this button to set or change a tray icon access password via the Password Change dialog box.
This allows you to set/reset a password and once a password has been set, only authorized users
will be able to terminate PeerSync.
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7.20.3  Display Options

Display status in Profiler:  This feature will have PeerSync open the Profiler, if it is not already
open, and send status messages to be displayed on the Run/View Current Profile Activity screen. 

Display status in PeerSync:  This feature will show the PeerSync Status Display dialog box
during synchronization so the user can see activity, status and other information while PeerSync
is running. 

Display Job Stats:  This feature will have PeerSync show the Job stats in the PeerSync Status
Display Window.

Display Copy Thread Progress* (Multi Threading Option):  This feature will have PeerSync
show the Copy Thread Progress in the PeerSync Status Display.

Display status in PeerSync upon completion:  This feature will have PeerSync show its
PeerSync Status Display dialog box at the end of synchronization (only in non-persistent modes)
so the user can see activity, status and other information upon completion. 

Send status information to PS Observer Utility:  This will send statistical information about the
current Profile to the LAN Observer Utility (PSObserver), if it is installed/available. This utility
allows for the ability to monitor PeerSync activity across the LAN for the centralized viewing of all
PeerSync activity on the network.

* Note:  Some features described on this page require the Multi Threading Option. Please visit
http://www.peersoftware.com or contact Sales for additional information.

7.20.4  Reporting Options

Message by Profile:  If this feature is selected messages for the full profile will be logged into a
text file.

Message by Job:  If this feature is selected messages for the individual Jobs will be logged into
separate text files. When this option is enabled, Job messages may be retrieved by right clicking
on the specific Job.

http://www.peersoftware.com/solutions/PeerSync_overview.asp
http://www.peersoftware.com/solutions/PeerSync_overview.asp
http://www.peersoftware.com
http://www.peersoftware.com/contact/contact_sales.asp
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7.21  Startup/Services

4 Topics
Startup/Services Overview

7.21.1  Startup/Services Overview

This screen allows the user to specify whether or not PeerSync will be run upon startup of the
active PC, while also defining its interaction with the network (if applicable). This screen provides
shortcuts for installing PeerSync as a service, adding it to the Windows StartUp list, or to the
Windows registry for automatic loading upon startup. 

Disable all Startup Options:  Check this feature to prevent PeerSync from automatically loading
at Windows startup/logon.

Create Shortcut on Desktop:  This button will place the current Profile into a shortcut on your
desktop (See "Scan at Start of Profile List," Options/Command). A Profile Shortcut will need to be
created through this feature in order to use PeerSync's Command Line Mode.

Add to Windows StartUp:  Check this feature if you want PeerSync to run automatically when a
user logs on to the PC.

Show StartUp Folder:  This button opens the Windows StartUp folder, showing links to files and
programs that open automatically upon user logon. This button is only accessible when "Add to
Windows Startup Folder" is checked.

Add to Windows registry:  Check this feature if you want PeerSync to run automatically when
Windows boots through specification in the Windows registry.

Run RegEdit:  This button opens the Windows Registry Editor. This button is only accessible
when "Add to Windows registry to run at boot" is checked.  

Install as an NT Service:  Check this feature if you want PeerSync to run automatically as a
service under Windows NT. Click here for a Tutorial on how to install PeerSync to run as an NT

http://www.peersoftware.com/support/kb/ps/run_as_a_service.pdf
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Service.

To configure and run the service you must go to "Services" located in the "Control Panel" and
select "PeerSync Professional Series Software." By default the service is installed with the "Local
System account" selected for the service "Log on as:" option. 

Caution: If any of your Source or Target Folder Selections are not located on the local machine, then you will have to
configure the service to "Log on as:" an alternate (Domain Admin) account on your domain so that the service has the
rights to access the remote machines and/or devices.  If you do not do this the service may not run properly.

Notes: 
 
1. If PeerSync is running as a Service it is advised to use UNC paths or PeerSync's Dynamic Network Drive Mapping
and Unmapping feature instead of using mapped drives do to the fact that mapped drives are not understood when a
user is not logged on.

2. You can add the argument /LSE (Log Service Events to NT Application Log) to the following entry in the registry
(HKEY_LOCAL_MACHINE\Software\PeerSoftware\PeerSync\Service\Parameters). This will have PeerSync log all
changes to be reported to application log in addition to the normal logging of the start, stop, pause and continue of the
service.

3. If PeerSync is running in Real-Time mode as a service, subsequent real-time Profiles will interfere with service
operation and should not be employed. Both Scheduled Operations and Manual (non-persistent) operations should
perform without interference to a service installation of PeerSync.

Details:  This button is used to view the details of the currently installed PeerSync service. 

Remove:  This button is used to remove the currently installed PeerSync service.

Create SNC extension association for Profiler:  Checking this feature causes any file with the
extension .SNC to be associated with PeerSync: PeerSync Profiles bear this extension by default.
Once this feature has been selected, double/clicking on any SNC file will open Profiler and load
that particular file. 

Add Quick-Sync Folder option to Explorer menu:  Checking this feature adds or removes the
Quick-Sync Folder selection from Windows Explorer. This feature is a quick and easy way to
synchronize folder(s) on the fly to backup location(s) with the option to modify your Job settings at
a later time.

PeerSync Application Path:  This field is used to specify the location of the PeerSync
executable file. You can use the open folder icon to browse drives in order to locate this
executable file.
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7.22  Run/View Current Profile

4 Topics
Run/View Current Profile Activity Overview

7.22.1  Run/View Current Profile Overview

PeerSync can be run as an Application or as an NT Service, if available and installed from the
Startup/Service screen.

This screen is used to Launch the current Profile and to view Current Profile Activity. If the Display
Status in Profiler option is turned on from the Options/Commands screen this screen will be
shown upon execution of a Profile and will dynamically show the status of synchronization of the
current Profile as the process occurs. This screen will also be shown upon using the Synchronize
Selected Jobs feature, found in the Profile Job List Popup Menu to display the Current Activity of
the Jobs sent to PeerSync as a temporary Profile.

Features

Profile: Displays the name of the Profile actively being processed. This label may not
match the name of the Profile currently being configured through Profiler.

Job: This indicator will dynamically display the name of whichever Job is presently
being processed for the Active Profile.

Mode: This indicator will dynamically display the name of whichever Job is presently
being processed for the Active Profile.

Launch Current
Profile/Terminate
Active Profile:

This button allows you to launch the current Profile. Once a Profile has been
launched, its processing may also be terminated through this button (the
label will change to read "Terminate Active Profile"). This button offers one of
three ways to initiate an Automatic Operation. 
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View Active
Profile:

This button allows you to connect to and view the Active Profile. 

Run as a service: If PeerSync is installed as a Service you have the option of running it as an
Application or as a Service from this screen.

Start/View
Service:

This button allows you to start the current Profile as a Service or view the
Active Profile.

Stop Service: This button allows you to stop the current Profile as a Service.  

Pause Service: This button allows you to pause the current Profile as a Service. 

Resume Service: This button allows you to resume the current Profile as a Service.  

Source: Displays a file path for the Source Folder presently being synchronized.

Target: Displays a file path for the Target Folder presently being synchronized from
the Source indicated above.   

Folders: This indicator provides a count of all unsynchronized folders contained within
the Source, and will decrease as each folder is synchronized. An additional
"thermometer" indicator will also track the progress of folder synchronization.

Files: This indicator displays the total number of files contained within the Source
while also providing a count of synchronized files. In addition, a
"thermometer" indicator will show file synchronization progress by increasing
according to the size of the current folder, with 100% representing the
cumulative size of files contained within the Source Job set.

File: Indicates the name of the file currently being synchronized.

Large File or
Compression
Status:

This caption will be displayed to the right of the file name that is currently
synchronized for large files and during compression. The caption will show
the size of the file that has been copied to the Target and/or compression
status.

Skip File: This button will appear once the active Profile has been launched. This
feature allows you to skip synchronization of the file currently displayed in the
indicator described below. Skip Files enables you to avoid delays caused by
large files on slow network or dial-up connections.

Size: Indicates the size (in bytes) of the file currently being synchronized. A related
"thermometer" indicator tracks the progress of synchronization for that file.

Checked: This indicator displays the total number of files contained in the selected
Source Folders. 

Excluded: Indicates the number of files that were excluded from synchronization (See 
Exceptions). 

Messages: Indicates the number of error messages generated during Profile
processing. 

Updated: Indicates the number of Target Files that were updated during
synchronization of Profile Jobs. 
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Added: Indicates the number of new files added to Target Folders during
synchronization of Profile Jobs. 

Deleted: Indicates the number of files deleted (or moved) during synchronization of
Profile Jobs. 

Job Status: This indicator displays the status of the active Job. The indicator may display
one of the following: Blackout, Source/Target disconnected (Job name) or
normal.

EOFM Status: This indicator displays the status of the EOFM (Embedded Open File
Manager). The indicator may display one of the following: n files (for number
of locked files to be processed), no files, n/a not enabled, n/a not registered.

Event Status: This indicator display the status of the events pertaining to Job/Copy thread
information or Job automation (such as next scheduled interval, daily timer
info etc.).

Target Space: Indicates the Target Folder space remaining during synchronization of Profile
Jobs. 

Elapsed Time: Indicates the amount of time that has elapsed during the current Profile
activity.

8.  Command Line Arguments

PeerSync's Command Line Mode offers users the ability to configure a truly "hands-off"
installation, where operation and distribution occurs from within an easily manageable,
administrative environment. This mode allows Profiles to be executed from logon scripts, system
batch (BAT) or command (CMD) files, detailed shortcuts, and shell commands -- while also
providing full access to the Profiler features through command line arguments.

Profiles will need to be created through the Profiler first in order to be further modified through the
arguments described in this topic (See Profiler Overview and related Help Topics).  

Command Line Arguments are entered into a Profile shortcut, created during build through the
"Add to Desktop" button found on Profiler's Startup/Service screen.

Notes:  

1. For the command line arguments described in this topic, note that attention is paid to punctuation, to the order in
which arguments are entered, and that appropriate spaces are used to separate these arguments. Follow the format
outlined in the examples provided.

2. Profile .SNC file names are the only command line variables associated with operation of the Profiler. All other
arguments described in this topic are used to configure operation of the PeerSync and its execution of Profiles.   

Profiler Command Line Arguments

As noted above, Profile (.SNC) file names are the only variables associated with operation of 
Profiler. To change an .SNC file name through the command line: 
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- Right click the Profile shortcut you created during build (see StartUp/Service, "Add to Desktop"
button). 

- Select the "Properties" item from the pop-up menu. 
- Select the "Shortcut" tab. As shown in the following sample, the "Target" field will contain a

command line for the Profile, where "Profile One" represents a sample Profile name: 
"C:\Program Files\PeerSync\PeerSync.exe" "C:\Program Files\PeerSync\Profile One.SNC"
/USEPROFILEARG

- Manually change the Profile Name to reflect that of the new .SNC file
- Click the "OK" button

PeerSync Command Line Arguments

The following arguments are appended to the end of the command line followed by a space and
forward slash (i.e. /A). A space and forward slash are also used to separate each additional
argument (i.e. /A /M). 

4Categories:
Configuration Arguments
Performance Arguments
Reporting and Display Arguments
Automation Arguments
Synchronization Arguments
Real-time Arguments
Bi-directional Arguments
FTP Arguments
Embedded Open File Manager (EOFM) Arguments

Notes:

1. Any arguments containing spaces must be enclosed by quotes. 

2. Some features described on this page may require the Enhanced Package. 

3. Command line arguments can also be identified through hints displayed on the Profiler. 

4. If you have selected to display hints through the View Menu (either on the application interface or in its Status Bar), a
hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will display both a
description of the feature as well as its related command line argument (if any).

5. For more information on the latest features and how to implement specific scenarios please goto our support page at: 
http://www.peersoftware.com/support/PS_documents.asp. 

8.1  Configuration Arguments

/0:Profile

Set SNC File to Load (Profile = File):  If the /0 argument is used in a shortcut or from the
command line, PeerSync will load the Job information specified in the file.

Examples:
/0:"C:\My SNC\MyBackups.snc"
/0:MyBackups.snc
MyBackups.snc

Full path to file
Will use install directory
Will use install directory (Must be first argument)

http://www.peersoftware.com/solutions/PeerSync_overview.asp
http://www.peersoftware.com/support/PS_documents.asp
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/1:source

Set Source Path (source = Folder):  If the /1 argument is used in a shortcut or from the
command line, PeerSync will use it in conjunction with /2 to define a Source and Target path for
a Job.

Example:
/1:c:\source /2:c:\target c:\source to c:\target

/2:target

Set Target Path (target = Folder):  If the /1 argument is used in a shortcut or from the
command line, PeerSync will use it in conjunction with /2 to define a Source and Target path for
a Job.

Example:
/1:c:\source /2:c:\target c:\source to c:\target

/C:cfile

Load Alternate Configuration File (cfile = File):  If the /C argument is enabled, PeerSync will
use the values specified in cfile for synchronization information instead of using the default
configuration file: PSDef.cfg which is located in the install directory.

Example:
/C:C:\PeerSync

\configs\altconfig.cfg 
Use alternate configuration file 

/USEPROFILEARG
Use Arguments from Profile:  If the /USEPROFILEARG argument is used in conjunction with
a /0:Profile, PeerSync will use the arguments specified in Profile, for synchronization. By
default, when you create a shortcut on the desktop or in the startup folder from the StartUp
Options screen this argument is used.

Notes:

1. Any arguments containing spaces must be enclosed by quotes. 

2. Some features described on this page may require the Enhanced Package. 

3. Command line arguments can also be identified through hints displayed on the Profiler. 

4. If you have selected to display hints through the View Menu (either on the application interface or in its Status Bar), a
hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will display both a
description of the feature as well as its related command line argument (if any).

5. For more information on the latest features and how to implement specific scenarios please go to our support page
at: http://www.peersoftware.com/support/PS_documents.asp.

8.2  FTP Arguments

/FTPPASSIVE
Force FTP passive mode on:  The /FTPPASSIVE argument forces on the passive mode
option for all Jobs using FTP in a Profile.

http://www.peersoftware.com/solutions/PeerSync_overview.asp
http://www.peersoftware.com/support/PS_documents.asp
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/GH:mm-dd-yy

Set FTP Short Date Format:  The /GH argument sets the Short Date Format used in FTP
transmission. This feature is necessary if an FTP Server uses a non-standard date format.

Example:  /GH:dd-yy-mm 

/GJ:x
Set FTP Failed Upload Retry Count:  The /GJ argument sets the number of times PeerSync
will attempt to upload a file after it has failed.

Notes:

1. Any arguments containing spaces must be enclosed by quotes. 

2. Some features described on this page may require the Enhanced Package. 

3. Command line arguments can also be identified through hints displayed on the Profiler. 

4. If you have selected to display hints through the View Menu (either on the application interface or in its Status Bar), a
hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will display both a
description of the feature as well as its related command line argument (if any).

5.  For more information on the latest features and how to implement specific scenarios please goto our support page
at: http://www.peersoftware.com/support/PS_documents.asp 

8.3  Performance Arguments

/GE:x
Set Shared Process Delay:  The /GE argument is used to set the shared process delay to
allow more/less CPU utilization. This value ranges from 0 -10 where 0 (less CPU) will use the
most delay and 10 (more CPU).will use the least amount of delay.

/GK:x
Copy Thread Utilization:  If the /GK argument is enabled, PeerSync will allow up to x threads
to watch the queue that manages changes allowing for increased Copy Thread utilization.

/GP:x
Set Email Threads:  If the /GP argument is enabled, PeerSync will allow up to x threads to be
used for email tasks.

/LK:x
Set Multitasking Delay:  The /LK argument is used to adjust the delay during multitasking.
This value may be set between 1 and 10 where 10 is the highest amount of delay and 1 is the
least amount of delay. The default value is 4.

http://www.peersoftware.com/solutions/PeerSync_overview.asp
http://www.peersoftware.com/support/PS_documents.asp
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/LN:x
Set Processor Affinity:  If the /LN argument is enabled, PeerSync will allow you to limit which
CPUs to use in a multi-processor environment, where each CPU is represented by 2 to the x
value:

1 = CPU 1 16 = CPU 5
2 = CPU 2 32 = CPU 6
4 = CPU 3 64 = CPU 7
8 = CPU 4 128 = CPU 8

Example
s:
/LN:1
/LN:3
/LN:4
/LN:5

CPU 1
CPU 1 and 2
CPU 3
CPU 1 and 3

Note: By default all CPUs will be used. 

/MCT:x 
Set Copy Threads:  If the /MCT argument is enabled, PeerSync will allow up to x file copy
threads to be spawned for file copy tasks. These copy threads will be shared by one or more
Jobs during the synchronization process. 

Note: This item is selectable from the Profiler via the Options/Commands Screen.

/MFT:x 
Set Job Threads:  If the /MFT argument is enabled, PeerSync will allow up to x Job threads to
be spawned for managing Job tasks.

Note:  This item is selectable from the Profiler via the Options/Commands Screen.

/OPTIMIZE
Optimize Performance:  If the /OPTIMIZE argument is enabled, PeerSync will disable status
screen windows used for outputting status information. This will minimize memory allocation for
the User Interface.

/PERFORMANCE:x
Set Application Priority:  If the /PERFORMANCE argument is enabled, PeerSync will set the
application's priority based on the following value of x

0: Lowest Priority
1: Below Average Priority
2: High Priority. 

Notes: 

1. This item is selectable from the Profiler via the Options/Commands Screen.

2. If the /PERFORMANCE argument is not used, PeerSync will use a default priority.
When setting the Application Priority to High, PeerSync will use more then average CPU, you may want to use the Set
Processor Affinity argument in this scenario.

/YK:n  
Set Real-time Copy Thread Pool: Used to set the percentage of Copy Threads to reserve for
Real-Time events, where n can be set between the values of 1 and 99. The default value is 10.
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/YX:n  
Set File Read/Write Buffer Delay:  Used to set a delay in n milliseconds between each file
read/write cycle to allow the limiting of CPU usage and system resources during file transfers.
The higher the delay value, the less CPU used but the slower the performance or speed of 
PeerSync. 

Notes:

1. Any arguments containing spaces must be enclosed by quotes. 

2. Some features described on this page may require the Enhanced Package or Multi Threading Option. Please visit
http://www.peersoftware.com or contact Sales for additional information.

3. Command line arguments can also be identified through hints displayed on the Profiler. 

4. If you have selected to display hints through the View Menu (either on the application interface or in its Status Bar), a
hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will display both a
description of the feature as well as its related command line argument (if any).

5.  For more information on the latest features and how to implement specific scenarios please goto our support page
at: http://www.peersoftware.com/support/PS_documents.asp 

8.4  Reporting and Display Arguments

/AP
Run Pre-Sync Report:  If the /AP argument is used a Pre-Sync Report will be generated and
files/folders will not be synchronized. If you add an O to the /AP then the previous Pre-Sync
report will be Over written, if you exclude the O then the file will be appended to an existing
Pre-Sync report. If you add an S to the /AP then the Pre-Sync report will be Shown at the end of
the run (i.e.: /AP, /APO, /APOS or /APS). 

Note: This item is selectable from the Profiler via the Options/Commands Screen.

/GL[S]
Display status in Profiler:  If the /GL argument is used, PeerSync will open the Profiler, if it is
not already open, and send status messages to be displayed on the Run/View Current Profile
Activity screen using mail slot messaging to communicate with the Profiler. By adding an S you
can suppress the initial connection of PeerSync to the Profiler upon activation of PeerSync.

Note: This item is selectable from the Profiler via the Options/Commands Screen.

/GM:x
Enable MSMQ messaging:  If the /GM argument is used, PeerSync will use x as the location
to manage messages in the queue. 

Example: /GM:DIRECT=TCP:209.51.171.142\PRIVATE$\MYQUEUE

http://www.peersoftware.com/solutions/PeerSync_overview.asp
http://www.peersoftware.com/solutions/PeerSync_overview.asp
http://www.peersoftware.com
http://www.peersoftware.com/contact/contact_sales.asp
http://www.peersoftware.com/support/PS_documents.asp
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/GO[F:y][C:group]
Enable PSObserver Broadcasts:  If the /GO argument is used, PeerSync will use mail slots to
broadcast activity across the LAN to the PeerSync LAN Observer Utility for the centralized
viewing of all PeerSync activity on the network. You can launch the PeerSync LAN Observer
Utility, if it is installed/available from the View Menu.

y: Identifies the number of seconds between each broadcast The default is 3 seconds
group: Identifies a group for the current Profile. The default is the Profile Name.

Example: /GOF:5C:MyProfiles Enabled and broadcasted every 5 seconds with a group name of

/GQ:[file][maxsize]
Create and Append Summaries into One Report:  If the /GQ argument is used, PeerSync
will append summaries into one log file.

/GR
Report Non Standard Events:  If the /GR argument is used, PeerSync will report non -
add,update, and delete actions.

/GS:x
Enable Summary Statistics Collection:  If the /GS argument is used, PeerSync will use x as
the file location to save summary statistics.

/H 
Hide Splash Screen:  Available through all registered versions of PeerSync, this argument will
suppress and hide the splash screen for both the PeerSync and Profiler applications.

/LQ:[file][maxsize]
Enable FTP Logging:  If the /LQ argument is used, PeerSync will log FTP activity to the user
defined file, or to PS_FTP.LOG by default.

/LSE 
Log Service Events to the Event Viewer:  If the /LSE argument is used, PeerSync will log
events to the Event Viewer. The following options are available for this argument:

/LSEE Log messages as errors
/LSEEW  Log messages as warnings
/LSEEM  Only log messages and log them as errors

/LSEEWM  Only log messages and log them as warnings

/M 
Show Tray Icon:  If the /M argument is used, PeerSync will display an icon in the system tray
for PeerSync. 

Note: This item is selectable from the Profiler via the Options/Commands Screen.

/PROGRESS
Display status in PeerSync:  This feature will show the PeerSync Status Display dialog box
during synchronization so the user can see activity, status and other information while 
PeerSync is running. 

Note: This item is selectable from the Profiler via the Options/Commands Screen.

/SNMP
Enable SNMP Error Reporting:  If the /SNMP argument is used, PeerSync will use SNMP
reporting to report any errors that occur during the synchronization process.
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/TD
Display status in PeerSync upon completion:  This feature will have PeerSync show the
PeerSync Status Display dialog box at the end of synchronization (only in non-persistent
modes) so the user can see activity, status and other information upon completion. 

Note: This item is selectable from the Profiler via the Options/Commands Screen.

/YL
Log Messages Only to a Log File by Filter and/or by Profile:  If the /YL argument is used,
PeerSync will log messages only to a log file based on the Filter and/or Profile. The following
options are available for this argument:
 

/YL   
/YLF 
/YLP   

Log messages for Both
Log messages by Filter Only
Log messages by Profile Only

When logging by Filter (/YL or /YLF), the Filter message log file will reside in the same directory
as the primary log file, with the same file name as the primary log file but with a "flt.log" file
extension. 
When logging by Profile (/YL or /YLP), the log file will reside in the same directory as the
Profile, with the same file name as the Profile but with a "snc.log" file extension. 

Notes:

1. Any arguments containing spaces must be enclosed by quotes. 

2. Some features described on this page may require the Enhanced Package. 

3. Command line arguments can also be identified through hints displayed on the Profiler. 

4. If you have selected to display hints through the View Menu (either on the application interface or in its Status Bar), a
hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will display both a
description of the feature as well as its related command line argument (if any). For more information on the latest
features and how to implement specific scenarios please goto our support page at: 
http://www.peersoftware.com/support/PS_documents.asp 

8.5  Automation Arguments

/A 
Scan at Start:  If the /A argument is appended to the command line, the Profile can be run
through its associated shortcut. As non-persistent processes, Automatic Operations are run a
single time upon manual initiation by the user. 

Note: This item is selectable from the Profiler via the Options/Commands Screen.

/D(H):x
Delay Scan at Start:  If this argument is used, PeerSync will delay x seconds before running
the Initial Scan of each Job. With this option enabled synchronization can be canceled via a
dialog box if done so within the designated interval. For example, /D5 would provide you with a
5 second delay during which the operation can be canceled. If the /D argument includes an H,
i.e. /DH60, then the delay timer will be hidden during operation. This argument is useful for
allowing PeerSync to begin after other applications have been loaded if you are running
PeerSync at Windows startup.

http://www.peersoftware.com/solutions/PeerSync_overview.asp
http://www.peersoftware.com/support/PS_documents.asp
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/R[OyCz] 
Real-time Monitoring Argument:   The /R argument activates Real-Time Mode.
The Oy and Cz arguments are optional and specify the following retry values during Real-Time
Mode:

y = The retry count if the file is open or network is unavailable 
z = The retry count maximum 

Note: This item is selectable from the Profiler via the Options/Commands Screen.

/S 
Run Scheduled Operation:  The /S argument enables or disables Scheduled Operation Mode
for the entire Profile. This feature must be selected in order for all Scheduled Operations set for
individual Jobs to be recognized. Scheduled Mode does not apply a global schedule to the
entire Profile: rather, it enables those schedules set for all individual Jobs on to run at their
specified intervals. 

All Scheduled Operations set for individual Jobs will be ignored if this mode is not selected. If
none of the Jobs within a Profile are set for Scheduled Operation and this mode is selected, all
active Jobs within the Profile will be assigned a default synchronization schedule of five
minutes. 

/Sx 
Synchronization Timer Argument:  The /Sx option is used to run PeerSync automatically at
regular intervals. This argument sets PeerSync to synchronize the selected Profile every x
minutes. Through this feature PeerSync remains persistent and will not terminate upon
completion.

Examples: /S10 Synchronization will be performed every 10 minutes

/SxKz
Synchronization Timer Argument with Keyboard Activity: The /SxKz option is used to run
PeerSync automatically at regular intervals only when it senses keyboard activity. This
argument sets PeerSync to synchronize the selected Profile every x minutes upon Keyboard
activity and will always run every z cycles with/without keyboard activity. The z is optional and
will be ignored if set to 0. Through this feature PeerSync remains persistent and will not
terminate upon completion.

Note: This item is selectable from the Profiler via the Options Commands Screen.
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/TIME
Daily Timer:   This argument will allow for scheduling of PeerSync for specific times of the day
down to the minute for selected days of the week and selected Jobs within a Profile.  If you use
a /TIMEF argument all selections at the Job level from the Automation screen will be used. You
can also specify Global Daily Timer selections for the entire Profile from the 
Options/Commands Screen or by using the following format:

1. Select the time of day (by default all Jobs will be run all days)

/TIME:HH:MM
Where HH is replaced with the value of 00-23 in military time and MM is replaced with 00-59 in minutes

Examples:
Every Day at
12:00 am:
Every Day at
1:00 am: 
Every Day at
8:00 am: 
Every Day at
12:00 pm: 
Every Day at
8:00 pm: 

/TIME:00:00
/TIME:01:00
/TIME:08:00
/TIME:12:00
/TIME:20:00

2. (Optional) - To select the days of week to run append the following:

D:SMTWTFS where the days are substituted with 1 (On) and 0 (Off)

Sunday:
Monday: 
Tuesday: 
Wednesday:
Thursday: 
Friday: 
Saturday: 

D:1000000
D:0100000
D:0010000
D:0001000
D:0000100
D:0000010
D:0000001

Examples:
M, W & F at
8:00 am:
Sat & Sun at
5:15 pm: 
Mon - Fri at
3:30 am: 

/TIME:08:00D:0101010
/TIME:17:15D:1000001
/TIME:03:30D:0111110

3. (Optional) - To select the Jobs to run append F:f1;f2;f3

Where f1-fn are the Job numbers.

Examples:
Job 1 Every
day at 6:00 am:
 
Jobs 1 - 5
Every day at
8:25 pm:
Jobs 1, 3 & 5
Mon - Fri at
3:30 am: 

/TIME:06:00F:1
/TIME:20:25F:1;2;3;4;5
/TIME:03:30D:0111110F:1;3;5

Note: Will accept multiple command lines.

Example:
Job 1 Every day at 8:00 am, Jobs 1 - 5 Every day at 8:25 pm and Jobs 1, 3 & 5 Mon - Fri at 3:30 am
/TIME:08:00F:1 /TIME:20:25F:1;2;3;4;5 /TIME:03:30D:0111110F:1;3;5

Sample: 
Complete command line to run PeerSync with Test.snc, all Jobs, at 3:00 am Mon -Fri, (M)inimized on the tray.
"C:\Program Files\PeerSync\PeerSync.exe" "C:\Program Files\PeerSync\test.snc" /TIME:3:00D:0111110 /M 

Note: This item is selectable from the Profiler via the Options/Commands Screen.
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/UDD 
Use Device Driver method:   This argument uses of the Windows NT device driver for real-time
detection. When using this argument PeerSync can detect changes made to remote Source
folders but only when the changes are made by the machine where PeerSync is installed.

/< 
Applications to Ignore:  If using the Device Driver method for Real-Time detection you can
select applications to ignore by appending application names (semicolon delimited) to the /<
argument.

Example: /<Explorer.exe;Word.exe  Will ignore any Real-Time changes made by Explorer.exe and Word.exe.

Note: When using this option and monitoring a remote Source folder, the Transfer NT security descriptions (ACLs) is
ignored in Real-Time.

/X 
Disable Initial Synchronization During Startup:  The /X command line argument disables initial
synchronization during /A /M /R operations at PeerSync startup. 

Notes:

1. Any arguments containing spaces must be enclosed by quotes. 

2. Some features described on this page may require the Enhanced Package. 

3. Command line arguments can also be identified through hints displayed on the Profiler. 

4. If you have selected to display hints through the View Menu (either on the application interface or in its Status Bar), a
hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will display both a
description of the feature as well as its related command line argument (if any).

5. For more information on the latest features and how to implement specific scenarios please goto our support page at: 
http://www.peersoftware.com/support/PS_documents.asp

8.6  Synchronization Arguments

/GC:x
Set File Comparison Value:  If the /GC argument is used, PeerSync will add x seconds to the
Target File date and time stamp to use during comparison.

/GD:n,z:n,z 

Set Job Comparison Delta:  If the /GD argument is used, PeerSync will add or subtract z
seconds from the Target File date and time stamp during a comparison for Job number n.

Example: /GD:1,+30:2,-60:

/GF 
Use Alternate Copy File Methods:  The following copy file methods may be invoked:

/GFC Use CopyFile API method
/GFS Use File Stream method
/GFE Use CopyFileEX method

http://www.peersoftware.com/solutions/PeerSync_overview.asp
http://www.peersoftware.com/support/PS_documents.asp
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/GI(S)(D) 
Ignore File Size and/or Date Comparison:  If the /GI or /GIS argument is used, PeerSync will
ignore file size during folder scans (if date matches then skip file). If the /GID argument is
used, PeerSync will ignore file date comparison during folder scan (if size matches then skip
file).f the /GISD argument is used, PeerSync will ignore file date and size comparison during
folder scan (always replace Target file even if they are identical).

/GT 
Get Remote PC Time:  If the /GT argument is used, PeerSync will attempt to get the time from
the Target PC as well as the local PC and automatically compensate for time differences.

Note:  /GT is only applicable in an NT/2K Environment

/GX 
Use Delete Path for Revisions:  If the /GX argument is used, PeerSync will use the deletions
path for all PSBAK revision files.

/I 
Ignore Target Space During File Copy:  The /I argument sets PeerSync to ignore Target space
available during file copy.

/J 
Move Files:  If the /J argument is used, PeerSync will move files - deleting them from the
Source after they have been successfully transferred.

/KA:x 
Active Connection Interval:  If the /KA argument is used, PeerSync will attempt to connect
every x minutes to Target machine(s).

/LH:x
Set Deletion Move To Folder Cleanup Interval:  If the /LH argument is used, PeerSync will
check the Move To Folder (the folder where deleted files are move to), every x minutes to see if
files needed to be deleted on the cycle specified by the Delete unmatched Target Files older
than x days option. 

/LI [ R | T | A ]
Target In-Use Replacement:  If the /LI argument is used, PeerSync will perform the following
operation if Target File is unavailable:

R Force rename of open Target File
T Force terminate of open Target File

application
A Force terminate of all open Target

applications
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/LM:xOyCz

Set Failed Connection Timer:  If the /LM argument is used, PeerSync will use the following
variables to determine retry frequency:

x Approximate time, in minutes, for retry of
failed connection (time may vary as much
as a few minutes).

y Frequency to retry files
z Maximum Retry Count

Example: /LM5O25C100 Checks failed connections every 5 minutes, retries files every 25
seconds, to a maximum retry count of 100.

Note: This item is selectable from the Profiler via the Options/Commands Screen.

/LMD
Disable Failed Connection Timer:  If the /LMD argument is used, PeerSync will not check for
failed connections.:

Example:  /LMD Does not check for failed connections.

Note: This item is selectable from the Profiler via the Options/Commands Screen.

/LR:file
Run application at start of PeerSync:  If the /LR argument is used, PeerSync will execute an
application or shell script specified by file at the initialization of PeerSync.

Example:   /LR:C:\WINNT\notepad.exe

/LW
Enable Last Access Compare:  The /LW argument allows you to use the last access date/time
instead of the modified date/time for comparisons to determine file updates.

/NODELFLDR 
Do not delete folders:  If the /NODELFLDR argument is used, PeerSync will not delete folders
during synchronization.

/O 
Set Target File Overwrite:  The /O argument sets Target File overwrite on all Jobs.

/QB
Use Full Access File Copy:  If the /QB argument is used, PeerSync will only copy files it can
gain full access to during synchronization.

/QFn
Shadow Time Range:  This argument will use an n second time range for file time stamps
during comparison. If the Source and corresponding Target File time stamps fall in the range
then the file time stamps will be seen as equal.

 n = Time in seconds

/QG
Always use the local machine time for the Last Run Time:  If this argument is used, PeerSync
will always uses the local machine time for the Last Run Time, instead of using the minimum
time of the Source and Target machines involved in the synchronization.
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/QH:n
Force Flush File Buffers:  Forces the file data that has been written across the network to be
fully committed to disk before continuing. The Interval n is the number of buffers worth of data
to write before forcing a disk write of the data, if n is not used the default is 20 cycles. 

Note:  This is expected to naturally occur without this argument, but on some systems across slower networks it is
necessary to force the commit of data to correctly gauge process of writing the file.

/QI:ext

Ignore Matching/Locked File Extensions:  This argument will ignore an add/update of a file, if a
matching file with the same base name and the specified extension ext exists.

Example:  /QI:dwl

Note:  One instance of this example is if a file called MyFile.dwg is updated it will be excluded from synchronization
while MyFile.dwl exists.

/QJ:str

Ignore Matching/Locked File Postfix Replacement:  This argument will ignore an add/update
of a file, if a matching file with the same base name with the specified postfix replacement str
exists.

Example:  /QJ:~$

Note: One instance of this example is if a file called MyDocument.doc is updated, it will be excluded from
synchronization while ~$Document.doc exists.

/T
Terminate All Instances of PeerSync:  The /T argument terminates all running instances of
PeerSync, including itself. 

/VRBn

Verify User-Name:  If the /V argument is used, PeerSync will verify logged on User-Name
defined in the local user file list, specified by the following options:

R Require user to be in the user file list 
B Bypass the request to add to list dialog
n Maximum number of user allowed

/W:x
Set Queue Directory Change Count:  If the /W argument is used, PeerSync will set queue
directory change count, events to wait for action x.

/WPFIX 
Disable application associated with active file synchronization:  When a file is being
synchronized, this option searches all active windows on the desktop for a caption that contains
the path/filename of the active file. PeerSync then disables the active application in one of two
ways. The command lines "/WPFIX or /WPFIX2" disables the entire application and" /WPFIX1"
disables the save toolbar and file menu save item. (This option also verifies that the word
"WordPerfect" is in the caption before disabling). Both options will append "(Synchronizing)" to
the existing caption and when the file is synchronized, the caption will be restored. 
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/WPMOD 
WordPerfect Fixes for synchronization:  The /WPFIX and /WPMOD arguments are used to
help in the synchronization of WordPerfect files. 

DLL file to improve interaction with WordPerfect v8 and higher: Working with the Corel
corporation, we developed a 3rd party utility that disabled the save function in WordPerfect
when a document is "unmodified." This reduces the possible "File Access Denied" error that
WordPerfect produces when PeerSync is synchronizing the active document. To run this
option, you must rerun the PeerSync installation program again. The file "PSWPMod.DLL" file
will be installed in the windows System32 folder. 

For WordPerfect 8, add "/WPMOD8" on the PeerSync command line, which will modify the registry as follows:

Key:  HKEY_LOCAL_MACHINE\SOFTWARE\COREL\WordPerfect\8\Third Party 

String: DLL16 

Value: C:\WinNT\System32\PSWPMod.DLL

For WordPerfect n, add "/WPMODn" on the PeerSync command line, which will modify the registry as follows:

Key:  HKEY_LOCAL_MACHINE\SOFTWARE\COREL\WordPerfect\n\Third Party 

String: DLL16 

Value: C:\WinNT\System32\PSWPMod.DLL

Note:  The DLL16 string may vary based on the installation of other 3rd party add-ons to your WordPerfect installation.
The value could be DLL15, DLL14, etc.

/YC:x
Folder Queue Watch Interval:  Change the default timer interval for checking the folder queue
to x seconds (the default is .5 seconds).

Example:  /YC:3

/YD
Allow Replication During Dynamically Created Jobs:  This argument will allow dynamically
created Jobs (i.e. Job scans triggered by Folder Additions) to use the replicate option.

/YF:ext1;ext2;extn

Partial Locked File Extensions List:  This argument is used for file types that are partial locked
when open by other applications (i.e. Outlook PST files). If the /YF argument is used, and
Embedded Open File Manager (EOFM) is enabled PeerSync will always process files with the
specified extensions as though they are open and locked files. If EOFM is not enabled, then
PeerSync will pre-scan the files to ensure complete access before file copy. PST files are
included in this list by default and can be changed via this command line.

Example:  /YF:.pst;.dba;

/YN
Use Network Password Dialog:  If the /YN argument is used, PeerSync will display a network
password dialog if you do not have right to access the Source or Target Folder. 

/YR
Delete Empty Source Folders After Move:  This argument will delete all empty Source Folders
after a synchronization scan when using the Move Files - Delete Source File after successful
copy to Target option.
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/YV
Do Not Validate Connections Before Profile is Loaded: This argument will not try to validate
Source and Target Folder connections during the load of a Profile. It will assume that the
connections will be available upon start of each Job. This option is useful if you are running a 
Pre Process that will establish a connection and/or create a Source or Target Folder.

/Z:ext1;ext2;extn

Ignore Open File Extensions:  If the /Z argument is used, PeerSync will ignore files with the
specified extensions that are currently opened where the full name of the file is displayed in the
caption of another window. This argument may be ignored if Multiple Job or multiple copy
threads are enabled. 

Example:  /Z:.wpd;.txt;

Notes:
1. Any arguments containing spaces must be enclosed by quotes. 

2. Some features described on this page may require the Enhanced Package. 

3. Command line arguments can also be identified through hints displayed on the Profiler. 

4. If you have selected to display hints through the View Menu (either on the application interface or in its Status Bar), a
hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will display both a
description of the feature as well as its related command line argument (if any).

5. For more information on the latest features and how to implement specific scenarios please goto our support page at: 
http://www.peersoftware.com/support/PS_documents.asp

8.7  Real-Time Arguments

/GA:x
Set Empty File Delay:  If the /GA argument is used, PeerSync will delay x milliseconds before
synchronizing empty (zero size) files that are detected in Real-Time.

/GB:x
Set Shadow Detection:  If the /GB argument is used, PeerSync will delay x milliseconds to
synchronize subsequent updates of the same file during Real-Time.

/LA 
Real-time Attribute Change:  If the /LA argument is used, PeerSync will monitor attribute
changes to files in Real-Time and use these changes as triggers for file synchronization.

/LF
Use Update Sensitivity:  If the /LF argument is used, PeerSync will use the update section of
PSChangeNotify to detect file changes during real-time. 

Note: This feature is generally too sensitive, and will create multiple detections.

/LG
Folder Change Detection:  If the /LG argument is used, PeerSync will detect folder changes,
and in Enhanced Real-Time will force only the security description to be validated. Any change
to the folder will trigger synchronization, so that more CPU will be required. This option is not
recommended for non-enhanced Real-Time.

http://www.peersoftware.com/solutions/PeerSync_overview.asp
http://www.peersoftware.com/support/PS_documents.asp
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/LL
Disable Real-time Security Change:  If the /LL argument is used, PeerSync will not trigger
updates in Real-Time when a file's security has changed. 

/LPC:x
Set Maximum Number of Events to Process within each Enhanced Real-Time Queue
Check:  If the /LPC argument is used, PeerSync will set the maximum number of events to
process within each Enhanced Real-Time queue check to x events. The default is 25 events
and the minimum is 5 events.

/LPD:x
Set Delay between Enhanced Real-Time Deletions:  If the /LPD argument is used, PeerSync
will delay the deletion of files x milliseconds during Enhanced Real-Time. 

/LPE:x
Set Delay between Enhanced Real-Time Event Processing:  If the /LPE argument is used,
PeerSync will delay the processing of each event x milliseconds. 

/LPM:x
Set Enhanced Real-Time Event Upper Limit:  If the /LPM argument is used, PeerSync will
set the maximum number of items x to allow in the Enhanced Real-Time event queue before
reverting to non-enhanced Real-Time. If this value is set to 0 then the option is disabled (the
default is 20000 events). If and when the Upper Limit is reached PeerSync will clear all
Enhanced Real-Time events that have not been processed and scan the directories for
changes. 

/LPW:x:y

Set Enhanced Real-Time Event Queue Delay:  If the /LPW argument is used, PeerSync will
set the number of items x in the enhanced real-time event queue to wait for before processing,
as well as, the maximum time to wait for to y milliseconds.

/LPQ:x
Set Delay between Enhanced Real-Time Queue Checking:  If the /LPQ argument is used,
PeerSyncwill delay x milliseconds before checking the Enhanced Real-Time queue for new
events.

/LPX:x
Set Process Delay for Enhanced Real-time Changes:  The /LPX argument allows you to set
the delay time for Enhanced Real-Time changes to be processed to x milliseconds. This value
will be applied directly for adds and updates and will be multiplied by 3 for deletions. The default
is 1000 milliseconds for adds/updates and 3000 milliseconds for deletions 

/YK:n
Set Real-time Copy Thread Pool:  Used to set the percentage of copy threads to reserve for
Real-Time events, where n can be set between the values of 1 and 99. The default value is 10
percent.

Notes:

1. Any arguments containing spaces must be enclosed by quotes. 

2. Some features described on this page may require the Enhanced Package. 

3. Command line arguments can also be identified through hints displayed on the Profiler. 

4. If you have selected to display hints through the View Menu (either on the application interface or in its Status Bar), a
hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will display both a
description of the feature as well as its related command line argument (if any).

http://www.peersoftware.com/solutions/PeerSync_overview.asp
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5. For more information on the latest features and how to implement specific scenarios please goto our support page at: 
http://www.peersoftware.com/support/PS_documents.asp

8.8  Bi-directional Arguments

/GV 
Always Create Superset during Bi-directional Synchronization:  If the /GV argument is
used, PeerSync will not use the TLR value, and therefore always create a superset of data
during a bi-directional synchronization.

Note: This item is selectable from the Profiler via the Options/Commands Screen.

/GW 
Enable Temp Files:  If the /GW argument is used, PeerSync will enable the use of temporary
files during file/folder renames and deletes. This is useful during 'Real-time Bi-Directional
Synchronization' in order to prevent oscillation. 

/LB 
Bi-directional Folder Deletion:  If the /LB argument is used, PeerSyncwill delete folders that
have been deleted from Target or  Source during bi-directional scans.

/LC 
Use Last Access File Time:  If the /LC argument is used, PeerSync will always use last
access file time for bi-directional synchronization.

/LD [ M | A | T | R ]
Set Trigger Folder File Name:  If the /LD argument is used, PeerSyncwill set enhanced
bi-directional synchronization trigger folder filename extension to:

M Use machine name as extension
A Use LastAccessTime for TLR comparison
T Use "~FLDR" extension in place of TLR
R Reset/Delete all trigger folder-files

/LE
Use Enhanced bi-directional synchronization mode:  The /LE argument is equivalent to
/LDMAT mode. This will alter the way the bi-directional synchronization option functions by
using enhanced features to track all file and folder adds, updates, deletions, renames and
moves between scan cycles. In this mode PeerSync will use a hidden system trigger file within
each sub-folder to store information about the last scan cycle for that sub-folder. Using this
trigger file PeerSync can determine if a Folder was added, deleted, renamed or moved since
the last scan.

Note: This item is selectable from the Profiler via the Options/Commands Screen.

http://www.peersoftware.com/support/PS_documents.asp
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/YO- 
Retain Last Access Time for Two Machine bi-directional synchronization:  The /YO-
argument will store the original Last Access time of the Source File before synchronization and
then it will set the Source and Target files' Last Access Times with the stored time after a file
add or update. This will allow bi-directional scans between two machines to properly track file
adds then subsequent file deletes within the next scan cycle.

Notes:

1. When using standard or enhanced bi-directional synchronization we recommend adding /YO- as well as /QYD:0 to
your list of command line arguments to ensure deleted files from one side are not re-added by the other side.   

2. The /YO- argument should NOT be used if there are more than two machines involved in a bi-directional
synchronization due to the need of the Last Access Time to be used by the third, fourth etc. machine during
comparison with either of the other two machines.

/QYD:n
Set Safety Value for Last Run Time: By default PeerSync uses /QYD:5 during standard or
enhanced bi-directional synchronization. With this option enabled deletion events are
programmatically delayed by approximately 10 seconds to account for any time differences
between machines. This can be problematic when performing standard or enhanced
bi-directional synchronization where a deleted file from one side can be re-added by the other.
In this scenario we recommend using /QYD:0 which represents a safety value of 0 seconds for
deletions. 

n = 0 safety value = 0 seconds
n = 1 safety value = approximately 2 seconds
n = 2 safety value = approximately 4 seconds
...
n = 5 safety value = approximately 10 seconds

Note: When using standard or enhanced bi-directional synchronization we recommend adding /QYD:0 as well as /YO-
 to your list of command line arguments to ensure deleted files from one side are not re-added by the other side.   

Notes:

1. Any arguments containing spaces must be enclosed by quotes. 

2. Some features described on this page may require the Enhanced Package. 

3. Command line arguments can also be identified through hints displayed on the Profiler. 

4. If you have selected to display hints through the View Menu (either on the application interface or in its Status Bar), a
hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will display both a
description of the feature as well as its related command line argument (if any).

5. For more information on the latest features and how to implement specific scenarios please goto our support page at: 
http://www.peersoftware.com/support/PS_documents.asp 

8.9  EOFM Arguments

/QD
Always Use Partial Locked File Extensions List For EOFM:  If the /QD argument is used,
any file that is in the Partial Locked File Extension List (default: .pst files) will always be
synchronized using EOFM without scanning the file for partial locks. 

Note: Please refer to the /YF argument for more detail on the Partial Locked File Extensions List. 

http://www.peersoftware.com/solutions/PeerSync_overview.asp
http://www.peersoftware.com/support/PS_documents.asp
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/GY:x 
EOFM Interval:  The /GY argument is used to set the interval to try open and locked files via E
The Default is every 2 hours and the minimum value is every 30 minutes.

Note: This item is selectable from the Profiler via the Options/Commands Screen.

/YY:n
Set EOFM Try Count: This argument is used to set the amount of times n to try and lock down
a drive for full access via EOFM during each cycle. The default is 5 times.

Note:  If this argument and the Set EOFM Base Timeout (/YZ:n argument) are not used then EOFM will wait 120
seconds five times.

/YZ:n
Set EOFM Base Timeout:  This argument is used to set how long to wait for EOFM to lock the
drive the first time in n seconds. Each subsequent try will have a timeout based on this value
multiplied by the EOFM Try Count (i.e. 30, 60, 90, 120, 150). The default timeout is 30
seconds. 

Note:  If this argument and the Set EOFM Try Count (/YY:n argument) are not used then EOFM will wait 120 seconds
five times.

Notes:

1. Any arguments containing spaces must be enclosed by quotes. 

2. All features described on this page may require the Enhanced Package. 

3. Command line arguments can also be identified through hints displayed on the Profiler. 

4. If you have selected to display hints through the View Menu (either on the application interface or in its Status Bar), a
hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will display both a
description of the feature as well as its related command line argument (if any).

5.  For more information on the latest features and how to implement specific scenarios please goto our support page
at: http://www.peersoftware.com/support/PS_documents.asp 

9.  Other Components

9.1  PeerSync Status Display

This screen is used to view Current Profile Activity within the PeerSync application. 

Status Screen Features

Profile Displays the name of the Profile actively being processed. This label may
not match the name of the Profile currently being configured through Profiler
.

Job This indicator will dynamically display the name of whichever Job is
presently being processed for the Active Profile.

Mode This indicator will dynamically display the name of whichever Job is
presently being processed for the Active Profile.

Source Displays a file path for the Source Folder presently being synchronized.

http://www.peersoftware.com/solutions/PeerSync_overview.asp
http://www.peersoftware.com/support/PS_documents.asp
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Target Displays a file path for the Target Folder presently being synchronized from
the Source indicated above.   

Folders This indicator provides a count of all unsynchronized folders contained
within the Source, and will decrease as each folder is synchronized. An
additional "thermometer" indicator will also track the progress of folder
synchronization.

Files This indicator displays the total number of files contained within the Source
while also providing a count of synchronized files. In addition, a
"thermometer" indicator will show file synchronization progress by
increasing according to the size of the current folder, with 100%
representing the cumulative size of files contained within the Source Job
set.

File Indicates the name of the file currently being synchronized.

Large File or
Compression
Status

This caption will be displayed to the right of the file name that is currently
synchronized for large files and during compression. The caption will show
the size of the file that has been copied to the Target and/or compression
status.

Skip File This button will appear once the active Profile has been launched. This
feature allows you to skip synchronization of the file currently displayed in
the indicator described below. Skip Files enables you to avoid delays
caused by large files on slow network or dial-up connections.

Size Indicates the size (in bytes) of the file currently being synchronized. A
related "thermometer" indicator tracks the progress of synchronization for
that file.

Checked This indicator displays the total number of files contained in the selected
Source Folders. 

Excluded Indicates the number of files that were excluded from synchronization (See 
Exceptions). 

Messages Indicates the number of error messages generated during Profile
processing. 

Updated Indicates the number of Target Files that were updated during
synchronization of Profile Jobs. 

Added Indicates the number of new files added to Target Folders during
synchronization of Profile Jobs. 

Deleted Indicates the number of files deleted (or moved) during synchronization of
Profile Jobs. 

Target Space Indicates the Target Folder space remaining during synchronization of
Profile Jobs. 

Elapsed Time Indicates the amount of time that has elapsed during the current Profile
activity.

Hide Will hide this display, which can be re-accessed via the Tray Icon Menu.

Quit Allows you to close/exit the current session of PeerSync.
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Other Screen Features

Processed Lists The Updated, Added, Deletions and Excluded screens will display statistical
information in the above format. Each screen will have statistical information
(File Name, Size, Modified Date/Time, Path, Duration, etc.) about the
changes that have occurred during the current PeerSync session.

Item Count Display of the amount of changes that have occurred for the current screen.

Maximum List
Size

Allows you to select the maximum amount of changes that you wish to store
for the current screen. It is recommended to keep this value low because
each entry requires memory to be used by PeerSync.

Status Display Popup Menu

Activated by right clicking on the PeerSync Status Display.

View Log File  Allows you to access, launch and view Log files in the default text editor for
the current Profile.

View Admin
Folder

Allows you to access, launch and view Admin log file Folders in Explorer for
the current Profile.

Open Source
Folder

Allows you to access, launch and view Source Folders in Explorer for the
current Profile.

View Target
Folder

Allows you to access, launch and view Target Folders in Explorer for the
current Profile.

Print Allows you to print the current screen information.

Save As Allows you to save the current screen information to file.

Clear List Allows you to clear/reset the current screen information.

Re-Load Profile Allows you to re-load the current Profile if any changes have occurred.

About PeerSync
 

Will display an about screen, that contains information about the current 
PeerSync you are running.

Quit Allows you to close/exit the current session of PeerSync.

9.2  PSObserver

This utility allows for the ability to monitor PeerSync activity across the LAN for the centralized
viewing of all PeerSync activity on the network. To enable this feature you must start each
PeerSync you wish to view with the /GO argument, which can be set from the Options/Commands
Screen. You can install, run and use PSObserver on any machine on your LAN. You can start PS
Observer from your PeerSync install folder (or where ever you copy the PSObserver .exe file to)
or from the View Menu in the Profiler. 

PSObserver Screen Features
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Group:
Computer

Displays the Profile and the machine each PeerSync is running on.

User Displays the current user of each PeerSync.

Current Status Displays the current activity of each PeerSync. 

Activity Displays the current status of each PeerSync. 

Checked Indicates the total number of files that were checked for each PeerSync.

Excluded Indicates the number of files that were excluded from synchronization for
each PeerSync.

Updated Indicates the number of Target Files that were updated during
synchronization for each PeerSync. 

Added Indicates the number of new files added to Target Folders during
synchronization for each PeerSync.

Deleted Indicates the number of files deleted (or moved) during synchronization for
each PeerSync.

Messages Indicates the number of error messages generated for each PeerSync.

Time Indicates the elapsed time. 

Close This button will close the utility. 

9.3  PeerSync Remote Control

This feature allows you to connect to and monitor any PeerSync currently running on your LAN.
Including PeerSync running as an application or a service on the local machine and/or any
instances of PeerSync running on any machine that is accessible from the local machine. 

PeerSync Remote Control Screen Features

Profile Selection The field located to the left of the Add Button. This field is used to add a
Profile to the Profile Selection List. The format for a Profile selection is:
MACHINENAME:PROFILENAME (i.e. DELLSERVER:Profile.snc).

Profile Selection
List

The list located below the Profile Selection, which contains Profile
Selections that can be connected to and monitored by selecting the item
and using the Connect button.

Add This button will add the current Profile Selection to the Profile Selection List.

Connect This button will connect to the current Profile Selection and display its
activity on the screen.

Disconnect This button will disconnect the current Profile Selection and stop the display
of activity.

Refresh This button will refresh the current Profile Selection activity.

Pause/Resume This button will pause/resume the current Profile that is selected.

Query This button will search for and add all Profiles that can be found to the
Profile Selection List.
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Clear List This button will clear out all entries from the Profile Selection List.

Remote
Connection
Information

Displays the computer, user and last response for the current connection. 

Close This button will close this dialog.

9.4  Quick-Sync

Quick-Sync Folder selection directly from MS Windows Explorer

This feature is a quick and easy way to synchronize folder(s) on the fly to backup location(s) with
the option to modify your Job settings at a later time. 

Using the Quick-Sync Option

Simply right click on any folder you wish to sync and select "Quick-Sync Folder...".  This will
launch the Wizard, which will ask you to select a Target Folder to sync to...and your ready to run
the Quick-Sync. You also have the options to edit and/or add the current sync Job to your Quick-
Sync Profile or any other selected Profile. Then the next time you select a folder if it matches any
Source or Target selection in the Quick-Sync Profile the Jobs will be listed to pick from or you
have the option to add a new Job. 
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